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Preface

Using Lotus Fax for Domino for AS/400 Release 4.1, you can now send faxes
directly from your Lotus Notes desktop. You can save time by not having to get up
from your desk to go to the printer and the fax machine to send faxes. You can
save money by scheduling long distance faxes to be sent at lower-priced calling
times. Even attachments from PC applications, such as Lotus Word Pro and
Microsoft Word, can be sent. Incoming faxes can be delivered automatically to a
fax administrator for redelivery to your inbox, or depending on your installation,
they can be delivered directly to the final recipient.

This redbook shows you how to set up, configure, use, and manage this exciting
new add-on product from Lotus. We show you how Domino applications can take
advantage of integrating faxing into their processing. In addition, we show you
how you can fax spooled files from the AS/400 system and provide a sample
command to assist you in integrating Fax for Domino with AS/400
line-of-business applications.

The team that wrote this redbook

This redbook was produced by a team of specialists from around the world
working at the International Technical Support Organization, Rochester Center.

Justine Middleton is a Senior AS/400 Specialist at the International Technical
Support Organization, Rochester Center. She writes extensively and teaches IBM
classes worldwide on Domino for AS/400 and Client Access/400. Before joining
the ITSO in 1998, Justine worked for IBM Australia as a Senior IT Specialist in
the Business Server team. Justine holds an MBA from the University of Western
Australia and is a Certified Lotus Professional R5 Domino System Administrator.

Gerri Passe is a Senior Information Technology Specialist with the IBM Americas
Advanced Technical Support organization. She most recently joined the AS/400
Domino Competency Center with a focus on Fax for Domino. During the last
three years, she has worked with AS/400 customers and Business Partners
implementing IBM Network Stations. Gerri has also presented at numerous
internal and external technical conferences. In addition, she has seven years
prior AS/400 experience as an IBM Systems Engineer and Services Specialist
working with Client Access and AS/400 Internet connectivity.

Yoshiko Tashima is an IT Specialist in IBM Japan. She has 11 years of
experience with IBM in presales and developing AS/400 applications. Her areas
of expertise include Domino for AS/400 and DB2 UDB for AS/400.

Felix Zalcmann is an IBM EMEA Domino for AS/400 Support Specialist with the
IBM Global Services organization in Austria. He started his career as an AS/400
IT Manager in Austria in 1989. He has been working for IBM Global Services
since 1997. He spent the first two years as an AS/400 Education Specialist for
Global Learning Services until he moved to his current position. Felix is a
frequent speaker on Domino for AS/400 at international technical meetings. He
has written extensively on Domino for AS/400 administration topics.
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Comments welcome

Your comments are important to us!

We want our redbooks to be as helpful as possible. Please send us your
comments about this or other redbooks in one of the following ways:

• Fax the evaluation form found in “IBM Redbooks review” on page 251 to the
fax number shown on the form.

• Use the online evaluation form found at http://www.redbooks.ibm.com/

• Send your comments in an Internet note to redbook@us.ibm.com
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Chapter 1. Introduction to Fax for Domino 4.1 for AS/400

Lotus Fax for Domino for AS/400 is a fax solution that is totally integrated with
both Domino and the AS/400 system and benefits from the proven reliability of
the AS/400 platform. It uniquely offers native integration with the AS/400 fax
hardware. And, unlike many other fax solutions, Fax for Domino doesn't require
an additional Domino server. Fax for Domino for AS/400 allows you to run your
fax server on the same AS/400 system that handles your mail. All you need is a
stand-alone Windows NT workstation with a Notes client to handle format
conversions. This avoids the additional cost and administrative headaches of an
extra server. If you prefer a single box solution, you can use the Integrated
Netfinity Server instead of the stand-alone workstation. Either way, a user simply
makes a request to send a fax and Fax for Domino for AS/400 handles the rest.

1.1 About Fax for Domino 4.1 for AS/400

The Fax for Domino solution from Lotus enables Notes users to send and receive
faxes directly from their Notes client or send faxes directly from within any
Microsoft Windows application. This increases convenience and reliability while
lowering overall fax-related costs. Fax for Domino makes fax communication as
easy as e-mail, whether you're in the office or on the road. Fax for Domino uses
your current telephone system and Domino infrastructure to route inbound faxes
to the recipient's inbox.

1.1.1 Availability
Fax for Domino (FxD) Release 4.1 for the AS/400 system is available in three
versions, therefore giving you a wide choice of options to meet your fax server
needs:

• Fax for Domino Pro Server: Allows you to use Fax for Domino with a
maximum of two fax ports. FxD Pro customers can use all the features of Fax
for Domino except the load balancing feature.

• Fax for Domino Team Server: Allows you to use up to four fax ports and all
the features available with Fax for Domino.

• Fax for Domino Enterprise Server: Allows you to use five or more fax ports.
Fax for Domino Enterprise customers can use all the features available with
Fax for Domino.

The number of fax ports is equal to the number of telephone lines that are
plugged into modems or intelligent fax cards (#2761 PCI Integrated Analog
Modem) that are connected to the Fax for Domino for AS/400 server.

Your support options for FxD vary depending upon where you live. In the
United States, support is from Lotus. In other countries, you may have an IBM
Support option. Please contact your IBM or Lotus representative for the options
in your country.

Note
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1.1.2 Summary of features
The capabilities of the Fax for Domino for AS/400 product are numerous. The
following list contains the major features of Fax for Domino:

• Faxing from the Notes Desktop: Send and receive faxes from the Notes
Desktop. Sending a fax becomes just like sending an e-mail. All you do is
compose a memo, specify a recipient in the Fax to: field, and send it. In
addition, the e-mail being faxed can include attachments.

• Print to Fax driver: Send faxes from within any Windows-based application
with the Print to Fax driver. A Lotus Notes client is required to use the Print to
Fax driver.

• Dynamic load balancing: Multiple Fax for Domino servers can work together
for maximum efficiency. Outbound faxes can be automatically routed to a
central fax server, which routes each fax to the shortest queue based on
throughput capabilities and the total size of the queue in bytes.

• Flexible inbound routing: Fax for Domino can automatically route inbound
faxes to recipients through: Dual Tone Multi-Frequency (DTMF), Customer
Subscriber Identification (CSID), fax port addressing, and manual routing. In
addition, support for Integrated Services Digital Network (ISDN) and Direct
Inward Dial (DID) routing is planned for the future.

• Schedule of transmission: Users can automatically delay fax transmission
until telephone rates drop.

• Full mobile support: Fax for Domino allows Notes users to send and receive
faxes right from their laptop when on the road, with full Domino security.

• Fax prioritization: Outbound faxes are automatically prioritized based on a
sender’s default priority levels, administrator-defined rules, and the time a fax
has waited in the queue.

• Full integration with Notes: Faxes are composed using the standard Notes
memo form. Faxes can be addressed using just the recipients' names. Cover
pages can be edited and modified using the fax options button right from
within the Notes Mail template.

• Domino-based administration: Fax for Domino uses familiar Domino
administration tools to configure and manage Fax for Domino, both locally and
remotely. System administrators can maintain user profile information in the
Domino directory or in a separate database.

• Convenient group settings: System administrators can assign outbound fax
priorities, default or custom cover sheets, and other configurable settings to
groups of Domino users automatically.

1.1.3 System requirements
Figure 1 shows the components of Fax for Domino for AS/400, including the
standard Notes administrator workstation that you use to manage your Domino
server and Fax for Domino for AS/400 installation.
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Figure 1. Fax for Domino for AS/400 system setup

Before installing Lotus Fax for Domino Release 4.1, ensure that your AS/400
system meets the following hardware and software requirements:

• OS/400 Version 4 Release 4 or later

• Domino for AS/400 Release 4.6.6b or 5.0.2a or higher

• A supported AS/400 fax device, such as IBM 7852 Model 400 Modem, or
Feature #2761 PCI Integrated Analog Modem, which supports up to eight
telephone lines. Support for the previously announced #2750 and #2751 PCI
ISDN cards may be available at a later date. Support will be announced at:
http://www.as400.ibm.com/domino/related/fxd

In addition, one or more analog telephone lines are required.

The required Windows NT workstation or server can be a separate stand-alone
workstation, a separate stand-alone server, or an AS/400 Integrated Netfinity
Server. It must meet the following hardware and software requirements:

• Windows NT Workstation or Server software Version 4.0 with SP4 or later
(Microsoft Windows 2000 is not supported)

• Pentium or equivalent 166 MHz processor or higher

• At least 80 MB of memory (96 MB recommended)

• At least 150 MB of hard disk space available

• Notes client software that corresponds to the level of the Domino server must
be installed on the FxD Windows Services System. The Notes client software
provides the communication between the FxD server application and the

Windows NT workstation or server;
runs Fax for Domino Windows
Services; performs format
conversion (could replace with
AS/400 Integrated Netfinity Server)

Runs Domino and Fax for
Domino; has fax hardware;
may have Integrated
Netfinity Server

For managing
Domino server,
running AS/400

commands

LAN

Administrator
Workstation

AS/400

Fax for Domino
Windows

Services System

The majority of Fax for Domino for AS/400 runs natively on your Domino for
AS/400 server. A small portion of the product that performs format conversions
must be installed on a Windows NT workstation or server.

Note
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Windows Services application. The FxD Windows Services System must be
dedicated to FxD and is not available for other Notes functions. However, the
Windows NT system can be used concurrently with non-Notes applications.

Because an extra Windows NT server isn't required, you don't need to worry
about extra server administration. No persistent customer data resides on the
Windows NT workstation, so there's nothing to back up. Other facts about the
Windows NT workstation that converts memos to image format include:

• Multiple Fax for Domino servers can use the same Windows NT workstation.
You don't need multiple Windows NT workstations just because you have
multiple fax servers.

• If you install your workstation applications on the Windows NT system, FxD
can create and fax an image of file attachments that use those applications.

• Because CPU-intensive image conversions are off-loaded to the Windows NT
workstation, normal fax workloads have a relatively low impact on your
Domino for AS/400 server.

1.1.4 Client requirements
Lotus Notes clients earlier than R4.6 have not been tested. When using mail
templates mail45.ntf, mail46.ntf, mailc46.ntf, mail50ex.ntf or higher, a Fax to:
option is found on the Notes memo. If using other templates, users can use the
To: field to address faxes.

Web mail clients and POP3 clients are also supported by Fax for Domino. A
summary of the functions available for each client type is found in Table 3 on
page 81.

How to use each of these clients is described in detail in Chapter 6, “Using Fax
for Domino: A user’s perspective” on page 81.

It is also possible for a PC to use the Lotus Print to Fax driver to fax PC
application output directly. The PC must have a Lotus Notes client installed for
this function to be available. Further information can be found in 6.1.2, “Sending a
fax directly from a PC application” on page 90.

1.2 Before installing Fax for Domino for AS/400

Prior to installing FxD, you should read through the Release Notes for Fax for
Domino for AS/400 4.1, which are available at the Web site:
http://www.as400.ibm.com/domino/related/fxd/

Ensure that you obtain the PTFs as described. For example, you should
download and install the latest Domino for AS/400 Quarterly Maintenance Update
from the Web at: http://www.as400.ibm.com/domino/QMUList.htm

If you choose to use an Integrated Netfinity Server to perform the image
conversions rather than a stand-alone workstation, remember that the
Integrated Netfinity Server only supports installation of Windows NT Server
(not Windows NT Workstation).

Note
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Additional information on planning and installing FxD for AS/400 can be found in
Chapter 3, “Planning and preparation” on page 23, and Chapter 4, “Installation”
on page 35.

1.3 Fax for Domino flow overview

As mentioned earlier, FxD allows Lotus Notes users to send and receive faxes
directly from their Notes client or send faxes directly from within any Microsoft
Windows application. When FxD is installed, user profile settings define how FxD
handles each individual user's outgoing and incoming faxes. The user profile
settings include:

• The class of service
• Cost code
• Cover page settings
• Settings for receiving incoming faxes

The installation process creates one Person (DefaultFxDUser) document, which
supplies default user profile settings to the server when individual user profile
settings have not been created for a user. The administrator may edit the
document to change these default values. Also, the fax settings for individual
users can be changed if they need values other than those specified in
DefaultFxDUser. The individual user fax settings are set in the Fax section of the
Person document (if using combined administration) or in a user profile in
nfxadmin.nsf (if using separate administration). See 3.2, “Planning for separate
versus combined administration” on page 24, for more information.

We recommend that you modify the DefaultFxDUser Person or User Profile
document so that it contains settings that meet the needs of most of the people in
your organization. Additional information on setting up your users’ environment can
be found in the database FxD for AS/400 Administrator’s Guide (nfxa400.nsf). We
now provide an introduction to the flow of inbound and outbound faxes using FxD.

The Fax for Domino for AS/400 Installation Guide is shipped with the FxD
product and is also available online at the following Web site:
http://www.as400.ibm.com./domino/related/fxd/FXDINSTL.PDF

The installation guide takes you through the process necessary to set up and
configure Fax for Domino in a step-by-step style, with less explanation than
this redbook and no figures. You can use either document to guide your setup.
You may decide to use the installation guide and then return to this redbook for
additional information.

Note

Information on separate and combined administration is included in 3.2,
“Planning for separate versus combined administration” on page 24. Also, an
example of changing user settings is contained in 7.1.4, “Assigning a cover
page to individual users” on page 121.

Note
Chapter 1. Introduction to Fax for Domino 4.1 for AS/400 5



1.3.1 Outbound fax flow using Fax for Domino
One of the advantages of using FxD is that end users can directly send a fax from
their Lotus Notes client (or Web mail client) or from a Microsoft Windows based
application. In Figure 2, the general flow of an outbound fax sent using FxD to a
receiving fax machine is illustrated. Additional details on sending a fax from a
user’s perspective is included in Chapter 6, “Using Fax for Domino: A user’s
perspective” on page 81. Figure 2 is further explained in the list that follows.

Figure 2. Outbound fax flow using FxD

1. Pete, a Lotus Notes user at the central office, is creating an e-mail with a
Lotus Word Pro attachment, which needs to be sent to other Lotus Notes
users and also to Jane. However, the remote office where Jane works only
has a fax machine.

2. To send a fax to Jane, Pete completes the Fax to: field in his e-mail to indicate
that the fax needs to be routed to Jane’s fax machine. Pete also enters the
e-mail addresses of the Notes users in the To:, cc or bcc: fields. As shown in
step 2 in Figure 2, Pete then sends (and saves) his “e-mail fax” which is routed
to the AS/400 Domino server.

3. The Domino for AS/400 mail server passes Pete’s “fax e-mail” to the Fax for
Domino for AS/400 server.

Windows NT workstation or server,
runs FxD Windows Services,
performs format conversion
(could be an AS/400 Integrated Netfinity Server)

Runs Domino and FxD,
has fax hardware,
may have Integrated
Netfinity Server

LAN

AS/400

Fax for Domino
Windows Services

System
End User

Workstation

Lotus Notes client
(or Web mail client)

1

2

6

4

5

3

7

This “e-mail fax” could also have been sent to a fax machine by using an
address in the To:, cc: or bcc: fields, which include the fax phone number
and fax domain.

Note
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4. The FxD AS400 server passes the fax request to the FxD Windows Services
System, which then handles converting the document, cover page (if
requested), and Lotus Word Pro attachment to the TIFF format.

5. The FxD Windows Services System routes the TIFF files back to the FxD for
the AS/400 server after the conversion is complete.

6. The FxD for AS/400 server then takes the converted TIFF files and sends
them as a fax to Jane’s fax machine. Jane now has the fax that Pete sent.

7. Unless Pete’s default settings have been changed, he receives notification in
his mail indicating that a “Fax has been transmitted”’.

1.3.2 Inbound fax flow using Fax for Domino
In addition to users being able to send an outbound fax from their Lotus Notes
client (or Web mail client), or from a Microsoft Windows based application,
inbound faxes can be received using FxD. Figure 3 illustrates the general flow of
an inbound fax from a fax machine to FxD and then to a Domino user using
manual routing. Additional details on receiving faxes from a user’s perspective is
in 6.1.3, “Receiving a fax” on page 95. The numbered diagram in Figure 3 is
discussed further in the list that follows.

Figure 3. FxD Inbound fax flow using manual routing

1. Jane, a manager in the remote office, needs to send a fax to Pete in the
central office. Jane uses her fax machine as usual, except that the phone
number she enters is the number of a phone line connected to a “fax port” on
the AS/400 system. The physical interface for this “fax port” is provided by the
IBM 7852 Model 400 Modem or the 2761 PCI Analog device.

2. The fax Jane sent comes through the fax port on the AS/400 system and is
received by the FxD for AS/400 server.

3. The Fax for Domino for AS/400 server then routes the inbound fax to the FxD
Windows Services System for conversion as needed.

Windows NT workstation or server,
runs FxD Windows Services,
performs format conversion
(could be an AS/400 Integrated Netfinity Server)

Runs Domino and FxD,
has fax hardware,
may have Integrated
Netfinity Server

Used to route
incoming faxes (for

manual routing)

LAN

Fax
Administrator's

Workstation

AS/400

Fax for Domino
Windows Services

System
End User

Workstation

Lotus Notes client
(or Web mail client)

6

5

1

3
4

2
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4. After completing any conversion, the FxD Windows Services System routes
the incoming fax back to the FxD for AS/400 server. In this case, since no
special inbound routing was used, manual routing is used and the fax will be
received into the designated “fax administrator’s” mailbox first.

5. Since manual routing is used in our example, a “fax administrator” has been
designated in FxD to handle incoming faxes. This user looks at the cover
pages of faxes waiting in a Lotus Notes mailbox to determine to whom they
should be routed. In this case, Jane had written Pete’s name on the cover
sheet, so the “fax administrator” forwards the fax to Pete. Additional ways to
handle inbound faxes are described in 7.4, “Routing” on page 131.

6. Pete checks his mailbox in his Lotus Notes client and can view and print the
fax that Jane sent to him.

1.4 Facsimile Support/400

Many customers use Facsimile Support for AS/400 (5798-TBY) to fax both
AS/400 spooled files and PC documents from their AS/400 system. This section
explains the positioning of Facsimile Support for AS/400 and FxD.

Both products can use the 2761 PCI Analog device and the IBM 7852 Model 400
Modem to send and receive faxes. In addition, it is planned that both will support
the PCI ISDN card. Facsimile Support for AS/400 can also be used with the older
SPD-based Fax Adapter (no longer marketed) as well as the external PC-based
solution using GammaFax cards.

Facsimile Support for AS/400 and FxD can co-exist on the same AS/400 system.
You simply define some of the eight analog lines on the 2761 to be for Facsimile
Support for AS/400 and some of them to be for FxD.

Consider the following points when making your choice of product:

• If you have implemented Lotus Domino for AS/400 and are now looking for a
fax solution, you should install FxD. Features of FxD have been described in
1.1.2, “Summary of features” on page 2. FxD allows you to fax directly from
your Lotus Notes desktop using ad-hoc fax numbers as well as numbers
stored in Person documents in your Personal Address Book or the Domino
Directory (Public Address Book).

The administrative interface is Notes based and, therefore, graphical. It is
possible to fax AS/400 spooled files and OfficeVision documents using FxD.
We describe how in Chapter 9, “Faxing from the AS/400 system” on page 153.
If you find that the options for faxing spooled files do not meet your
requirements, look at Facsimile Support for AS/400 as an additional part of
your implementation.

• If you have already installed Facsimile Support for AS/400 and are now
implementing a Domino solution, you should consider installing FxD to
complement and enhance your faxing capabilities. You may have already
programmatically integrated Facsimile Support for AS/400 with your
line-of-business applications, and you will want to maintain that functionality. If
you are using a 2761 card for your faxing, you can easily allocate one or more
lines to your new FxD solution. Your Notes users will be able to send faxes as
an integrated part of their regular e-mail sending activity.
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• If you have no plans to use Domino for AS/400 in your installation, you should
install Facsimile Support for AS/400. It uses a familiar AS/400 interface for
managing inbound and outbound faxes. Facsimile Support for AS/400 can
also be used for faxing Windows-based output by using the AFP printer driver
provided with Client Access Express and Client Access for Windows 95/NT.

Although it is possible to fax a single Notes document using the Client Access
AFP printer driver, it is not possible to automatically fax attachments that are
associated with the document. However, you can use each application used
for creating the attachments and perform the faxing manually. Font fidelity is
maintained when faxing using the AFP printer driver.

It is possible to use AnyMail/400 Integration to fax using Facsimile
Support/400 from Domino mail to people who have appropriate fax information
(fax numbers) defined in the AS/400 system distribution directory, but you lose
font fidelity in the process. This means that all fonts on the received fax will be
the same. Note that the system distribution directory may, in turn, use
information in the Fax Master List which is part of Facsimile Support/400. The
Lotus Memo may include attachments, but separate telephone calls are made
for each attachment. Only image attachments, such as GIF, BMP, JPEG, and
some TIFF images are supported. Some variations of these may not work, so
you should consider testing the faxing of attachments.

For more information on Facsimile Support for AS/400, see the Web site at:
http://www.as400.ibm.com/fax400/fax400.htm

This Web site provides links to additional resources, such as manuals.

1.5 The future

FxD R4.1 will enhance your company's faxing ability by enabling you to fax
directly from your Notes desktop and from Windows applications. You can also
incorporate AS/400 spooled files into your faxing options as is described in 9.1,
“Prerequisites for faxing spooled file attachments” on page 153. You will see as
you read through this redbook that you can use FxD R4.1 with Release 4.6 and
Release 5 Domino servers and with Release 4.6 and Release 5 Domino clients.
As with any software, there will continue to be new releases with enhancements.
Future planned enhancements to FxD for AS/400 include support for ISDN, Direct
Inward Dialing (DID) routing, and FxD 5.0 function. FxD 5.0 includes
improvements to queue management, least cost routing, the ability to send
inbound faxes directly to printers, and usability enhancements. No dates have
been announced for the enhancements to FxD for AS/400.

Throughout this book, any reference to Direct Inward Dialing (DID) support
also includes support for Dialed Number Identification Service (DNIS) and
Multiple Subscriber Numbering (MSN).

Note
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Chapter 2. The design of Fax for Domino for AS/400

In this chapter, we explain the design of the Fax for Domino for AS/400 product
on the AS/400 system. Even if you are not interested in detailed information
about how FxD works, we suggest you look through 2.2, “The detailed processing
of a fax” on page 16, which shows you how the Spool Mailbox entries change as
faxes flow through.

2.1 Fax for Domino for AS/400 architecture overview

In this section, we describe the framework (Figure 4) of Fax for Domino.

Figure 4. Fax for Domino for AS/400 Framework

2.1.1 Configurator
The Fax for Domino configurator is the component that manages the
configuration for the server. The configurator is also the component that allows
Fax for Domino to be a Notes add-in task.

2.1.2 Scheduler
The Fax for Domino scheduler is the component that manages the Fax for
Domino system. The scheduler loads and initializes the rest of the core
components. It uses the configurator module to determine the configuration to
use. And, it is responsible for terminating all components and for shutting down
the server.
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The FxD scheduler loads the configuration database and initializes internal
configuration data structures. It uses the system administration module to retrieve
the configuration. The scheduler is responsible for loading and initializing
configurable components.

The FxD scheduler is responsible for the scheduling of received fax requests for
processing by Fax for Domino and the flow of a fax through the various Fax for
Domino subsystems as it gets processed. There is a basic data structure within
Fax for Domino that is used to represent a fax. This data structure is passed to
the various subsystems by the scheduler as a fax is being processed. At any
time, only one subsystem has primary control of the fax job and is allowed to
modify it.

2.1.3 System administration manager
The Fax for Domino system administration manager is the component that reads
the Notes documents containing the Fax for Domino configuration. Configuration
information is requested by the scheduler at system startup and during periodic
maintenance. Other configuration information, such as user-specific
configuration, is requested only when needed.

2.1.4 Job spool
A Fax for Domino job spool is a persistent repository for fax jobs. A fax job is
either an outgoing or an incoming fax that must be delivered to a final destination.
A job spool may hold incoming jobs, outgoing jobs, or both. Every Fax for Domino
server must have a local job spool for incoming and outgoing faxes.

A Fax for Domino server may also be configured to use other Fax for Domino
servers in the same Notes domain for processing outgoing fax jobs. A Fax for
Domino server configured in this way is called a “parent”, and the other Fax for
Domino servers that it uses are called “children”. Jobs in the outgoing spool of a
parent may be assigned to a child's local spool to balance the processing load. A
job placed in a child's spool is essentially a copy of the same job in the local
spool. The job spool subsystem maintains the status of all copies of each job.
When a parent places a job in the child's spool, the child takes responsibility for
processing the job and has primary control of the fax job. The parent and children
are “tightly coupled,” in that direct connectivity via Notes networking between the
parent and each child is required.

The job spool subsystem, therefore, manages two types of spools: The local
spool and children spools. The local spool is a local Notes mail database, and
users can view the status of their outgoing faxes by viewing this database. The
children spools are in-memory class instances of spools that exist on other
servers. There is no local database representing these spools.

The use of load balancing with multiple Fax for Domino servers is described in
Chapter 11, “FxD in action” on page 177.

2.1.5 E-mail subsystem
The Fax for Domino e-mail subsystem provides the mechanism for Fax for
Domino to send e-mail. E-mails are sent for notification of incoming and outgoing
faxes, delivery of incoming faxes, non-delivery of outgoing fax requests, and
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alarms to administrators. The FxD e-mail subsystem is used only by the FxD
scheduler.

2.1.6 Job router
The Fax for Domino job router is responsible for all the processing associated
with the destination address of both outgoing and incoming fax jobs.

For outgoing fax jobs to multiple fax destinations, it creates multiple fax jobs from
the original fax job. The job router determines the destination address for an
outgoing fax job by parsing the original address and using user profiles when
necessary. The FxD job router is responsible for determining which server will be
used to process an outgoing fax job, for example, the local server or a child
server. It also fixes up the destination phone number for outgoing jobs using the
phone number translation database when necessary.

For incoming faxes, the job router determines the destination address using user
profiles.

The FxD job router is closely coupled with the FxD scheduler and is part of the
Fax for Domino engine consisting of the scheduler, configurator, and job router.

2.1.7 Device thread
The Fax for Domino device thread is the component that interfaces with fax
devices. There is one FxD device thread per fax device port. The device thread
allows a device to execute independently of the main Fax for Domino thread as a
separate thread of execution in OS/400.

2.1.8 Fax devices
The Fax for Domino fax device subsystem supports hardware devices that can
process faxes. Fax devices are the components that deliver faxes. When a fax
job has been successfully processed by a fax device, the job is considered
complete. There is a Fax for Domino device class instance for each device that
can process a fax, for example, a fax modem (7852 Model 400), or a port on an
intelligent fax board (2761 PCI Analog device). A device may be associated with
either incoming or outgoing faxes or both.

Fax devices are dynamically bound to a particular fax server according to the
configuration set up in Notes. There are three configuration settings that allow a
fax device to be used by Fax for Domino:

• A device configuration document in the Fax for Domino administration
database.

• An administration module entry in the notes.ini environment file for the admin
module that can read the configuration document

• A device module entry in notes.ini for the device module that implements the
interface to the device hardware.

Each fax device module supports the defined API that allows the Fax for
Domino components to work with it.
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After setting up Fax for Domino for AS/400, you find the following settings in
the notes.ini file for the AS/400 device plug-in:

– $FAXAdminMods=/QSYS.LIB/QDOMFXD.LIB/NFXADMIN.SRVPGM (administration
module interface)

– $FAXDeviceMods=/QSYS.LIB/QDOMFXD.LIB/NFXIBM.SRVPGM (device module
interface)

2.1.9 Format converter
The Fax for Domino format converter is the component that converts documents
from one format to another. For example, the FxD format converter converts a
Notes document to TIFF format. The format converter is responsible for three
basic types of conversions:

• Notes documents to TIFF

• Image format conversions, such as JPEG to TIFF

• Application documents to TIFF, such as Microsoft Word to TIFF. Application
document conversions are done via a mailFax Convert Server driver.

The Fax for Domino format converter has its own threads of execution so that
multiple documents can be converted concurrently.

In Fax for Domino for AS/400, the format converter program has its logic split
across the AS/400 and a Windows NT system:

• OS/400 Format Converter provides:

– All the error and event logging
– Management of thread/process states
– Start up of format converting threads

• Windows NT FxD Conversion Service will:

– Handle multiple format conversion requests from multiple Domino servers,
potentially residing on multiple AS/400 systems, by creating threads
corresponding to each thread created by an OS/400 format converter.

– Receive, convert, and return fax documents, images, and Notes
attachments that are sent to it from an OS/400 format converter.

– Return meaningful return codes and additional information to the OS/400
format converter whenever errors or meaningful events occur that need to
be logged into the fax logging database.

How exactly do these two processes work and communicate?

First of all, when the Windows NT FxD Conversion Service process
(qfxddaemonrtr.exe) is installed, it is installed as a Windows NT service that is
automatically started whenever the Windows NT server or workstation is
started.

Therefore, whenever an Integrated Netfinity Server Network Server
Description (NWSD) is varied on, or an external Windows NT system is
started, the Windows NT FxD Conversion Service process is started during
the Windows NT startup. This is necessary since this Windows NT FxD
Conversion Service must be active all the time to handle conversion requests
from OS/400 format converters. Consequently, the best solution for this 24/7
requirement is to ensure that:
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• It is started whenever the Windows NT server or workstation, on which it is
installed, is started. The installation process sets this up by default.

• There is a “watchdog” service that is also started whenever the Windows
NT server or workstation is started that monitors the Windows NT FxD
Conversion Service making sure that it remains active. If it ever ends
(without an administrator ending it), this “watchdog” service restarts the
Windows NT FxD Conversion Service.

During the startup process, the Windows NT FxD Conversion Service
registers itself first with the Windows NT Service Control Manager. Besides
setting itself up as a service at startup time, the Windows NT FxD Conversion
Service needs to create one more item, the socket, so that it can communicate
with the OS/400 format converter.

When the OS/400 format converter service program begins executing, it
determines whether it will communicate with a Windows NT FxD Conversion
Service running on a local Integrated Netfinity Server or an external Windows
NT server or workstation. It first checks the Domino server's notes.ini file for
the $FAXFMTCVTNWSD environment string. If this exists, the OS/400 Format
Converter determines that the Windows NT FxD Conversion Service is
running on a local Integrated Netfinity Server associated with the NWSD name
set to this $FAXFMTCVTNWSD variable. It extracts the IP address from the
Network Server Description so that it can communicate with the Windows NT
FxD Conversion Service service via the internal AS/400 bus.

If the Domino server's notes.ini file does not contain the $FAXFMTCVTNWSD
environment string, (or if it contains a $FAXFMTCVTNWSD environment string
with no value), it then searches for $FAXFMTCVTHOST. If this exists and has
a value associated with it, the OS/400 format converter can determine that the
Windows NT FxD Conversion Service is running on an external Windows NT
server or workstation. This includes an Integrated Netfinity Server located on a
different AS/400. Therefore, using the Windows NT TCP/IP host name to
which $FAXFMTCVTHOST is set, the OS/400 Format Converter can
determine the IP address that it should use.

Once the correct IP address has been determined, the correct port number
must be obtained. The OS/400 format converter does this by searching the
Domino server's notes.ini file for the $FAXFMTCVTPORT environment string.
If it doesn't exist, port 19700 is the default port. If it does exist, the value
returned is the port that is to be used. You should not change this variable
unless instructed to by Support. At this point, all the information needed to
communicate with the Windows NT FxD Conversion Service has been
obtained. Therefore, the OS/400 format converter continues by starting up to
handle fax conversion requests.

Now, whenever a conversion request is signalled to the OS/400 Format
Converter, it passes the necessary information to the FxD Windows Services
System. Once the files have been successfully created as TIFF or JPEG files
by the Windows NT FxD Conversion Service, they are read and their contents
are sent back to the OS/400 format converter thread that receives the data
and creates identical files in the
/QIBM/UserData/LOTUS/FAX/TMP/servername IFS directory.
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2.1.10 Log subsystem
The Fax for Domino log subsystem is the component that records events and
errors for the Fax for Domino server. The level of event and error logging is
configured by the administrator. Error and events are categorized as major or
minor. An example of a major event is when a fax has been received by the
Fax for Domino server. An example of a minor event is when a device has
dialed a destination fax number and is waiting for an answer. An example of a
major error is when a fax transmission by a device fails. An example of a
minor error is when fax transmission fails and must be retried. The Fax for
Domino log is a Notes database (nfxlog.nsf). It is also possible to configure
Fax for Domino so that errors and events are logged in the Notes log (log.nsf)
as well as the Fax for Domino log (nfxlog.nsf).

2.2 The detailed processing of a fax

The following sections illustrate how the various components are involved in
processing a fax. The changing status of the fax in the spool mailbox database
(nfxspook.nsf) is tracked. If you are interested in a higher level overview, see 1.3,
“Fax for Domino flow overview” on page 5.

2.2.1 Outgoing fax
When a fax is sent using FxD, the following steps occur:

1. A Notes user sends a fax, as shown in Figure 5, which is delivered to the local
spool for the Fax for Domino server.

Figure 5. A Notes user sends a fax

2. The Fax for Domino scheduler polls the job spool, discovers a new outgoing
fax job (see Figure 6), and reads it from the spool. The fax job state is now
New Request.
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Figure 6. The scheduler polls job spool

3. The Fax for Domino scheduler passes the fax job to the Fax for Domino job
router. The job router then determines which local spool should process the
fax job. The fax job state is now queued.

4. The Fax for Domino scheduler passes the fax job to the format converter
(Figure 7) to convert the cover page, the Notes document, and any
attachments to TIFF format. The state of the fax job is now Fax job conversion
is occurring. The conversion takes place on the FxD Windows Services
System.

Figure 7. The scheduler passes the fax job to format converter

5. The Fax for Domino format converter passes the fax job back to the scheduler
after the conversion. The fax TIFF files are now stored on the AS/400 system
in an IFS directory. The fax job state is now ready for delivery.

6. The Fax for Domino scheduler checks if there is an idle device and assigns
the fax job to the Fax for Domino device thread for delivery (see Figure 8 on
page 18). The fax job state is now Fax device is processing job.
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Figure 8. The fax device is processing the job

7. The Fax for Domino device thread passes the fax job to the fax device for
delivery.

8. The device notifies the Fax for Domino device thread when the delivery is
completed.

9. The Fax for Domino device thread passes the fax job back to the Fax for
Domino scheduler after the fax has been transmitted (Figure 9). The fax job
state is now Fax processing completed.

Figure 9. The fax processing is completed

10.If requested, the Fax for Domino scheduler passes the fax job to the e-mail
subsystem and requests a notification e-mail to be sent saying that the fax job
has completed successfully (Figure 10).
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Figure 10. The scheduler passes the fax job to the e-mail subsystem

11.The Fax for Domino scheduler deletes the fax job from spool.

2.2.2 Incoming fax
When a fax is received by FxD, the following steps occur:

1. The Fax for Domino device thread receives an incoming fax and passes it to
the scheduler.

2. The Fax for Domino scheduler adds a fax job to the local spool (Figure 11).
The fax job state is New.

Figure 11. The scheduler adds a fax job to the local spool

3. The Fax for Domino scheduler polls the incoming fax spool and discovers a
new incoming fax job and reads it from the spool.
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4. The scheduler passes the fax job to the Fax for Domino job router. The fax job
state is now Queued.

5. The Fax for Domino scheduler passes the fax job to the format converter.
Some extraneous TIFF information needs to be parsed out so that the TIFFs
are viewable and can be converted to another image format if necessary
(Figure 12). The fax job state is now Fax job conversion is occurring. The
conversion takes place on the FxD Windows Services System.

Figure 12. The scheduler passes the fax job to the format converter

6. The Fax for Domino format converter passes the fax job back to the scheduler
after conversion (Figure 13). The fax TIFF files are stored on the AS/400
system in an IFS directory. The fax job state is now Fax is ready for delivery.

Figure 13. The format converter passes the fax job back

7. The Fax for Domino scheduler passes the fax to the e-mail subsystem for
delivery (Figure 14).
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Figure 14. Incoming fax received

8. The Fax for Domino scheduler passes the fax job to the e-mail subsystem. If
configured, the scheduler also requests a notification e-mail be sent saying
that an incoming fax has been received.

9. The Fax for Domino scheduler deletes the fax job from the spool.

2.2.3 Print to Fax driver
The Lotus Print to Fax driver allows users with Notes clients to send faxes directly
from a PC application, such as Lotus Word Pro. How to use this driver is
described in detail in 6.1.2.1, “Using the Lotus Print to Fax driver” on page 91.

From the fax processing perspective, the main difference between sending a fax
using the Print to Fax driver and faxing from within Notes is that the conversion of
the PC document being faxed takes place on the workstation PC and not on the
FxD Windows Services System. This means that an application can be used on
the PC when that application is not on the FxD Windows Services System at all.
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Chapter 3. Planning and preparation

In this chapter, we discuss a number of items that you must consider before you
install and configure Fax for Domino for AS/400.

Note: We do not cover FxD performance in this redbook. You can find a link to
some performance data at: http://www.as400.ibm.com/domino/related/fxd

3.1 Domino server considerations

First, you have to think about the Domino server on which you want the Fax for
Domino server to be installed. Do you want a server that is only responsible for
Fax for Domino, or do you want to add Fax for Domino to an existing Domino
server?

3.1.1 Using an existing Domino server for Fax for Domino
You can use an existing Domino for AS/400 server to handle your Fax for Domino
requests, and you can install and configure Fax for Domino on any additional
Domino for AS/400 server. Using an existing Domino server as your Fax for
Domino server, you can restart the Fax for Domino task in case of problems
without interfering with your existing mail users.

Under most circumstances, you should consider running Fax for Domino on an
existing server. Fax for Domino is so robust that it will not cause the server to
crash and is economical in its use of resources.

3.1.2 Using a specific Domino server for Fax for Domino
You can also use a Domino for AS/400 server that is dedicated to Fax for Domino
requests. One advantage of using a specific Fax for Domino server is that if there
are problems, it is possible for you to restart the Fax for Domino task, or even the
whole server, without interfering with your existing mail users. You may decide to
use this in a more complex environment as shown in Figure 15 on page 24.
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Figure 15. Specific fax server in complex environment

If you want to set up a Domino for AS/400 server only for serving fax requests,
follow the installation steps described in Lotus Domino for AS/400 - Installation,
Customization, Administration, SG24-5181 (Domino Release 4.6.x) or Lotus
Domino for AS/400 R5: Implementation, SG24-5592 (Domino R5).

3.2 Planning for separate versus combined administration

There are two ways you can configure your Fax for Domino. The difference
between them relates to how administration of your fax users is managed.

• Separate administration where you use a separate administration database
(nfxadmin.nsf) for Fax for Domino.

• Combined administration where the server’s Domino Directory (names.nsf) is
used to hold fax related configuration information.

Whether you are using combined or separate administration, the cover page
forms and the sample cover page documents are stored in the Fax for Domino
cover page database (nfxcover.nsf).

3.2.1 Separate administration
When using separate administration, configuration documents related to the
following items are stored in the Fax for Domino administration database (Figure
16):

• Fax for Domino servers
• Classes of Service
• User Profiles
• Fax Devices
• Telephone Number Translation
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Backup
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Figure 16. Using separate administration

A reason to use separate administration is when you have different Domino
Domains in your organization. This means that you probably have different
Domino Directories replicated across servers in your organization to assist in
addressing mail. With the use of separate administration, you still have control
over who can perform fax administration. The setup of FxD for separate
administration creates a separate Fax for Domino administration database where
the database‘s Access Control List (ACL) can be set up.

Another advantage of separate administration is that you can set up individual
user profiles for SMTP users of FxD. See 5.2, “User profiles” on page 64, for
information on this.

In addition, some organizations may decide that they do not want the Domino
Directory (names.nsf) to be used for any function other than standard Domino
server activities.

In the Notes.ini file, you find an entry, $FaxAdmin=nfxadmin.nsf. This indicates
that separate administration is being used because the name of the
administration database is specified.

3.2.2 Combined administration
When using combined administration, configuration documents related to the
following items are stored in the primary Domino Directory of your organization
(Figure 17 on page 26):

• Fax for Domino servers
• Classes of Service
• User Profiles
• Fax Devices
• Telephone Number Translation
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Figure 17. Using combined administration

A reason to use combined administration is that the user profile information is
simply an extension of the Person document in the Domino Directory. This makes
the management of routing codes and other user profile-relevant information
easier since there is only one place to update this information. Using combined
administration, all fax servers can be administered from a centralized database,
the Domino Directory.

In the Notes.ini file, you find an entry, $FaxAdmin= . This indicates that combined
administration is being used because the name of the administration database is
blank.

3.3 Planning for the FxD Windows Services System

Before installing Fax for Domino, you have to plan your FxD Windows Services
System. You have two options when setting up your FxD Windows Services
System, which are:

• AS/400 Integrated Netfinity Server
• External Windows NT server or workstation

3.3.1 Using an Integrated Netfinity Server
You can use a Windows NT server running on an Integrated Netfinity Server as
your FxD Windows Services System. Using an Integrated Netfinity Server on the
same AS/400 system as Fax for Domino gives you the opportunity to use the
internal system bus to communicate between the AS/400 system and Windows
NT. This means that all requests that are passed from the AS/400 part of Fax for
Domino to the Windows NT part (the Windows NT FxD Conversion Service) will
use the internal TCP/IP address and the internal LAN. To set up Windows NT on

If you install Fax for Domino with combined administration and then uninstall
the product, the Fax for Domino subforms will remain in the Domino Directory.
The only way to remove them is manually. See 5.11.1, “Moving from combined
to separate administration” on page 78, for information on the subform names.

Note
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the Integrated Netfinity Server, please see AS/400 - Implementing Windows NT
on the Integrated Netfinity Server, SG24-2164.

You can also use an Integrated Netfinity Server on a different AS/400 system to
be your FxD Windows Services System. In this case, the internal system bus will
not be used for communication between the AS/400 system and Windows NT.
Instead, Fax for Domino for AS/400 communicates with an Integrated Netfinity
Server on a different AS/400 system in exactly the same way as it does with an
external Windows NT server.

3.3.2 Using an external Windows NT server or workstation
You can use an external Windows NT server or workstation as your FxD Windows
Services System. The minimum hardware system configuration for this external
solution is:

• Pentium or equivalent 166 MHz processor or higher
• At least 80 MB of memory (96 MB recommended)
• At least 150 MB of hard disk space available

You need to install and configure TCP/IP correctly on your external FxD Windows
Services System so that communication between the AS/400 system and your
external Windows NT server or workstation, using the TCP/IP protocol, is
possible.

For both options, you need the following software on your FxD Windows Services
System:

• Windows NT Server or Workstation software version 4.0 with Service Pack
(SP) 4 or later.

• Notes client software that corresponds to the level of the Domino server you
are using for Fax for Domino for AS/400. We discuss installing the Notes client
software in 4.3.2, “Installing the Notes client on the FxD Windows Services
System” on page 41.

• All software programs that will be used by users to send attachments; they are
needed to complete the format conversion process so that you get fax pages
and not only the icon of the faxed attachment.

3.4 Information you need

To configure Fax for Domino, you need to gather some information. We provide
you with Table 1 on page 34, which you can use to record this information.

3.4.1 CSID for your fax lines
The Called Subscriber Identification (CSID) is usually the telephone number or
numbers you use for your fax lines. However, you can use a CSID code that
includes alphabetic characters. It is a string of characters that is sent with the fax

On the Integrated Netfinity Server, it is only possible to install the server
version of Windows NT not the workstation version.

Note
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and appears on the fax header that most fax machines print on incoming faxes.
You need to find out this information, since it will be used in the configuration. The
CSIDs can be changed after the setup, but you have to restart FxD for the change
to take effect.

3.4.2 TCP/IP host name of your AS/400 system
You can find the TCP/IP host name of your AS/400 system by selecting option 12
on the Configure TCP/IP (CFGTCP) menu.

3.4.3 TCP/IP host name of your external FxD Windows Services System
You must provide the TCP/IP host name of your FxD Windows Services System if
you are using an Integrated Netfinity Server located in a different AS/400 system
from Fax for Domino, or if you are using a stand-alone Windows NT server or
Workstation PC. Your network administrator may provide this information. Skip
this step and move to 3.4.4, “Network server description name” on page 29, if you
are using an Integrated Netfinity Server on the same AS/400 system on which
you are installing FxD.

If you are using a Domain Name Server (DNS) for TCP/IP name resolution, add
the host name and TCP/IP address of your FxD Windows Services System to
your DNS server.

If you do not use DNS for name resolution, add the host name and TCP/IP
address of your FxD Windows Services System to the AS/400 host table using
the Add TCP/IP Host Table Entry (ADDTCPHTE) command (Figure 18).

Figure 18. ADDTCPHTE command

Using the Packet Internet Groper (PING) command on the AS/400 system you
want to install Fax for Domino, verify that you get a response from your FxD
Windows Services System (Figure 19).

Add TCP/IP Host Table Entry (ADDTCPHTE)

Type choices, press Enter.

Internet address . . . . . . . . 10.1.1.10________
Host names:
Name . . . . . . . . . . . . . fxdntpc_____________________________________

________________________________________________________________________________
________________________________________________________________________________
____________________________________________________

+ for more values _
Text 'description' . . . . . . . ____________________________________________
____________________________________

Bottom
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys
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Figure 19. Using PING to verify connection

Since you are using an external FxD Windows Services System or an Integrated
Netfinity Server on a different AS/400 system, skip the next section and go to
3.4.5, “Determining which fax hardware is installed on the AS/400 system” on
page 29.

3.4.4 Network server description name
If you will run Fax for Domino Windows Services on an Integrated Netfinity Server
on the same AS/400 system where you will install Fax for Domino, you need to
find out the name of your network server description. Your AS/400 administrator
can provide this information.

3.4.5 Determining which fax hardware is installed on the AS/400 system
To configure your fax devices during the setup of Fax for Domino for AS/400, you
must first be sure that you have the supported hardware available and installed
on your AS/400 system.

3.4.5.1 IBM Analog device
The IBM Analog device that is supported is the analog modem 7852 model 400.

This modem is a high-performance, high-function modem designed for
commercial and server applications. It is also designed and tested for use as a
AS/400 Electronic Customer Support (ECS) modem and with Fax for Domino for
AS/400 as a fax modem.

Display All Messages
System: AS26

Job . . : QPADEV0001 User . . : ZALCMANN Number . . . : 008549

3>> ping fxdntpc
Verifying connection to host system FXDNTPC at address 10.1.1.10.
PING reply 1 from 10.1.1.10 took 55 ms. 256 bytes. TTL 126.
PING reply 2 from 10.1.1.10 took 47 ms. 256 bytes. TTL 126.
PING reply 3 from 10.1.1.10 took 59 ms. 256 bytes. TTL 126.
PING reply 4 from 10.1.1.10 took 97 ms. 256 bytes. TTL 126.
PING reply 5 from 10.1.1.10 took 94 ms. 256 bytes. TTL 126.
Round-trip (in milliseconds) min/avg/max = 47/70/97
Connection verification statistics: 5 of 5 successful (100 %).

Bottom
Press Enter to continue.

F3=Exit F5=Refresh F12=Cancel F17=Top F18=Bottom

Your system must have an RS-232 serial interface, which is provided by the
communications adapter, which includes an Enhanced EIA 232/V.24
connection.

You probably have this on your system for ECS and data usage.

Note
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The features and benefits include:

• Full V.25bis Synchronous Support.

• Two-wire Leased Line Support with Switched Network Back-Up: Automatically
guides you to another line if your initial connection fails.

• Data/Fax speeds: Data transmission speeds up to 33.6 Kbps, fax speeds up to
14.4 Kbps.

• Two-level password protection: Two-level password protection regulates
access to the modem remote configuration utility through a datacom link.

• Flash Memory: Flash Memory for firmware updates.

• Caller ID (CSID) support.

• Maximum throughput of 115.2 Kbps: Uses V.42bis 4:1 data compression.

There are some restrictions with the 7852-400 modem. It does not support a
banner (where people often put their CSID), Error Correction Mode, 2D (a form of
compression), and Dual Tone Multi Frequency (DTMF). It supports CSID-based
inbound faxing. We recommend that you use this modem only in relatively light
faxing environments. You can use several of these modems to allow the use of
dedicated modems for inbound and outbound faxes.

3.4.5.2 IBM PCI Analog
The IBM PCI Analog device that is supported is the 8 port analog modem card,
feature code 2761.

The 2761 PCI Integrated Analog Modem contains eight ports. The 2761 PCI
Integrated Analog Modem also provides connections, by using V.34, for remote
sites with an analog connection to the network.

The features and benefits:

• Analog-to-analog connections
• Analog-to-digital connections

If a modem has dip switch settings for autoanswer, do not enable autoanswer
via the dip switch setting. Fax for Domino automatically answers incoming calls
to fax modems that have been enabled for receiving via the Fax for Domino
modem configuration document. Setting autoanswer with the modem dip
switch may interfere with Fax for Domino’s ability to answer incoming calls. For
the IBM analog 7852 model 400 modem, we recommend that dip switch
settings 3, 4, 8, 9, and 11 be set in the down position.

Note

The AS/400 models 640/650/S30/S40 and 730/740 have only the SPD bus in
their base support. If you want to use the IBM PCI Analog device 2761 on
these systems, the Storage/PCI Expansion Tower 5065 is required, because
this expansion tower allows the connection of PCI cards into the SPD bus
systems.

Note
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• PPP (synchronous and asynchronous)
• Fax over asynchronous communications (used by Fax for Domino)
• Synchronous data link control (SDLC)

Use the Work with Hardware Resources (WRKHDWRSC) type *CMN command to
determine if this card is installed on your AS/400 system (Figure 20).

Figure 20. WRKHDWRSC *CMN

3.4.5.3 ISDN devices
For information about supported ISDN devices, please refer to Appendix D,
“ISDN” on page 223.

3.5 Registering a Notes user for the FxD Windows Services System

This section describes how to register a Notes user to be used by the Notes client
on the FxD Windows Services System.

When you register the user, you can choose to store the new user ID as an
attachment to the Person document in the Domino Directory, in a file on the disk
drive of your workstation, or both.

If the ID file is stored in the Domino Directory, the setup process (see 4.3.3,
“Configuring the Notes client on the FxD Windows Services System” on page 41)
accesses the Directory database directly and detaches the ID file onto the FxD
Windows Services System. In this case, it is mandatory to specify a password,

Work with Communication Resources
System: AS26

Type options, press Enter.
5=Work with configuration descriptions 7=Display resource detail

Opt Resource Type Status Text
CMB01 6757 Operational Combined function IOP
LIN01 2720 Operational Comm Adapter
CMN01 2720 Operational Comm Port

LIN02 2745 Not detected Comm Adapter
CMN02 2745 Not detected Comm Port
CMN03 2745 Not detected Comm Port

LIN03 2724 Operational LAN Adapter
CMN04 2724 Operational Token-Ring Port

LIN06 2761 Operational Comm Adapter
CMN07 2761 Operational Comm Port
CMN08 2761 Operational Comm Port
CMN09 2761 Operational Comm Port
CMN10 2761 Operational Comm Port
CMN11 2761 Operational Comm Port
CMN12 2761 Operational Comm Port

More...
F3=Exit F5=Refresh F6=Print F12=Cancel

Consider using the following values when you register the user:

• First name: The TCP/IP host name of your FxD Windows Services System
• Last name: Fax

Note
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even if you selected a minimum password length of 0. How to remove the
password after set up is described in 4.3.3.1, “Removing the password” on page
43. Note that to remove the password later, you must set the minimum password
length to 0. If you did not, you have to recertify your user or create another user.

If you choose to store the ID in a file, it is saved to the selected drive on your
workstation. It can be put on a diskette and used for the FxD Windows Services
System setup. If you are using an Integrated Netfinity Server and, therefore, do
not have a diskette drive, follow the instructions in the Installation Guide to use
FTP to access the file.

3.6 Advanced planning considerations

There are some more advanced configurations that you may want to consider,
either now or in the future.

3.6.1 One FxD Windows Services System serving multiple FxD servers
With FxD, it is possible to use one FxD Windows Services System to serve
multiple FxD servers. These servers can reside on the same AS/400 system or
on multiple AS/400 systems. They all need to be connected via the same LAN.

If the Domino servers are in the same Domino Domain, you can take advantage
of load balancing to maximize the use of your hardware.

3.6.2 One FxD Windows Services System serving different organizations
You may want to use one FxD Windows Services System to serve more than one
Notes organization (see a possible scenario in Figure 21). In this case, you have
to cross certify the Notes user ID that you are using for the FxD Windows
Services System with the cert.id file of this additional Notes organization.

With this type of cross certification, this single Notes user (the FxD user
registered for ACME) can authenticate with all Domino servers within both
organizations and, therefore, can receive fax requests. However, because this is
a cross certification only for a single Notes user ID file and not for an
organization, the first organization (ACME) cannot authenticate with any other
Domino server within the second organization (ABC). This means that no
end-user from one organization can gain access to Domino servers in the other
organization and vice versa.

The method for setting this up is described in A.2, “Cross certifying the user ID
file” on page 202.
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Figure 21. Two FxD servers share one FxD Windows Services System

3.7 Before installing Fax for Domino for AS/400

Prior to installing Fax for Domino for AS/400, you should read through the latest
Release Notes for Fax for Domino for AS/400 4.1, which are available at the Web
site: http://www.as400.ibm.com/domino/related/fxd/

Ensure that you obtain the PTFs as described. For example, you should
download and install the latest Domino for AS/400 Quarterly Maintenance Update
from the Web at: http://www.as400.ibm.com/domino/QMUList.htm

Verify that your AS/400 system uses OS/400 Version 4 Release 4 or later.

In addition, we recommend that you install the latest AS/400 cumulative fix
package and check the latest Domino for AS/400 related PTFs appropriate for
your OS/400 release from: http://www.as400.ibm.com/domino/DomSupport.htm

Verify that the Administrator workstation for Domino Server has the Notes Client
with Administrative components installed.

If you are using the PCI Integrated Analog Modem (#2761) card, please check
Informational APAR II12188 for the latest umbrella PTF. Informational APARs can
be found online at: http://as400service.ibm.com

You must use the CHGNETA MDMCNTRYID(xx) command (where xx is your
corresponding modem country ID) to get the card to work properly. This
parameter is shipped blank.

Fax for Domino
Windows

Services System
in Notes

organization
ACME

LAN Notes
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3.8 The Fax for Domino for AS/400 planning table

Use Table 1 to gather all information necessary prior to installing Fax for Domino
for AS/400.

Table 1. Fax for Domino for AS/400 planning table

Item Sample value

CSID (refer 3.4.1, “CSID for your fax lines” on page
27).

555-1212

TCP/IP host name of your AS/400 (refer 3.4.2,
“TCP/IP host name of your AS/400 system” on
page 28).

ACME1

TCP/IP host name of your external FxD Windows
Services System (refer 3.4.3, “TCP/IP host name of
your external FxD Windows Services System” on
page 28). Only required if not using a local
Integrated Netfinity Server.

OR

Network server description name
(refer 3.4.4, “Network server description name” on
page 29). Only required if using a local Integrated
Netfinity Server.

FXDNTPC

Fax hardware installed on your AS/400 system
(refer 3.4.5, “Determining which fax hardware is
installed on the AS/400 system” on page 29).

X_ IBM PCI Analog (2761 (8-port))
__ IBM Analog (7852 model 400)

Fax hardware resource name or names (refer 3.4.5,
“Determining which fax hardware is installed on the
AS/400 system” on page 29).

CMN10

Notes user and password on FxD Windows
Services System (refer 3.5, “Registering a Notes
user for the FxD Windows Services System” on
page 31). You may prefer to remember the
password and not write it down.

FXDNTPC FAX
lotusnotes

The Fax for Domino for AS/400 Installation Guide is shipped with the FxD
product and is also available online at the web site:
http://www.as400.ibm.com./domino/related/fxd/FXDINSTL.PDF

The Installation Guide takes you through the steps necessary to set up and
configure Fax for Domino in a step-by-step style with less explanation than this
redbook and no figures. You can use either document to guide your setup. You
may decide to use the Installation Guide and then return to this redbook for
additional information.

Note
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Chapter 4. Installation

This chapter describes the installation and configuration of Fax for Domino. We
assume that you have:

• Made your decision as to whether you are going to run Fax for Domino on an
existing Domino server or if you are going to allocate a dedicated server to this
function. See 3.2, “Planning for separate versus combined administration” on
page 24, if this is not the case.

• Decided if you are going to use combined or separate administration for Fax
for Domino.

• Configured and started the AS/400 Domino server.

There are now several distinct steps to be completed before you can use Fax for
Domino:

1. Install the Fax for Domino software on the AS/400 system
2. Add the Fax for Domino server to a Domino server
3. Set up the FxD Windows Services System
4. Set up the Fax for Domino for AS/400 server
5. Configure Fax for Domino for AS/400
6. Set up Fax for Domino users
7. Start Fax for Domino for AS/400

4.1 Installing the Fax for Domino software on the AS/400 system

To install the Fax for Domino for AS/400 software, follow these steps

1. Sign on to your AS/400 system with a user profile that has the *ALLOBJ and
*SECADM special authorities.

2. Insert the Fax for Domino CD into the CD-ROM drive on your AS/400 system.

3. Enter the Load Run (LODRUN) command from any AS/400 command line and
press F4.

4. On the LODRUN panel, enter *OPT for Device. Press Enter and specify /OS400

for the Directory as shown in Figure 22.

Figure 22. LODRUN

Load and Run (LODRUN)

Type choices, press Enter.

Device . . . . . . . . . . . . . > *OPT______ Name, *TAP, *DKT, *OPT
Directory . . . . . . . . . . . /OS400______________________________________
________________________________________________________________________________
________________________________________________________________________________
____________________________________________________

Bottom
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys
RESTORING FAX FOR DOMINO LICENSED PROGRAM, PLEASE WAIT.
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Press Enter to run the command and wait for it to complete. You see the
message: Fax for Domino successfully installed as shown in Figure 23.

Figure 23. Fax for Domino successfully installed

This step copies the code to the AS/400 system. From there, it can be installed
on your specific server.

You can tell if Fax for Domino is on the AS/400 system by typing GO LICPGM on any
command line and selecting option 10. Scroll down until you see:

5733FXD *INSTALLED Lotus Fax for Domino

4.2 Adding the Fax for Domino server to an existing Domino server

Before you can add a Fax for Domino server to an existing Domino server, you
must end the Domino for AS/400 server where you plan to add it.

4.2.1 Shutting down the Domino server if it is active
To shut down the Domino server where you want to add Fax for Domino,
complete the following steps:

1. On any AS/400 command line, enter the Work Domino Server (WRKDOMSVR)
command.

2. If the Domino server where you want to add Fax for Domino is not in *ENDED
status, type a 6 beside the server name and press Enter (see Figure 24).

MAIN AS/400 Main Menu
System: AS24

Select one of the following:

1. User tasks
2. Office tasks
3. General system tasks
4. Files, libraries, and folders
5. Programming
6. Communications
7. Define or change the system
8. Problem handling
9. Display a menu
10. Information Assistant options
11. Client Access/400 tasks

90. Sign off

Selection or command
===> __________________________________________________________________________
_______________________________________________________________________________
F3=Exit F4=Prompt F9=Retrieve F12=Cancel F13=Information Assistant
F23=Set initial menu
Fax for Domino successfully installed.

It is not necessary that you shut down all your Domino servers on your AS/400
system.

Note
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Figure 24. WRKDOMSVR

Wait a few minutes for the server to end. Press F5 periodically to refresh the
status on the display until the Domino server status shows *ENDED.

4.2.2 Adding the Fax for Domino software to the Domino server
To add the Fax for Domino software, follow these steps:

1. On any AS/400 command line, type the Add Domino Application (ADDDOMAPP)
command and press F4 (see Figure 25).

Figure 25. ADDDOMAPP

Work with Domino Servers
System: AS24

Type options, press Enter.
1=Start server 2=Change server 5=Display console 6=End server
7=Submit command 8=Work console 9=Work server jobs
11=Change current directory 12=Work object links 13=edit NOTES.INI

Domino Domino
Opt Server Subsystem Status
6_ AS24FAXDOM AS24FAXDOM *STARTED

Bottom
Parameters or command
===>
F3=Exit F4=Prompt F5=Refresh F9=Retrieve F11=Display path
F12=Cancel F17=Top F18=Bottom F22=Display entire field F24=More keys

For details about managing a Domino for AS/400 server, see Lotus Domino for
AS/400 - Installation, Customization, Administration, SG24-5181 (Domino
Version 4.6.x), or Lotus Domino for AS/400 R5: Implementation, SG24-5592
(Domino R5).

Note

Add Domino Application (ADDDOMAPP)

Type choices, press Enter.

Server path: _
Server name . . . . . . . . . ____________________________________________

________________________________________________________________________________
________________________________________________________________________________
____________________________________________________

Data subdirectory . . . . . . *NONE_______________________________________
______

+ for more values _
Product . . . . . . . . . . . . _______ 5733FXD
Optional part to be added . . . *BASE *BASE, 0, 1, 2, 3, 4, 5, 6...

Bottom
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys
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2. On the Add Domino Application panel, enter values for the following fields:

• Server name: Specify the name of the Domino server where you want to
run FxD. While the cursor is on this field, you can press F4 to list the
Domino servers on this AS/400 system.

• Data sub directory: Specify *None, which is the default.

• Product: Specify 5733FXD

• Optional part to be added: Specify *BASE, which is the default.

Press Enter to run the command and wait for it to complete. You see the
display as shown in Figure 26.

Figure 26. Request to add application for licensed product 5733FXD option *base completed

When you run the ADDDOMAPP, command a number of actions occur. Several
databases are created on your Domino server, and the FaxAdmins group is
created in the Domino Directory.

4.2.3 Restarting the Domino server
To restart the Domino server perform these steps:

1. On any AS/400 command line, enter the Work Domino Server (WRKDOMSVR)
command and press Enter.

To add Fax for Domino to more than one server, you can run the
ADDDOMAPP command once for all servers by using a + for more values. Do
not specify *ALL.

Note

MAIN AS/400 Main Menu
System: AS24

Select one of the following:

1. User tasks
2. Office tasks
3. General system tasks
4. Files, libraries, and folders
5. Programming
6. Communications
7. Define or change the system
8. Problem handling
9. Display a menu
10. Information Assistant options
11. Client Access/400 tasks

90. Sign off

Selection or command
===> __________________________________________________________________________
_______________________________________________________________________________
F3=Exit F4=Prompt F9=Retrieve F12=Cancel F13=Information Assistant
F23=Set initial menu
Request to add application for licensed product 5733FXD option *BASE comp... +
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2. Type a 1 beside the Domino server where you installed Fax for Domino and
press Enter (Figure 27). The server is active when its status changes to
*STARTED. Press F5 periodically to refresh the status.

Figure 27. WRKDOMSVR

4.2.4 Updating the FaxAdmins group
During the Add Domino Application (ADDDOMAPP) step, a group called FaxAdmins is
created in the Domino Directory. Initially, it contains only the Domino server
administrator's ID. At this time, you should update the group to include any other
Notes users who will be responsible for configuring or managing Fax for Domino
(Figure 28).

Figure 28. FaxAdmins group

Work with Domino Servers
System: AS24

Type options, press Enter.
1=Start server 2=Change server 5=Display console 6=End server
7=Submit command 8=Work console 9=Work server jobs
11=Change current directory 12=Work object links 13=edit NOTES.INI

Domino Domino
Opt Server Subsystem Status
1_ AS24FAXDOM AS24FAXDOM *ENDED

Bottom
Parameters or command
===>
F3=Exit F4=Prompt F5=Refresh F9=Retrieve F11=Display path
F12=Cancel F17=Top F18=Bottom F22=Display entire field F24=More keys
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4.2.5 Finishing the installation of Fax for Domino on the AS/400 system
You have finished installing the Fax for Domino software on your AS/400 system.
In the next step, you install and set up the necessary software on the Windows
NT server or workstation that you selected to be the FxD Windows Services
System.

At this time, you should leave the Administrator workstation and go to the console
of the system that acts as the FxD Windows Services System. In a later step, you
will return to the Notes administrator workstation to finish setting up and
configuring the Fax for Domino for AS/400 server.

4.3 Setting up the FxD Windows Services System

The following sections guide you through steps that must be performed on the
FxD Windows Services System:

1. Register a Notes user for the FxD Windows Services System (if not done
already)

2. Install the Notes client software

3. Set up the Notes client

4. Install the FxD Windows Services software

5. Install applications of your choice to process attachments your users might fax

To install and set up the FxD Windows Services System, you must be a member
of the Windows NT Administrators group of your Windows NT server or
workstation. You must use this same identity to perform all of the steps.

If you are planning to use combined administration, and you set up multiple
Fax for Domino servers in your domain, you may have multiple FaxAdmins
groups defined after replicating the Domino Directory between your servers.
This occurs because the Add Domino Application (ADDDOMAPP) command
creates the FaxAdmins group in the Domino Directory of each server. There
are several ways to avoid this. After running the ADDDOMAPP command, you
can replicate the Domino Directory before running the ADDDOMAPP command
on another server.

As an alternative, you can manually update one of the FaxAdmins groups so
that it contains the appropriate Fax for Domino administrators for each of the
servers. Then, you delete the extra FaxAdmins groups and replicate the
Domino Directory after that.

Note

If you do not use the appropriate privileges when installing an application, you
may experience problems converting attachments for that application.

Note
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4.3.1 Registering a Notes user for the FxD Windows Services System
See 3.5, “Registering a Notes user for the FxD Windows Services System” on
page 31, if you have not done this before.

4.3.2 Installing the Notes client on the FxD Windows Services System
To install the Notes client on your FxD Windows Services System, follow these
steps:

1. Insert the Notes client CD (Release 4.6.6b or 5.0.2a or higher, according to
your Domino for AS/400 release) in the CD-ROM drive of the Windows NT
system you want to use as your FxD Windows Services System.

2. Install the “Standard” components of the Notes Client. You do not need to
install any of the Designer or Administrator components.

4.3.3 Configuring the Notes client on the FxD Windows Services System
You have registered the user ID you want to use on your FxD Windows Services
System in 3.5, “Registering a Notes user for the FxD Windows Services System”
on page 31. You can now configure the Notes client using this user ID as
described in the following steps:

Note: For R5 client instructions, refer to A.1, “Configuring the Notes client on the
FxD Windows Services System” on page 197.

1. Start the Lotus Notes client application.

2. When you are prompted for the Notes Workstation Setup screen, enter the
values as shown in Figure 29 and click OK.

Figure 29. Notes Workstation Setup

If you are using an Integrated Netfinity Server, insert the CD in the AS/400
CD-ROM drive.

Note

You should only install one version of the Notes client. This Notes client must
only be used for FxD Windows Services.

Note
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3. You see the Network Workstation Setup display. For the Your user name field,
enter the name of the user ID you created in 3.5, “Registering a Notes user for
the FxD Windows Services System” on page 31. For the Home server name
field, enter the name of the Domino for AS/400 server where you registered
the user ID. Click OK. Refer to our example in Figure 30.

Figure 30. Network Workstation Setup

4. Your client now connects to your Domino for AS/400 server and prompts you
to enter the password for the user ID you entered in the last step. Enter the
password and click OK (Figure 31).

Figure 31. Enter Password

5. Your client retrieves the user ID file from your Domino for AS/400 server and
stores it in the Notes data directory of your client. When the configuration
process has ended, you see the Notes client window as shown in Figure 32.

Figure 32. Workstation configuration completed

6. After the set up is completed, shut down the Notes client unless you want to
remove the password from the ID file, in which case, read the next section
first.
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4.3.3.1 Removing the password
This step is optional. If your ID file has a password, but the minimum length
specified for the password is 0, you may decide to remove it by completing the
following steps:

1. From the Notes client, select File->Tools->User ID and press Enter.
2. Enter the password of your user.
3. Click Clear Password.
4. You are prompted for the user password again.
5. Click OK.

The password is now removed.

4.3.4 Installing FxD Windows Services System software
We now describe the installation of the FxD Windows Services System software:

1. Insert the Fax for Domino for AS/400 CD in the CD-ROM drive of the Windows
NT system you want to use as your FxD Windows Services System. If your
system is configured to use the autorun function, the installation wizard
automatically starts the installation.

2. If your system is not configured for autorun, execute the setup.exe program in
the \WINNT subdirectory of your Fax for Domino for AS/400 CD.

3. Click the Install Fax for Domino (Windows Services) button, as shown in
Figure 33, and click Next.

Figure 33. Install Fax for Domino (Windows Services)

4. When the installation procedure ends, you see the display shown in Figure 34
on page 44. Click Finish to complete the setup.

If you are using an Integrated Netfinity Server, insert the CD in the AS/400
CD-ROM drive.

Note
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Figure 34. Installation complete

5. In Figure 35, you see that you have to restart the FxD Windows Services
System to activate the service. Select Yes, I want to restart my computer
now and click Finish.

Figure 35. Setup complete

6. When the restart completes, and you have logged on to the Windows NT
system, if the Notes ID file is password protected, you have to enter the
password for the user ID used to set up the Notes client in 4.3.2, “Installing the
Notes client on the FxD Windows Services System” on page 41. The
password prompt is shown in Figure 36. After you have entered the password,
click OK.

Figure 36. Enter Lotus Notes Password for Fax for Domino
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The dialog box is closed, and you can access the Windows NT desktop.

7. Two new Windows services are running on the FxD Windows Services
System. To verify that these services are started, complete the following
steps:

a. Click Start->Settings->Control Panel.
b. Select the Services icon. A window appears, as shown in Figure 37.

The Fax for Domino Conversion Service and the Fax for Domino Service
Monitor are started.

Figure 37. Services

4.3.5 Installing the required applications
You should install the applications that your users most commonly use for
document attachments so that the attachments can be converted to a TIFF file
format for faxing. See the specific application's instructions for installing the
software. See 7.2, “Sending a fax with attachments” on page 122, for more
information about installing non-standard applications.

Whenever you install an application on the FxD Windows Services System, make
sure that you are a member of the Windows NT Administrators group for the
system.

You only have to enter this password once. It will be encrypted and stored
on the FxD Windows Services System so that the FxD Windows Services
System can start up without user intervention. You are not prompted for the
password on subsequent system restarts unless you change the password
or switch to a different user ID prior to the restart.

Note

Before you enter the password, or when you are changing the password for
this user ID, you may receive a message from the Windows NT Services
Control Manager saying that not all services could be started. This is normal
because after the installation of the FxD Windows Services System, the
services are waiting for the password of the user ID and are, therefore, not
able to start up.

Note
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You have now finished setting up the FxD Windows Services System. Go back to
the Notes administrator workstation to finish setting up the Fax for Domino for
AS/400 Server.

4.4 Setting up the Fax for Domino for AS/400 server

Next you need to set up the Fax for Domino for AS/400 server. This process
includes a number of tasks, including modifying the Notes.ini file, creating an
Administration database if you are using separate administration, and modifying
mail templates. The following sections guide you through performing the process
at the Notes administrator workstation.

4.4.1 Modifying the agent restrictions on your server
First, you must modify the agent restrictions on the Domino for AS/400 server.

1. Open the Domino Directory (names.nsf) on your server.

2. In the left pane of the address book window, click Server and open the view
called Servers.

3. Select the Domino for AS/400 server where you added Fax for Domino and
click Edit Server.

4. Locate the Agent Manager tab and click it.

5. In the Run unrestricted LotusScript/Java agents field, click the drop-down list
and select the Domino for AS/400 server name that you use for Fax for
Domino. You see a display similar to the example in Figure 38.

Be aware that you have to buy the appropriate licenses for the applications you
install on your FxD Windows Services System.

Note

The change to the agent restrictions is necessary only for the Fax for Domino
setup because the setup task is running as a server side agent. You can
restore the original agent restriction settings after you finish setting up the Fax
for Domino for AS/400 server.

Note

If you are managing a Domino for AS/400 R5 server, click the Security tab.

Notes
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Figure 38. Agent Manager

6. Click Save and Close.

4.4.2 Running the Fax for Domino setup
To run the Fax for Domino setup, follow these steps:

1. Open the Fax for Domino setup database (setupfxd.nsf), which is located on
the Domino for AS/400 server where you have added Fax for Domino.

2. You are prompted with a display like the example in Figure 39 on page 48.
Enter the following information:

• Fax Foreign Domain: Specify a unique domain name for the fax server.
This name must be different from every other Domino domain, foreign
domain, or existing fax foreign domain defined in your Domino Directory or
Public Address Book. The default Fax Foreign Domain name is Fax.

• Administration: Select either Separate or Combined as the method you
will use to administer Fax for Domino. See 3.2, “Planning for separate
versus combined administration” on page 24, for more information.

Verify you have modified the Unrestricted LotusScript/Java agents field.

Notes

Do not replicate this database to your local workstation. The Fax for Domino
Setup database is designed to be used only on the Domino server.
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• Notes User for FxD Windows Services: Select the Notes user that you
created for the FxD Windows Services System in 3.5, “Registering a Notes
user for the FxD Windows Services System” on page 31.

• FxD Windows Services System: Specify the type of system where you
installed the FxD Windows Services software:

– Select Local Integrated Netfinity Server if you installed FxD Windows
Services on an Integrated Netfinity Server and the Integrated Netfinity
Server is located on the same AS/400 system where you installed Fax
for Domino.

– If you installed FxD Windows Conversion Services on any other
Windows NT server or workstation (including an Integrated Netfinity
Server located on a different AS/400 system), select Other Windows
System.

Figure 39. Fax for Domino Setup database

You see one of the following fields depending on whether you specified
Local Integrated Netfinity Server or Other Windows System:

– Network Server Description: If you installed FxD Windows Services
on an Integrated Netfinity Server located on the same AS/400 system
as Fax for Domino, specify the name of the Network Server Description
for the Integrated Netfinity Server.

– FxD Windows Services System TCP/IP Host Name: If you installed
FxD Windows Services on any other Windows NT server or workstation

To view the help text for a field in the Fax for Domino setup database,
click on the title to the left of the field.

Note
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(including an Integrated Netfinity Server located on a different AS/400
system), specify the TCP/IP host name of the FxD Windows Services
System.

3. Click Done and wait for the setup process to complete. You see a display
similar to the example in Figure 40.

Figure 40. Fax for Domino Setup complete

4.4.3 Restoring the agent restrictions on your server
Restore the agent restrictions on your Domino for AS/400 server. To restore the
original values in the Run unrestricted LotusScript/Java agents field, see 4.4.1,
“Modifying the agent restrictions on your server” on page 46, and reverse the
process described there. If when you did this step, the server was already set up
to Run unrestricted LotusScript/Java agents, do not change it back. Your
administrator must have a reason for having it set this way. If you did need to
change it for the FXD installation, now change it back. Don’t forget that if you
need to run the setup again, you have to modify the agent restrictions again.

4.4.4 Notes.ini entries
After the setup, if you look in your Notes.ini, you see something like the following
example:

Do not specify the IP address of your FxD Windows Services System.
During startup, Fax for Domino needs to resolve the IP address on its
own.
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$FAXAdminMods=/QSYS.LIB/QDOMFXD.LIB/NFXADMIN.SRVPGM
$FAXDeviceMods=/QSYS.LIB/QDOMFXD.LIB/NFXIBM.SRVPGM
$FAXCoverPages=nfxcover.nsf
$FAXLog=nfxlog.nsf
$FaxAdmin=nfxadmin.nsf
$FAXFMTCVTPORT=19700
$FaxShutdownRcvWait=0
$FAXFMTCVTHOST=FXDNTPC

The above example is for separate administration. The only difference for
combined administration is that the entry for $FaxAdmin is blank.

Do not try to change the port number entry for $FAXFMTCVTPORT unless
directed to do so by support.

If FaxRCVShutdownWait = 0 and you run tell fax quit while a fax is being
received, it will shut down as soon as it is done with the current page.

If FaxRCVShutdownWait = 1 and you run tell fax quitwhile a fax is being received,
it will wait until the entire fax has been received before shutting down.

4.5 Configuring Fax for Domino for AS/400

This section guides you through the process of configuring Fax for Domino for
AS/400 and the AS/400 fax hardware. You should perform these steps at your
Notes administrator workstation. Use the server administrator ID or any other
Notes user ID that you added to the FaxAdmins group. This process creates
objects, such as fax devices, and defines the Server administrator.

How you configure Fax for Domino after the installation depends on whether you
chose combined administration or separate administration. See 3.2, “Planning for
separate versus combined administration” on page 24.

1. Open the server database that you will use to administer your Fax for Domino
server.

• If you chose combined administration, open the Domino Directory
(names.nsf) database. In the left-hand pane, you see a new category of
views called Fax. Expand this category to display the new views.

• If you chose separate administration, open the Fax for Domino
administration database (nfxadmin.nsf).

2. Update the fax server information. See Figure 41 for the form when separate
administration is selected.

• If you chose combined administration, select the Fax/Servers view in the
Domino Directory and open the appropriate Server document. Expand the
Fax section of the document and make sure there are valid entries in all
mandatory fields. Although these fields are not indicated in the form, you
will not be able to Save and Close successfully if the necessary fields are
not complete.You must enter a name in the Server administrator field.

• If you chose separate administration, select the Fax Servers view in the
Fax for Domino administration database and open the default Fax Server
document. Make sure the document includes valid entries in all mandatory
fields. These are indicated by check marks on the form. You must enter a
name in the Server administrator field.
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Figure 41. Update fax server information using separate administration

3. Verify the fax person information.

• If you chose combined administration, select the People view in the
Domino Directory. Open the DefaultFxDUser Person document and make
sure the Fax section includes valid entries in all required fields (see Figure
42 on page 52). Make sure that the Deliver faxes to: is filled in. Otherwise,
faxes received will not be accessible. It is optional to complete the Send
fax notification to: field. See 7.4, “Routing” on page 131, for more
information on this. We recommend that you use the Fax Administrator’s
name for this field until you decide that there is a more suitable recipient.
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Figure 42. DefaultFxDUser using combined administration

• If you chose separate administration, select the User Profiles view in the
Fax for Domino Administration database. Then open the DefaultFxDUser
User Profile document and make sure it includes valid entries in all
required fields (see Figure 43). Make sure that the Deliver faxes to: is filled
in. Otherwise, faxes received will not be accessible. It is optional to
complete the Send fax notification to: field. See 7.4, “Routing” on page 131,
for more information. We recommend that you use the Fax Administrator’s
name for this field until you decide that there is a more suitable recipient.
52 Lotus Fax for Domino for AS/400: Getting the Straight Facts



Figure 43. DefaultFxDUser using separate administration

4. Create a fax device document for each fax line or modem you are using by
clicking on the Fax Devices view in the left-hand pane. Complete the following
steps for each fax line or modem:

a. In the menu bar, select Create. Then, select your fax device from the
pull-down menu (IBM Analog or IBM PCI Analog). For more information
about which device to select, refer to 3.4.5, “Determining which fax
hardware is installed on the AS/400 system” on page 29.

b. Enter the device and general settings information for your fax device using
the form shown in Figure 44 on page 54.

The remaining steps do not distinguish between combined or separate
administration. These steps are the same, regardless of which
administration type you are using.

Note
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Figure 44. Device configuration

c. The necessary information for each type of device is described here:

• Fax server name: The name of the Domino for AS/400 server that will
manage the fax device.

• Fax hardware resource name: The AS/400 resource name that
identifies the fax port.

• Unique name for fax device: A unique name to describe the fax port.
This name must be one to eight characters. You can make this name
whatever you want. The line, controller, and device descriptions are
automatically created for you and are named whatever you enter in this
field. A sample display of the results of typing WRKCFGSTS *LIN is shown
in Figure 48 on page 59.

d. If desired, enter information in the General and Advanced settings fields.

5. When you are finished configuring the fax hardware, click Save and Close.

For more information on each field within these sections, click the blue
field labels.

Note
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6. Set up the default Class of Service document (DefaultFxDCOS) to meet the
needs of most people in your organization (see Figure 45). You can create
additional Class of Service documents if needed. These documents define the
characteristics of faxes and how faxes are sent.

Figure 45. Default Class of Service document

7. Create user profile settings for individual users as needed.

See 5.2, “User profiles” on page 64, for more information on this topic.

8. Create Telephone Number Translation documents as needed.

See 7.5, “Telephone number translation” on page 137, for more information on
this topic.

4.6 Setting up Fax for Domino users

To use all available functions of Fax for Domino, you need to modify the
environment of your Notes users.

4.6.1 Updating user Personal Address Books with fax domain information
You must provide your fax users with the necessary instructions to perform the
following steps:

If you are using the 2761 8-port adapter, make sure that you have followed
the planning instructions in 3.7, “Before installing Fax for Domino for
AS/400” on page 33, to use the Change Network Attributes (CHGNETA)
command to specify the Modem country ID (MDMCNTRYID) value
corresponding to your country ID. If you don’t, the modem port initialization
will fail.
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1. Update the design of their Personal Address Books so that the fax domain
field appears in their Location documents.

• If your users do not keep a copy of pernames.ntf on their client workstation,
they should refresh the design of their Personal Address Book (names.nsf)
using the updated template on the server. Use File->Database->Refresh
Design to do this.

• If your users keep a copy of pernames.ntf on their client workstation, you
may want to mail them a copy of the updated pernames.ntf file from the
Domino for AS/400 server along with instructions for detaching it to the
Notes data directory of their client workstation. This replaces the user’s
pernames.ntf file. They now have the $LotusFaxLocationSubform from the
Design/Subforms view in their own copy of pernames.ntf. Once the
template is updated, users must refresh the design of their Personal
Address Book (names.nsf). Now, the Fax domain field appears in the
Location documents in their Personal Address Books.

2. Enter the name of the fax domain in the Fax domain field in their Location
documents (Figure 46). You defined this name in 4.4.2, “Running the Fax for
Domino setup” on page 47.

Figure 46. Fax domain in location document

Another way to add the fax domain to your users’ Location documents is to send
them a note with a button that executes the following simple LotusScript agent:

Sub Click(Source As Button)
‘This function updates the location documents in the local address book
with your fax domain information'

Dim session As New NotesSession
Dim personDB As New NotesDatabase("","names.nsf")
Dim faxdomain As String
faxdomain = "fax" 'specify your fax domain'
Dim view As NotesView
Set view = personDB.getView("Locations")
Dim locationDoc As NotesDocument
Set locationDoc = view.getFirstDocument
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While Not locationDoc Is Nothing
locationDoc.FaxDomain = faxdomain
Call locationDoc.save(True,True)
Set locationDoc= view.getNextDocument(locationDoc)

Wend
Messagebox("Your domain information for the "+faxdomain+" fax domain has
been updated in your location documents.")

End Sub

We are providing this code as part of the Web downloadable additional material.
See G.3, “Other resources” on page 243, for more information on how to obtain
the required files.

4.6.2 Updating a user’s mail template with fax options
To include the Fax to: field and Fax Options button into a user’s Notes Memo
form, you have to perform the following steps:

1. Copy the $LotusFaxMemoSubform and the $LotusFaxOptionsSubform, which
the Add Domino Application (ADDDOMAPP) command placed in the mail template
on the fax server (mail45.ntf, mail46.ntf, mailc46.ntf, and mail50ex.ntf) to the
mail templates on all your mail servers.

You need this step only if your mail templates are not automatically replicated
among all of your Domino mail servers.

2. Refresh the design of each user’s mail databases on your Domino mail
servers.

If a user's mail database inherits its design from the updated mail template on a
server, the new features will be made available to that user automatically when
the server's design task runs. This usually occurs at 1:00 a.m. You can also
refresh the design manually using the LOAD DESIGN command from the Domino
console.

Using this method, you can be sure that all location documents of your fax
users are changed correctly.

Note

The Fax to: field is only seen when using mail templates mail45.ntf, mail46.ntf,
mailc46.ntf, and mail50ex.ntf. In the future, it may be included in mail50.ntf.
Mail50ex.ntf was released with Domino R5.0.3.
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Table 2 summarizes what needs to be done to modify the environment depending
on your situation.

Table 2. Additional administration steps

4.6.3 Making the Fax for Domino help information available to users
Make the Fax for Domino Help database (nfxuhelp.nsf) available to your users by
copying it to the Domino data directory on your mail servers or by sending it to
users and having them copy it to their Notes data directories. Once this is done,
they can access FxD Help from within the Notes application.

4.7 Starting Fax for Domino for AS/400

During the setup of Fax for Domino, described in 4.4.2, “Running the Fax for
Domino setup” on page 47, the fax task was added to the end of the ServerTasks
environment variable in the Notes.ini file. The Fax for Domino server is, therefore,
automatically started when you start your Domino for AS/400 server using the
Start Domino Server (STRDOMSVR) command.

To start the Fax for Domino server manually, use the Work Domino Console
(WRKDOMCSL) command to submit the LOAD FAX command (Figure 47).

Environment Setup Additional Admin Steps

A One Domino server
used for mail and Fax
for Domino.

Setup updates your mail
templates and the
pernames.ntf file on your
FxD server with
additional subforms for
your whole environment.

If your users have a copy of
pernames.ntf on their client, you
have to send them the updated
copy to replace the client version.

Send a mail memo with a button
agent to update the fax domain in
the Location documents, or tell
them to do it manually.

Run the DESIGN process on
Domino mail server to update your
users’ mail files with the changed
templates.

B One Domino mail
server used for Fax
for Domino.
Additional mail
servers are in the
environment.

Setup updates your mail
templates and the
pernames.ntf file with the
additional subforms only
on the Domino mail
server to which it was
added.

Replicate your mail templates and
pernames.ntf to your other mail
servers. Then, follow the
additional admin steps in A.

Replicate the help database if your
users will use it from a server copy.

C Fax for Domino is
installed on a server
without mail users.

Setup updates your mail
templates and the
pernames.ntf file with the
additional subforms only
on the Domino server to
which it was added.

Follow additional admin steps in B
and then A.
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Figure 47. Load Fax

After you have started Fax for Domino, you can also see that your fax devices are
active. To verify this, use the Work with Configuration Status (WRKCFGSTS)
command (Figure 48).

Figure 48. Status of fax devices

In the Domino subsystem, you can find new tasks after successfully starting Fax
for Domino. You see the FAX job and one or more QFAXDD (Fax device) jobs.
Using the Work with Active Jobs (WRKACTJOB) command, you see a display like the
example in Figure 49 on page 60.

Work with Domino Console
Server: AS24FAXDOM

Previous subcommands and messages:
03/10/2000 06:11:11 PM Database Server started

> LOAD FAX

> LOAD FAX

03/10/2000 06:12:15 PM Fax (Release 4.1) initialization begun.
03/10/2000 06:12:15 PM Fax: Logging subsystem has been started.
03/10/2000 06:12:15 PM Fax: Fax class of service configuration records read
successfully.
03/10/2000 06:12:15 PM Fax: Fax server configuration record read
successfully.

Enter a Domino subcommand.
===> __________________________________________________________________________
_______________________________________________________________________________
F3=Exit F5=Refresh F6=Print F9=Retrieve
F17=Top F18=Bottom F21=Command line

Work with Configuration Status AS24
03/10/00 10:20:25

Position to . . . . . Starting characters

Type options, press Enter.
1=Vary on 2=Vary off 5=Work with job 8=Work with description
9=Display mode status 13=Work with APPN status...

Opt Description Status -------------Job--------------
FXPORT01 ACTIVE
FXPORT01 ACTIVE
FXPORT01 ACTIVE QFAXDD QNOTES 009206

FXPORT02 ACTIVE
FXPORT02 ACTIVE
FXPORT02 ACTIVE QFAXDD QNOTES 009209

FXPORT03 ACTIVE
FXPORT03 ACTIVE
FXPORT03 ACTIVE QFAXDD QNOTES 009211

More...
Parameters or command
===>
F3=Exit F4=Prompt F12=Cancel F23=More options F24=More keys
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Figure 49. Fax jobs in Domino subsystem

4.8 Stopping Fax for Domino for AS/400

If you want to end your Fax for Domino server manually, use the Work Domino
Console (WRKDOMCSL) command to enter the TELL FAX QUIT command (Figure
50).

Figure 50. Tell fax quit

The Fax for Domino server will be automatically stopped when you shut down
your Domino for AS/400 server by using the End Domino Server (ENDDOMSVR)
command.

Work with Active Jobs AS24
03/10/00 10:31:38

CPU %: 1.4 Elapsed time: 00:00:01 Active jobs: 177

Type options, press Enter.
2=Change 3=Hold 4=End 5=Work with 6=Release 7=Display message
8=Work with spooled files 13=Disconnect ...

Opt Subsystem/Job User Type CPU % Function Status
__ AS24FAXDOM QSYS SBS .0 DEQW
__ ADMINP QNOTES BCI .0 SELW
__ AMGR QNOTES BCI .0 SELW
__ AMGR QNOTES BCI .0 CNDW
__ DECS QNOTES BCI .0 SELW
__ EVENT QNOTES BCI .1 SELW
__ FAX QNOTES BCI .0 SELW
__ QFAXDD QNOTES BCI .0 ICFW
__ QFAXDD QNOTES BCI .0 ICFW

More...
Parameters or command
===> _________________________________________________________________________
F3=Exit F5=Refresh F7=Find F10=Restart statistics
F11=Display elapsed data F12=Cancel F23=More options F24=More keys

Work with Domino Console
Server: AS24FAXDOM

Previous subcommands and messages:

> TELL FAX QUIT

> TELL FAX QUIT

03/10/2000 06:19:26 PM Exiting Fax addin task.

03/10/2000 06:19:51 PM Fax addin task has exited.
Enter a Domino subcommand.
===>

F3=Exit F5=Refresh F6=Print F9=Retrieve
F17=Top F18=Bottom F21=Command line
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For details about managing a Domino for AS/400 server, see Lotus Domino for
AS/400 - Installation, Customization, Administration, SG24-5181 (for Domino
Release 4.6.x), or Lotus Domino for AS/400 R5: Implementation, SG24-5592
(for Domino R5).

Note

If you stop and restart the Fax for Domino Conversion Service on the FxD
Windows Services System, you have to restart Fax for Domino to re-establish
the communication between the two systems. If you reboot the FxD Windows
Services System, you must also restart Fax for Domino.

For more details on starting and stopping services, see 5.7, “Starting and
stopping services” on page 72.

Important
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Chapter 5. Administration

For general monitoring of ongoing activity in FxD, the two databases to use are
the Spool Mailbox (nfxspool.nsf) and the FxD Log database (nfxlog.nsf). We
recommend that if you are the adminstrator, you add these databases to your
workspace.

This chapter covers some specific topics of interest to the system administrator:

• Administering from a Web browser

• User profiles

• Housekeeping

• Removing fax requests

• Backup and recovery

• Priorities

• Starting and stopping services

• Enabling and disabling ports

• Miscellaneous tips

• Domino for AS/400 QMUs and QMRs

• Changing type of Administration (combined to separate or separate to
combined)

• Maintaining the FxD Windows Services System

5.1 Administering from a Web browser

Whether you are using combined or separate database administration, you can
perform the following FxD administrative tasks through a Web browser:

• Edit server settings, user profile settings, class of service settings, and
telephone number translation rules

• View the Fax for Domino Log

• View the Fax for Domino Spool Mailbox

You can’t set up Fax for Domino using the Web browser client. If you try to, you’ll
get the message shown in Figure 51 on page 64.
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Figure 51. Setup from a Web browser

To access a database from a Web browser, follow these steps:

1. Configure the fax server for HTTP access. Refer to Domino for AS/400
documentation for instructions.

2. In your Web browser, type the name of the fax server and HTTP port used in
the Location bar and press Enter. The page shown in Figure 52 appears.

3. Choose the database you want to work with and open it.

Figure 52. Address Book from Web browser

5.2 User profiles

Every user may have their individual fax settings defined. If you are using
combined administration, this is kept in the Person document in the Domino
Directory. If you are using separate administration, it is in a User Profile
document in the FxD administration database. If you are using separate
64 Lotus Fax for Domino for AS/400: Getting the Straight Facts



administration, you do not have to create a user profile for a user to be able to
use Fax for Domino. Default settings from a default user profile can be used
instead.

User profile (or Person) settings define how FxD handles each individual user's
outgoing and incoming faxes. The user profile settings consist of the class of
service, cost code, cover page settings, and settings for receiving incoming
faxes.

When you install FxD with combined administration, a Person document, called
DefaultFxDUser, is created in the Public Address Book (Figure 53). When you
install FxD with separate database administration, the user profile for
DefaultFxDUser is created in the Fax for Domino Administration database. A new
user is not registered in your Domino server, because the DefaultFxDUser
doesn’t have a mail file or an ID file.

DefaultFxDUser supplies default user profile settings to the server when no
individual user profile settings have been created for a user. You can edit the
document to change these default values. Remember that you must set the value
for Deliver faxes to: to ensure that inbound faxes will be delivered to someone.
They cannot be delivered to DefaultFxDUser, since this user does not have a mail
file.

Figure 53. Default user

The display in Figure 53 is from a combined administration implementation.
The same information in a separate administration implementation is presented
in a different form but includes the same fields.

Note
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For any user who needs values other than those in DefaultFxDUser, you can
specify the same fields shown in Figure 53 but in individual Person or User Profile
documents. The values for Default FxDUser will be used when individual users
don’t override the values, either by having values in their individual Person
documents or user profiles or by setting fax options by using the Fax Options
button.

Users listed in the Owners field of the Person document or the User Profile
document may edit all their user profile settings except the class of service, cost
code, routing method, routing number, and whom FxD notifies when an inbound
fax was routed to the user.

The user name in an individual User Profile document should match a person
name in the Public Address Book. One exception to this rule is a user profile used
to route incoming faxes from a remote CSID number, since you may use a
company name for this. You cannot use a group name for a User Profile
document.

Specify the DefaultFxDUser settings so that it meets the needs of most of the
people in your organization. You can edit the user profile settings in the users'
Person documents if their requirements are different from the majority of users.
For example, you can assign a particular user a class of service that will send
faxes at a higher priority than is allowed to other people in your organization.

The user profile settings consist of the class of service, cost code, cover page
settings, and settings for receiving incoming faxes:

• Class of service: In the user profile, you can define the name of the class of
service to be used by this user. Classes of service are separate documents
that define the characteristics of faxes being sent, such as resolution, whether
a cover page should be sent, and so on.

While writing this redbook, we found that local POP3, AS/400, and remote
SMTP users can use the FxD server to send faxes. These users will use the
settings for DefaultFxDUser settings because, by default, there is no user
profile for this user. You will see an error in the FxD log indicating a minor error,
such as: Admin reported error when getting user profile document for

JMIDDLE?AS26@as26.itsoroch.ibm.com.

When using separate administration, you can use this log information to
identify what user profile FxD is looking for and provide that information in a
User Profile document. For example, if the POP3 user's address is
mjones@acompany.com, you create a user profile document called
mjones@acompany.com. If the POP3 user's address is Mary Jones
<mjones@acompany.com>, you create a user profile document called Mary
Jones <mjones@acompany.com>.

We could not determine how to provide the same information for combined
administration. Be aware that the support of SMTP by FxD is not an official use
of the product. More information about SMTP faxing is in 9.7, “Broadening the
reach” on page 160.
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• Cost code: For information on the use of cost codes, see 7.6, “Cost codes” on
page 139.

• Cover page settings: The following items are included:

– Name of the sender as it should appear on the cover page.

– Name of the cover page form used for faxes sent by this user.

For information on how to tailor this form, see 7.1, “Fax cover page” on
page 115.

– Any cover page message.

– Company name and address.

– Sender's e-mail addresses.

• Receive settings: How the user receives faxes are defined by the following
criteria:

– Phone number format for routing faxes to the user.

– Mail address to which FxD sends incoming faxes.

– Mail address to which FxD sends notification when incoming faxes are
routed to the user.

– File format in which FxD presents incoming faxes.

Information about inbound fax routing is found in 7.4, “Routing” on page 131.

There can only be one default user for each fax server.

5.3 Housekeeping

The faxing process first detaches any attachments to temporary files in the
integrated file system (IFS) on the AS/400 system. Then, the fax requests are
sent to the FxD Windows Services System. Once on the FxD Windows Services
System, the attachments are detached to temporary files. The cover sheet, fax
body, and attachments are now all converted to TIFF format and sent back to the
AS/400 system for the actual faxing.

When this process works correctly, all temporary files disappear after the fax has
been sent. Occasionally, in error situations, some or all temporary files may
remain in the FxD Windows Services System and AS/400 IFS temporary
directory. They may have to be deleted manually.

In addition, FxD continually updates the Fax for Domino Log database
(nfxlog.nsf) and creates new records as it processes a fax request. Fax for
Domino can record all errors and events that occur or record only major errors
and events depending on the logging configuration you select in the fax server
configuration document. All entries remain in the Log database until you remove
them. In addition, it is possible to log FxD entries in the Notes Log database of
your Domino for AS/400 server. The size of the Fax for Domino Log and the
Notes Log database grow as FxD operates.

To free up hard disk space on the AS/400 system, you should periodically delete
old entries from the databases you configured for Fax for Domino logging.
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5.3.1 AS/400
Fax for Domino for AS/400 uses the following AS/400 IFS directories for
temporary files:

• /QIBM/UserData/LOTUS/FAX/TMP
• /QIBM/UserData/LOTUS/FAX/TMP/servername

Here, servername is replaced by your FxD server name.

The /QIBM/UserData/LOTUS/FAX/TMP directory is used for all FxD servers
running on the same AS/400 system. Therefore, you should not delete any files
other than those associated with the fax job you are going to delete.

You may see files in the /QIBM/UserData/LOTUS/FAX/TMP directory with names,
such as nxxxxxxx.TIF and zxxxxxxx.fls. These are temporary files used by Fax for
Domino and normally should not be deleted.

You may also see files in this directory with names that start with NFX, and files in
/QIBM/UserData/Lotus/FAX/TMP/servername with names similar to
FCxxxxxx.TIF and FIxxxxxx.TIF. FC files are cover pages, and FI files are the fax
body. This group of files are associated with fax conversions and in the normal
course of events, should be automatically deleted when the fax is sent or when
the request fails.

In 5.4, “Removing fax requests” on page 70, we explain how to remove a fax
request from the Spool Mailbox database. This involves deleting the specific files
that you know are associated with a particular fax being sent. If you have
removed a request and not performed the correct associated cleanup, these files
will remain in the directory. If you don’t know what fax these files are associated
with, you should only delete them if FxD is stopped on all Domino servers using
this FxD Windows Services System and if there are no outstanding requests in
the Spool Mailbox database.

5.3.2 Windows NT
The following directories are used by the FxD Windows Services System. They
are under the Notes directory where you installed the Notes Client (C:\notes\data\
is the default for R4.6):

• C:\notes\data\Nfxtemp\servername\
• C:\notes\data\work

Here, servername is replaced by your FxD server name.

The temporary files located on the FxD Windows Services System will eventually
be deleted by the system when the Fax for Domino Conversion Service is
restarted. Since this may not occur very often, you can choose to manually delete
the temporary files located on the FxD Windows Services System as well. See

Before you delete any files from the AS/400 IFS, you should stop FxD from
running on the AS/400 system. For details about stopping FxD, see 5.7.1.2,
“Stopping” on page 73.
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5.4, “Removing fax requests” on page 70, for information on doing this when
removing a fax being processed.

If you receive an error message about “unknown popup window”, an image of the
“unknown popup window” is stored in C:\notes\data\work. Therefore, you should
check this directory too.

5.3.3 Log database (nfxlog.nsf)
With Domino databases, you can select two ways to clean them up:

• Select documents and delete them manually

The benefit is that you can keep error records but delete request records if you
prefer.

• Set the Replica option to delete old documents by date

The benefit is that you can delete them automatically.

After you delete documents from Domino databases, you should compact the
database because the database is still using disk space where you deleted the
records. If you use an R4.6x server, you have to stop the Fax for Domino server
before compacting the database.

The log consists of two views: Requests and Errors.

5.3.3.1 Deleting log documents manually
You may have to update the database Access Control List (ACL) first to allow
documents to be deleted:

• To delete a request from the Log, follow this process:

1. Open the Fax for Domino Log database.
2. Choose View->Requests->(name of view).
3. Select the fax record or records you want to delete.
4. Choose Edit->Clear or press Delete.
5. Choose View-> Refresh or press F9 to update the view.

• To delete an error from the Log, complete these steps:

1. Open the Fax for Domino Log database.
2. Choose View-> Errors->(name of view).
3. Select the error you want to delete.
4. Choose Edit->Clear or press Delete.
5. Choose View->Refresh or press F9 to update the view.

5.3.3.2 Deleting log documents automatically
Perform the following to delete log documents automatically:

1. Select the Fax for Domino Log database.

2. If you use an R5 Notes client, right-click and select Replication->Settings....
If you use an R4.6 Notes client, right-click and select Replication and then
Settings....

3. Select Remove documents not modified in the last: and specify xx days
(Figure 54 on page 70).

4. Click OK.
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Figure 54. Replication Settings

5.4 Removing fax requests

If a user has submitted a fax request and has decided that it should not have
been sent, the user has to ask the administrator to remove it. It is not a good idea
for the administrator to just delete the request from the Spool Mailbox because
there are a number of temporary files that need to be deleted as well.

You may need to update the ACL of the database to allow deletion of documents.

To delete a fax request, perform these steps:

1. Shutdown FxD.

2. Open the Fax for Domino Spool Mailbox (nfxspool.nsf) database.

3. In the Fax Jobs view, open the fax job document of the fax job you want to
delete.

4. Write down the names of the temporary files associated with the fax job or
print the screen.

Some of the temporary files are located on the FxD Windows Services System
and have names similar to
c:\notes\data\NFXTEMP\server_name\NFXxxxxx.txt.

Other temporary files are located on the AS/400 system and have names
similar to:

• /QIBM/USERDATA/LOTUS/FAX/TMP/NFXxxxxx.txt
• /QIBM/USERDATA/LOTUS/FAX/TMP/server_name/FIxxxxxx.TIF
• /QIBM/USERDATA/LOTUS/FAX/TMP/server_name/FCxxxxxx.TIF

Some of the temporary file names are separated with a semi-colon (;).
Sometimes there is no separator between the names.

5. In the Fax Jobs view of the Fax for Domino Spool Mailbox database, select the
job you want to delete.

6. Choose Edit->Clear or press Delete.

7. Choose View->Refresh or press F9 to update the view.
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8. Check the AS/400 system for the temporary files associated with the fax job
and delete them if they exist.

9. Restart FxD.

The temporary files located on the AS/400 system are never deleted by the
system when you manually delete a fax job. Therefore, you must delete them
manually. The temporary files located on the FxD Windows Services System will
eventually be deleted by the system when the Fax for Domino Conversion
Service is restarted. Since this may not occur often, you can choose to manually
delete the temporary files located on the FxD Windows Services System as well.

5.5 Backup and recovery

You don’t need to do a full backup of the FxD Windows Services System because
there are mostly only temporary files involved. The configuration information on
the AS/400 will be saved together with your regular Domino server backup.

There are two databases that FxD Windows Services System uses on the
Windows NT local hard drive: the Convert Server Config (nfxconv.nsf) and
Convert Server Log (nfxcnvlg.nsf). You should back up the Convert Server Config
database when you change it. You may choose to do this by replicating it to the
AS/400 Domino server. You should also consider saving a copy of the ID file for
the Notes user on the FxD Windows Services System.

You can back up the Fax for Domino for AS/400 code by using the Save Licensed
Program (SAVLICPGM) command to save the Program 5733-FXD. It will also be
saved as part of any total system save that you do.

Remember that your Domino server must be up and Fax for Domino active for
faxes to be sent or received. This means that if your AS/400 system is put into a
restricted state every night for your system backups, you will not be able to send
or receive faxes during that time. For other ways to do AS/400 backups, see
OS/400 Backup and Recovery, SC41-5304.

For information about alternatives for backing up Domino for AS/400 servers, see
Lotus Domino for AS/400 R5: Implementation, SG24-5592 (Domino R5). For
information about the new online backups for Domino for AS/400, see the Web
site at: http://www.as400.ibm.com/service/brms/domino.htm

5.6 Priorities

Fax prioritization enables both you and users to determine how quickly a fax is
routed through FxD. You define the user's default fax priority and whether the
user can change that default priority as part of the class of service you designate
in the User Profile document assigned to the user. When users send a fax, they
can specify its priority in the Notes Memo Fax Options if you have granted them
permission to change their default fax priority.

The following priorities are available in FxD:

• IMMEDIATE: This priority can only be assigned in a Class of Service
document by you, the administrator. Users cannot assign this priority to a fax
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with the Fax Options on the Notes Memo. Faxes at Immediate priority go to
the front of all fax queues and are routed as soon as a fax port is available.

• HIGH

• MEDIUM: This is the default priority when no other priority is specified.

• LOW

Faxes are routed in first in, first out order within each of these priority queues. If a
fax is waiting in any queue for more than four hours, FxD bumps the fax up one
priority level in order to move it out of the queue and then logs a minor event. The
four-hour aging value cannot be modified.

Once a fax has been submitted, the priority cannot be changed by a user.

If the user schedules a transmission date and time for the fax, the fax does not
enter the queue at its assigned priority until the scheduled time.

5.7 Starting and stopping services

As you know, there are two major components in your FxD implementation:

• FxD server on the Domino for AS/400 server
• FxD Windows Services System

Both need to be active for faxes to be sent and received. There are times when
you need to stop one or the other, and in this section, we describe when that
might be and how you should do it to minimize disruption.

Starting FxD was briefly described in 4.7, “Starting Fax for Domino for AS/400” on
page 58, and stopping in 4.8, “Stopping Fax for Domino for AS/400” on page 60.
Here, we go into more detail on the circumstances that might require the
restarting of Fax for Domino Windows Services and Fax for Domino.

5.7.1 FxD server on the Domino for AS/400 server
To start and stop Fax for Domino, complete the procedures in the following
sections.

5.7.1.1 Starting
When you install and configure FxD for AS/400, the server notes.ini file is
updated so that FxD will start automatically whenever you start the Domino
server. If you need to start FxD manually, complete the following steps:

1. Start a Domino console session by entering the following from any AS/400
command line:

WRKDOMCSL ACME1

Here, ACME1 is the name of your Domino server.

When the console session is active, enter the following command:

load fax

2. Close the console session.
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5.7.1.2 Stopping
When it is necessary to stop FxD, you can stop the Fax server by following these
steps:

1. Start a Domino console session by entering the following command from any
AS/400 command line:

WRKDOMCSL ACME1

Here, ACME1 is the name of your Domino server.

2. When the console session is active, enter the following command:

tell fax quit

3. Close the console session.

Whether you stop FxD by using tell fax quit or whether the Domino server is
ended, the effect on faxes in progress is the same:

• Outbound faxes will complete the transmission of the current page. If that is
not the complete fax, the recipient's fax machine should indicate incomplete
transmission. When FxD starts up again, the entire fax will be transmitted,
including pages already sent.

• For inbound faxes, the action will depend on the FaxRCVShutdownWait entry
in Notes.ini. If it is 0, and if a fax is being received when FxD is shut down, it
will shut down as soon as it is done with the current page. If it is 1, it will wait
until the entire fax has been received before shutting down.

5.7.2 FxD Windows Services
To start and stop FxD Windows Services, perform the procedures in the following
sections.

5.7.2.1 Starting
When the FxD Windows Services System is booted up, the FxD Windows
Services will start automatically as shown in Figure 55. If you have manually
stopped them for problem determination or administration reasons, you can start
the services by following these steps:

1. Open the Windows Control Panel (Start->Settings->Control Panel).
2. Double-click the Services icon.
3. Select Fax for Domino Conversion Service.
4. Click Start.

Figure 55. Services on FxD Windows Services System
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5.7.2.2 Stopping
Ideally, you should stop Fax for Domino on the Domino server before stopping
FxD Windows Services. You are going to have to restart Fax for Domino to
re-establish the communication between the two systems anyway.

To stop the Fax for Domino Windows Services, follow these steps:

1. Open the Windows Control Panel (Start->Settings->Control Panel).
2. Double-click the Services icon.
3. Select Fax for Domino Conversion Service.
4. Click Stop.

5.7.3 Why you may need to restart services
The following lists some situations where you need to consider whether to restart
one or both of these services:

• The AS/400 with FxD installed is IPLed or taken down to a restricted state and
brought back up. This could happen as part of a complete system save.

In this situation, your Domino for AS/400 server will also be restarted. Your
notes.ini file will probably have the task Fax included in the ServerTasks line
so that FxD will start automatically when the server starts. You will not have to
do anything special.

You do not have to touch the FxD Windows Services System.

• The Domino server with FxD is stopped and restarted.

This will be the same as the previous situation.

• Something is changed in your fax device configuration. For example, you
changed the fax banner (header) or turned DTMF on or off.

You need to stop and restart Fax for Domino for AS/400.

• You edit the Convert Server Config database on the FxD Windows Services
System to tailor an application.

You need to restart the FxD Windows Services. Therefore, you also need to
first stop and restart FxD on each Domino for AS/400 server (the Fax server
not the complete Domino server) that uses this FxD Windows Services
System. The correct order to perform this is as follows:

1. Stop FxD for AS/400 on each Domino fax server that uses this Fax for
Domino Conversion Service.

2. Stop the Fax for Domino Conversion Service.

3. Start Fax for Domino Conversion Service.

4. Start FxD for AS/400 for each Domino fax server that you had previously
ended.

• You need to apply a fix to the FxD Windows Services software. To do this,
follow these steps:

You should stop the FxD server on the Domino server before stopping FxD
Windows Services to prevent new requests from starting.
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1. Stop FxD for AS/400 on each Domino fax server that uses this Fax for
Domino Conversion Service.

2. Stop the Fax for Domino Conversion Service.

3. Apply the fix.

4. Start Fax for Domino Conversion Service.

5. Start FxD for AS/400 for each Domino fax server that you had previously
ended.

• Fax settings are changed in a Person document (for combined administration)
or the Administration database (for separate administration).

You don’t need to do anything. FxD automatically checks for, and
incorporates, changes to fax server settings, user profile settings, Telephone
Number Translation documents, and Class of Service documents every 15
minutes. You can stop and restart FxD if you want the changes to take effect
immediately.

• The FxD Windows Services System is rebooted or powered down and then
powered on.

This may occur for many reasons. If this is a planned occurrence, you should
end all FxD for AS/400 servers that use this FxD Windows Services System,
as well as the Fax for Domino Conversion Service, before the reboot or power
down.

After the FxD Windows Services System has been rebooted or powered on,
and the Fax for Domino Conversion Service has been restarted, you need to
restart all FxD for AS/400 servers that use this FxD Windows Services System
for fax conversions.

• You want to log Fax for Domino Conversion Service debug information.

1. Stop FxD for AS/400 on each Domino fax server that uses this Fax for
Domino Conversion Service.

2. Stop the Fax for Domino Conversion Service.

3. Start Fax for Domino Conversion Service with the -debug option specified in
the Startup Parameters: field.

4. Start FxD for AS/400 on each Domino fax server that you had previously
ended.

The debug information is located in C:\QFXrouter.log.

To turn debug logging off, follow these steps:

1. Stop FxD for AS/400 on each Domino fax server that uses this Fax for
Domino Conversion Service.

2. Stop the Fax for Domino Conversion Service.

3. Start Fax for Domino Conversion Service without specifying the -debug

option in the Startup Parameters: field.

4. Start FxD for AS/400 on each Domino fax server that you had previously
ended.

• The Fax for Domino Conversion Service encountered an error that caused it to
end prematurely.
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The Fax for Domino Conversion Service is automatically restarted. However,
any FxD for AS/400 that uses this service for fax conversions must be
restarted.

5.8 Enabling and disabling ports

You may define all 8-ports on your 2761, but then decide that you don’t have the
telephone lines to support them. You can either remove the configuration for that
port by deleting the entry, or you can disable it by editing the fax device settings
to disable Transmit and Receive.

As you see in Figure 56, you can define ports to be enabled or disabled for
sending and receiving separately.

You have to restart Fax for Domino on your AS/400 system to change any setting
you make in fax device settings. This includes deleting them.

Figure 56. Fax device settings for PCI Analog

After you first create fax device settings and start Fax for Domino on your
AS/400, Fax for Domino creates line descriptions, controller descriptions, and
device descriptions automatically. However, Fax for Domino does not delete them
automatically if you delete the fax device settings. The line description remains in
Connect Pending status.
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5.9 Miscellaneous tips

This section covers some miscellaneous tips for FxD.

5.9.1 Time
When FxD logs the completed transactions, it records the time that the
transaction was received in the Fax for Domino Spool database. Since the mail
database resides on a Notes server, FxD records the time on that server's clock.
If the clock on the server and the clock on the FxD workstation are not
synchronized, then an inaccurate duration of processing time will be calculated.
For example, the processing time field will be blank when the “Received by FxD
at” field has a later time than the “Transmission Start Time”.

5.9.2 Drafts of stationery
If you are using stationery to send e-mail with an R4.6 client, do not use the Fax
To: field to send a fax. Use the To: field to address your Fax recipients and Send
and File button to send your fax. If you use the Fax to: field or To: field and Send
button, your stationery may be deleted when you send a fax.

5.9.3 Delayed sending
If you have users in different time zones, they can perform delayed sending using
their own time zone information. However, if the reason for delayed sending is to
take advantage of lower priced long-distance rates, they will have to make mental
adjustments to any delayed sending they want to do. You may want to provide
some guidance as to the appropriate times to use.

Suppose the client is set to Pacific Time, and the server is on Central Time (two
hours ahead of Pacific Time). If cheaper long distance rates start at 6 p.m. CST,
then you should enter 4 p.m. as the delayed time when sending from the Pacific
Time client.

If you are authorized to look at the Fax Entry Information in the Spool Mailbox
from the Pacific Time client, the scheduled time for the fax to be sent will display
as 4 p.m. A colleague with authority in Chicago looking at the same information
will see it as 6 p.m.

5.10 Considerations when installing Domino for AS/400 QMUs and QMRs

When installing a new Domino for AS/400 QMU or QMR, please read the release
notes. It is possible that these QMUs or QMRs replace your existing Notes
templates with new templates.

Why is this important for Fax for Domino? Fax for Domino adds additional
subforms to the pernames.ntf, pubnames.ntf, and to the mail template files. When
they are replaced, and the design process refreshes the databases based on
these templates, the additional subforms are removed from the databases.

This means, for example, that the Fax to: field and the Fax options button are no
longer visible in a Notes memo. Also, if you are using combined administration,
you will not see your Fax configuration view.
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To update your new templates with the Fax for Domino subforms, open the Fax
for Domino Setup database and run setup with the values that are displayed.
After that, use the LOAD DESIGN command on the Domino console to add the
subforms back to your databases.

5.11 Changing the type of administration

In the following sections, we describe how you can change your administration
type after having configured Fax for Domino. In either case (combined to
separate, or separate to combined), there is a great deal of manual re-entry of
data required. For that reason, we urge you to plan your original decision
carefully.

5.11.1 Moving from combined to separate administration
To change from combined administration (using the Domino Directory) to
separate administration (using the database nfxadmin.nsf), perform the following
steps:

1. End FxD.

2. Make a copy of names.nsf so that you have access to the data in it later, if
necessary. If you use the Notes client to make the copy, you can do it while the
server is active.

3. Remove the following subforms, views, and forms related to FxD from
names.nsf (these steps require Designer Client):

• Remove the following views:

– Fax\Classes of Service
– Fax\Devices
– Fax\Inbound Routing Profiles
– Fax\Telephone Number Translations

• Remove the following forms:

– Class of Service
– IBM Analog
– IBM PCI Analog
– Telephone Number Translation

• Remove the following subforms:

– $LotusFaxBanner
– $LotusFaxCommonDeviceInfoAS400
– $LotusFaxDTMFRouting400
– $LotusFaxLocationSubform
– $LotusFaxRetryInfoAS400

When you upgrade to a new Notes client version, the pernames.ntf file (the
base for the local names.nsf file) can also be replaced. Be aware that you have
to send a pernames.ntf file that includes the Fax for Domino subforms to your
users after upgrading so that your users can refresh the design of their local
names.nsf file without losing the $LotusFaxLocation subform.
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– $LotusFaxSingleHWSettingsAS400
– $OptionalMessage400

• Change the following subforms:

– $LotusFaxPersonSubform
– $LotusFaxServerSubform

To change subforms, follow these steps:

a. Open the subform.
b. Select the twistie and delete it.
c. Save and close it.

These subforms, views, and forms are not deleted as part of rerunning FxD
setup.

4. Rerun FxD setup selecting separate administration. This updates notes.ini to
change the entry $FaxAdmin=nfxadmin.nsf and creates the necessary
Administration database. It also re-adds the subforms to your mail templates,
pubnames.ntf, and pernames.ntf.

5. Manually re-enter the fax user profile information, redefine the fax devices,
classes of service, and so on, unless you can write a program to copy
information from the original names.nsf.

6. Start FxD.

5.11.2 Moving from separate to combined administration
To change from to separate administration using the database nfxadmin.nsf to
combined administration using the Domino Directory, perform the following steps:

1. End FxD.

2. Rerun FxD setup selecting combined administration. This modifies the
$FaxAdmin= entry in notes.ini.

3. Make sure you enter the Fax Administrator name in the server configuration.

4. Manually re-enter the data and redefine the Fax devices unless you can write
a program to copy information from the original NFXADMIN.NSF.

5. Start FxD.

5.12 Maintaining the FxD Windows Services System

Once the FxD Windows Services software is installed and active on the Windows
NT server or workstation, you may need to perform maintenance on the Windows
NT server or workstation.

Before upgrading or reinstalling the Notes client, stop the FxD Windows Services.

If you reinstall the Notes client and choose to install it in a different directory, you
must un-install and then reinstall FxD Windows Services.

Before applying any fixes to the FxD Windows Services software, stop the FxD
Windows Services. If fixes are made available, information will be posted at the
FxD for AS/400 Web site: http://www.as400.ibm.com/domino/related/fxd/index.htm

Potentially, a fix to the FxD Windows Services software could require a
companion fix to the FxD software running on the Domino server. If the version
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level of the FxD Windows Services software becomes incompatible with Fax for
Domino for AS/400, a message is logged to the Fax for Domino Log database
(nfxlog.nsf).

Remember, after you start the FxD Windows Services after successfully applying
a fix, you need to restart any FxD for AS/400 servers that use this service for fax
conversions.
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Chapter 6. Using Fax for Domino: A user’s perspective

As described in Chapter 1, “Introduction to Fax for Domino 4.1 for AS/400” on
page 1, Fax for Domino for AS/400 from Lotus enables Notes users to send and
receive faxes directly from their Notes client or to send faxes directly from within
any Microsoft Windows application. When reading this chapter, put yourself in the
chair of an end-user, wanting to know how to use FxD. We discuss the use of a
Lotus Notes client, a Web mail browser, and a browser POP3 client. The following
topics are covered:

• Sending faxes
• Sending attachments
• Using the Lotus Print to Fax driver (Lotus Notes client only)
• Receiving faxes
• Printing faxes

Table 3 quickly summarizes the major fax-related functions available to a Lotus
Notes user, a Web mail user, and a POP3 user. Additional information regarding
each type of user and the various functions available are discussed throughout
this chapter.

Table 3. Comparison of key functions for different users

6.1 Using FxD with the Lotus Notes client

Users can easily send a fax from their Lotus Notes client. It is merely a matter of
the user entering the appropriate address when completing either a Fax to: field
or entering an address comprised of the fax number and domain when
completing the To:, cc:, or bcc: fields. The Fax to: field is available if you are
using mail45.ntf, mail46.ntf, mailc46.ntf, or mail50ex.ntf mail templates.

If the Fax to: field is not available to users, the To:, cc:, or bcc: fields can be used
as long as the address format used is name@faxnumber@faxdomain. The
address format of name@faxdomain may also be used if the recipient’s fax
number is listed in the Domino Directory or in your Personal Address Book. This
also applies both when you send a Notes (fax) memo from the Web interface and
when you are using an R5 mail template prior to mail50ex.ntf. This template was
released with Domino R5.0.3.

Function Lotus Notes client Web mail user POP3 user

Send fax yes yes yes

Receive fax yes yes yes

Print fax yes yes yes

Fax to: field available yes 1 no no

Fax options button yes no no

Lotus Print to Fax available yes no no

1. Fax to: field is available if you are using mail45.ntf, mail46.ntf, mailc46.ntf, or
mail50ex.ntf templates.
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There are several steps that a user must do before sending a fax using FxD.

1. Set up the “Fax domain” in your Location document. Normally, your Domino
administrator notifies you on how this is done in your environment. This could
involve adding a subform to your Personal Address Book template
(pernames.ntf) or refreshing the design of your Personal Address Book using
the updated template on the server. As a result, a Fax tab with a Fax domain
field is added to your Location document. Each user must ensure that the Fax
domain field contains their site’s appropriate fax domain name. In our
example, the Fax domain name is “Fax” as shown in Figure 57. Additional
details for the Domino Administrator on how to automate this process for users
are included in 4.6.1, “Updating user Personal Address Books with fax domain
information” on page 55.

Figure 57. Fax tab in Location document of R5 Lotus Notes client

2. Ensure that the office and home fax phone numbers are present on all fax
recipients’ entries in your Personal Address Book or in their Person
documents in the Domino Directory (Public Address Book). Otherwise, you
have to include their fax phone number when you send the fax memo. To add
an entry in your Personal Address Book, click the New Contact icon on the
desktop as shown in Figure 58.

The Lotus Notes client version 5.0.2b International, with the mail50ex.ntf Mail
template, was used for this chapter.

Note
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Figure 58. New contact icon on desktop

Enter Jane Doe’s contact information, including her fax number, as depicted in
Figure 59. Click the tabs along the top to complete any other desired fields
such as a business or home address. Click Save and Close when finished.

Figure 59. Personal address book entry for Jane Doe

Figure 60 on page 84 shows Pete’s personal address book entry for Jane Doe,
the remote office manager at ABC.
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Figure 60. Personal Address Book (R5) entry

3. If your Lotus Notes client mail preference is not set to automatically save a
copy of any memo you send, you may have to take action to save a copy of
your fax memo before sending it.

For example, you may be using a 4.6 template and your mail preference is set
to “Don’t keep a copy”. If you use the Fax to: field and press the Esc key (and
select send only) or click on the Send button, you receive the error message
No names found to send mail. However, you may be using the mail50ex.ntf mail
template and are using the Fax to: field. If you press the Send button, the fax
is sent. The only time a mail50ex.ntf template user receives the No names found

to send mail message is if the user presses the Esc key and chooses send
only.

There are several ways of ensuring that your fax memo is saved prior to
sending it. The first way is to edit your Lotus Notes user preferences so that
mail is always saved or that you are prompted each time you send mail. In
your Lotus Notes (R5) client, select File->Preferences>User Preferences.
Click the Mail and News icon and a window, as shown in Figure 61, appears.
Select Always keep a copy or Always prompt. A second way is to save an
individual memo by pressing the Esc key when finished, choosing send and
save a copy and then clicking on the OK button. You can also select Send
and File (to the Trash folder) if you don’t want to keep it.

In our examples, the format of the fax number is five digits due to our lab
environment. A more likely number for an external fax machine would
contain more digits, such as 9-1-507-123-5555 or 9-01144-898-123456.

Note
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Figure 61. Setting default ‘Save sent mail’ preference (Lotus Notes R5)

If your mail preferences indicate “Don’t keep a copy of sent mail”, you can save
each message individually when you send it by selecting the Send and File
button or by pressing the Esc key and then selecting Send and save a copy as
shown in Figure 62.

Figure 62. Saving an individual fax memo

6.1.1 Sending a fax using Lotus Notes
Note that the word Fax in the following examples (Table 4) refers to the name of
the fax domain defined by our administrator. You should substitute this with the
name provided to you.

Table 4. Fax addressing options

Address field Sample value Information

Fax to:
(if available)
Fax domain retrieved
from Location
document.

Jane Doe Office fax number retrieved from
Personal then Public Address Book
else prompted.
Home number will not be used.

Jane Doe@12345 Fax sent to 12345.

Jane Doe@home Home fax number used from
Personal then Public Address Book
else prompted.

To: or cc: or bcc:
Home fax option is
not available

Jane Doe@Fax Number retrieved from Personal
then Public Address Book .

Jane Doe@12345@Fax Fax sent to 12345.
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To send a fax using your Lotus Notes client, open the Notes memo form by
selecting the New Memo button. If the Fax to: field is available, enter the name of
the person or persons who should receive this memo as a fax. Remember, if a
person’s associated fax number has already been defined, as described in 6.1,
“Using FxD with the Lotus Notes client” on page 81, a shorter address format,
such as Jane Doe in the Fax to: field, or Jane Doe@Fax in the To:, cc:, or bcc:
fields can be used. Otherwise, you are prompted to enter the phone number if
using the Fax to: field, or you have to enter the actual phone number, such as
Jane Doe@5-7068@Fax, if using the To:, cc:, or bcc: fields to send a fax. Since
we are using a Lotus Notes 5.0.2b client with a mail50ex.ntf mail template, the
Fax to: field is available as illustrated in Figure 63. Also shown in the cc: field in
Figure 63, is the name of a Domino user (Jill Jones) who will receive this fax as
an e-mail in her mailbox. In addition, an attachment has been included as shown
in Figure 63.

Figure 63. Sending a fax (with an attachment)

If you are using a Lotus Notes R5 mail template prior to mail50ex.ntf, the Fax
to: field is not available, and the address for the fax recipient is entered in the
To:, cc:, or bcc: fields. If you are using an mail45.ntf, mail46.ntf, mailc46.ntf, or
mail50ex.ntf mail template, the Fax to: field is available regardless of the level
of the Domino server.

If a fax recipient’s home fax number is listed in your Personal Address book or
in their Person document in the Domino Directory, the Fax to: address format is
name@home. For example, if Jane’s home fax number were specified in our
address book, or in her Person document, then we could send a fax to her
home by entering Jane Doe@home in the Fax to: field.

FxD substitutes the home number for the characters home.

Note
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In Figure 63, there is also a Fax button above the addressing area. Click the Fax
button, and several choices are presented: Help and Options. If you were using a
4.6 client, there would be a Fax Help button and a Fax Options button instead.

Click on Help, and a window containing user related FxD information, like the one
shown in Figure 64, appears.

Figure 64. Fax user help information

Although you can use the default fax options as set by your administrator, you
can also change Fax options for this fax by clicking the Fax button that you can
see in Figure 63. Then, click on Options, and a window, as shown in Figure 65
on page 88, displays. If no entries are changed in the Fax Options window, FxD
looks for the following settings in your personal fax settings first (refer to “User
settings” on page 88) and then in the default Fax for Domino settings:

• Send a cover page
• Sender’s name
• Include all names

When creating a new Lotus Notes memo that will be sent to a fax recipient, you
may want to enlarge the font of the text being sent since the font sizes are
slightly reduced when the fax is rendered.

If the new memo you are creating contains sections (twisties), prior to sending
the fax, you must expand those sections or change the section properties to
indicate “Auto expand when opened for reading”. If neither of these steps is
taken, the sections remain collapsed on the sent fax.

Note

If you see a Security Execution Alert pop-up window regarding Lotus Fax
Development when clicking the Fax Help option, click the Trust Signer button.

Note
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• Cover page form
• Cover page message
• Company name
• Address line 1
• Address line 2
• Sender's e-mail address

The sender’s fax and phone numbers are obtained directly from the sender’s
Person document in the Domino Directory. The sender’s name will be obtained
from the From field of the Notes Memo if it is not found first in the Fax Options
window, your fax settings, or the default fax settings (set by the FxD system
administrator).

In our example, we are not making any changes to the Fax Options, so click the
Cancel button. Any changes made in the Fax Options window apply for that fax
transmission only. Changes entered here are not saved.

Figure 65. Fax options

Although we’ve automatically set the sent mail to be saved (as discussed in step
3 on page 84), we want to save this fax to a special folder called janedoe, so click
on the Send and File button. A pop-up window, as shown in Figure 66, appears.
Also, note that the Jane Doe entered in the Fax to: field has been translated for

Depending on whether the administrator chose combined or separate
administration for the Fax for Domino server, your fax settings are either stored
in your Person document in the Domino Directory or in your user profile in the
Fax for Domino Administration database respectively. Remember that you may
not have your own user profile, as you could be using the default settings.
Users listed in the Owner’s field in a Person document or user profile may edit
their fax settings except for the class of service, cost code, routing method,
routing number, and whom FxD notifies when an inbound fax has been routed
to the user. Also, your site’s Domino Administrator may have taken measures
to prevent users from directly accessing their Person document.

There may not be any fax settings set up for you personally. You may be using
the default FxD options. Contact your administrator if you need to have
personalized fax settings, and you cannot access the information yourself.

User settings
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you into a full address and moved to the To: field. After selecting the desired
folder, click Add to send the fax e-mail. Figure 66 shows a grayed-out Move
button because the New Memo button was used from the Sent mail folder.

Figure 66. Send and File fax into designated folder

A notification message, like the example in Figure 67, is delivered to the sender’s
(Pete Smith) mail box after FxD handles the fax.

Figure 67. Notification message

The content of the notification message sent to Pete is shown in Figure 68 on
page 90.
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Figure 68. Content of notification message

6.1.2 Sending a fax directly from a PC application
In addition to being able to send a fax directly from Lotus Notes, the Lotus Print to
Fax driver enables Notes client users to send a fax directly from Windows-based
applications that support printing, including Lotus 123, Lotus Word Pro, and
Microsoft Word. The Print to Fax driver works by creating a fax image of your
document and then displaying a dialog prompting you for the destination and
other fax transmission options before the fax is sent.

Faxes may also be sent to a group. If you are using the Fax to: field, the group
may exist in either your Personal Address Book or in the Domino Directory
(Public Address Book). Members of groups defined in your Personal Address
book may be individuals or other groups from either your Personal Address
Book or the Domino Directory.

Members of groups defined in the Domino Directory must be individuals or
groups from the Domino Directory. If you are using the To:, cc: or bcc: fields,
then the group must exist in the Domino Directory. Group members must be
individuals or groups from the Domino Directory only. Also, individual members
of the group must be defined as name@faxnumber@faxdomain or
name@domain.

Note

The Lotus Notes client must be installed on your PC in order to use the Lotus
Print to Fax driver.

Note
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If the Lotus Print to Fax driver is not already installed on your workstation, details
on how to install it are included in B.1, “Installing the Lotus Print to Fax driver” on
page 207.

6.1.2.1 Using the Lotus Print to Fax driver
After installing this driver on the Lotus Notes client PC, faxes can be sent through
FxD by simply selecting the Print to Fax driver from the application’s File->Print
menu. Print to Fax is fully integrated with Lotus Notes. When prompted for the fax
destination address, your Notes Address Book and the Domino Directory can be
searched. In addition, as with e-mail messages, there is an option to save the
transmitted fax as a Sent message in Lotus Notes as shown later in Figure 76 on
page 95. The Print to Fax driver also enables you to schedule the transmission of
the fax, select a cover page, and convert the document into faxable format.

Follow these steps:

1. Open a Windows-based application, such as Lotus Word Pro, and create a
document. Click File->Print. In the printer selection window, as shown in
Figure 69, choose Lotus Print to Fax.

Figure 69. Selecting Print to Fax

2. Click on the Print button. A window is displayed, as shown in Figure 70 on
page 92.
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Figure 70. Print to Fax options window

3. Click the Address Book to select an address from the Domino Directory
(Public Address Book) as shown or from your Personal Address Book.

4. If prompted, as shown in Figure 71, enter your Lotus Notes password.

Figure 71. Print to Fax: Enter user ID and password

5. After selecting Jane Doe, as shown in Figure 72, click the Add button.

Figure 72. Selecting a fax recipient from Domino Directory (Public Address Book)
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6. In the resulting display shown in Figure 73, select the Office Fax option since
we are sending a fax to Jane’s fax machine. In fact, she does not even have a
Domino mail box. The e-mail address appears since her address in the
Domino Directory had to include an e-mail address as mentioned in the note
box “No destination address message”. Click OK, and Jane Doe appears in
the Destination Addresses area.

Figure 73. Select Destination for Recipient

7. In this example, select Jill Jones and click Add. Since Jill’s Person document
in the Domino Directory does not contain any fax phone numbers, you were
not prompted to select a destination. She will receive this fax in her mail box.

8. Click Cancel to close the Address Book window.

If you receive the pop-up window indicating No destination address found

for recipient, ensure that the person being selected from the Public
Address Book (Domino Directory) has a completed Email Address field.

No destination address message
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9. Enter a subject and cover page message as shown in Figure 75.

Figure 75. Print to Fax options: Address and subject

10.Click the Transmissions Options tab. A window appears that is similar to the
example in Figure 76. Make any desired changes. In our case, select Save
Cover Page options, and leave the rest at their default settings. Selecting
Save Cover Pages results in the changes being used as the default options
the next time you use Print to Fax.

Alternatively, simple addressing may be used by pressing the Simple
Address button shown in Figure 70. In the pop-up window, shown in Figure
74, the sender then enters the fax recipient’s address instead of looking in
an address book. When using simple addressing, the recipient name and
fax number and fax domain are required fields. This enables a fax to be
sent to someone who is not listed in the Domino Directory or Personal
Address Book. The fax domain will already be entered if you set it in your
Location document.

Figure 74. Print to Fax driver: Using simple addressing

Note
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Figure 76. Print to Fax: Transmission options

11.Click the Cover Page tab, and make the changes as shown in Figure 77. If the
sender fields of Name, Company, Address, or Email address are not entered
here, the sender’s Person document (or user profile if using separate
administration) provides the fax settings. Otherwise, the FxD default settings
are used.

Figure 77. Print to Fax: Cover page options

12.Click the Send Fax button.

6.1.3 Receiving a fax
As a Domino user with a Lotus Notes client, incoming faxes are viewed from
within your Domino mailbox. For your information, the actual method by which the
inbound fax e-mail arrives in your mailbox varies depending on the inbound
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routing method set by the Fax for Domino administrator. Additional details on the
various inbound routing methods are discussed in 7.4, “Routing” on page 131.

As shown in Figure 78, Pete has a new fax e-mail in his mail box. Double-click it
to open this e-mail. For your information, since we are using manual routing in
this example, this fax was routed to Pete by the “administrator” designated to
handle the routing of inbound faxes.

Figure 78. Receiving a fax

To view the fax, double-click the attached TIFF (fax) file as shown in Figure 79.
Then, click on the View button in the Attachment pop up window to start the File
Viewer.

Another way to view the attached fax (TIFF) file is to right-click it and then
select View from the pop-up window. For your information, we could have
selected Launch instead of View and viewed the fax image using the Imaging
for Windows 95 application installed on our PC as described in 6.1.4, “Printing
a fax” on page 98. Windows NT has an imaging application available also.

Note
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Figure 79. Viewing fax e-mail in mail box

In the File Viewer window, shown in Figure 80, close the Attachment pop-up
window.

Figure 80. Viewing a received fax

To zoom in on the fax image, click Viewer->Magnify->Fit to Width as shown in
Figure 81 on page 98. Alternatively, you could select another magnify setting,
such as 50 percent.
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Figure 81. Magnify option

The fax image is resized to fit the width of your window as shown in Figure 82.
The entire fax can be seen by using the scroll bar on the right side of the window.

Figure 82. Reading a received fax

6.1.4 Printing a fax
As discussed in 6.1.3, “Receiving a fax” on page 95, a received fax can be
viewed online using the Lotus Notes File Viewer. However, there may be times
when you want to print a received fax. As shown earlier in Figure 79 on page 97,
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double-click the attached TIFF file in your fax e-mail. Click the Launch button in
the Attachment pop-up window. Click File->Print as shown in Figure 83.

In our example, the application launched is Imaging for Windows 95 because it is
the application associated with TIFF files in Windows 95, and we have a Windows
95 PC. Imaging for Windows NT is shipped with Microsoft Windows NT.

It is possible that you have a different application associated with TIFF files on
your PC. In that case, a different application may be launched. For your
information, the Imaging for Windows 95 accessory can be used to create,
annotate, view, and print TIFF and other images. It can be downloaded from the
Web site: http://www.microsoft.com/downloads/search.asp

Imaging for Windows NT is shipped with Microsoft Windows NT.

Figure 83. Printing a fax

A Print options window, like the one in Figure 84 on page 100, appears. Select
the desired printer and any other required options, such as the number of copies.

Applications associated with specific file types can be checked in Windows 95
or NT by double-clicking the My Computer icon and then clicking
View->Options. Then, select the File Types tab.

Note

Printing files from the Lotus Notes File Viewer may give unexpected results. If
possible, print files from their native applications. For example, in our case, we
used an image viewing application.

Note
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Click the OK button to send the fax image to your printer. Assuming that the
selected printer is operational, the fax image will be printed on it.

Figure 84. Print options window

6.2 Using FxD from a Web mail client

Lotus Domino can be accessed using a Web browser; this is often referred to as
using a “Web mail template”. In Domino 4.6, the mail template for such a user can
be a combined mail template or a Web only template. In Domino R5, the Mail 5.0
template handles both Lotus Notes clients and Web mail clients.

Figure 85. Registering a Web mail Domino user

When registering a Web mail user with the Domino server, the Internet
password field must be checked as shown in Figure 85.

Note
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6.2.1 Sending a fax using a Web mail client
As a Web mail client, open your browser and enter the appropriate Uniform
Resource Locator (URL) for your mailbox on the Domino for AS/400 server. In our
example, we use Netscape 4.7, and enter the URL:
http://as26faxdom:4444/mail/mbrowser.nsf

When prompted, as shown in Figure 86, enter the Domino user name (mbrowser
in our example) and password.

Figure 86. Web mail sign on

To send a fax using your Web mail client, open the Notes memo form by selecting
the New Memo button shown in Figure 87 on page 102.

In the above URL, as26faxdom should be replaced by the name or IP address
of your Domino for AS/400 server, and mbrowser.nsf should be replaced by
your mail box file name. Although you will most likely not need to issue a port
number, we had to specify the port number 4444 because our Domino
administrator had changed the Domino Web server port from the default of 80
to 4444. For convenience, set a bookmark for this URL.

Note
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Figure 87. Web mail Inbox

Note that the word Fax in the following examples refers to the name of the fax
domain defined by our administrator. You should substitute the name provided to
you.

In Figure 88, we send Jane Doe a fax with a Lotus Word Pro attachment. The To:,
cc:, or bcc: fields must be used since the Fax to: is not available when using Web
mail. Enter Jane Doe@Fax in the To: field since Jane is the fax recipient. Remember,
we can use the shorter address since Jane Doe’s associated fax number is in the
Domino Directory (refer to 6.1, “Using FxD with the Lotus Notes client” on page
81). Otherwise, you have to enter the fax phone number when sending the fax
e-mail in the format: name@faxphonenumber@faxdomain.

In this example, we could have used the full address, Jane Doe@5-7068@Fax,
but we chose to use the shorter version since Jane’s fax number is in the Domino
Directory.

If you click on the Address button, which appears in Figure 88, and select your
site’s Domino Directory, only users with a Mail system specified in their Person
document will appear. You may also notice that not all names are displayed
and that the Previous and Next buttons do not seem to work. You are only
shown a portion of the Directory at any one time.

To display more entries in the Domino Directory, do a search on the first letter
of a last name in the required alphabetic part of the directory. This restriction
may be lifted in a future release of the template.

Note
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Figure 88. Sending a fax e-mail

Click the Send button, which is at the top of the page shown in Figure 88, and
then click Send and Save to send the fax. After the fax has been transmitted, a
notification message is sent to your inbox.

6.2.2 Sending a fax directly
Since the Lotus Print to Fax driver requires a Lotus Notes client, this function is
not available when using Web mail through a browser.

6.2.3 Receiving a fax
As a Domino Web mail user, incoming faxes are viewed from within your Domino
mailbox. For your information, the actual method by which the inbound fax e-mail
arrives in your mailbox varies depending on the inbound routing method set by
the Fax for Domino administrator. Additional details on the various inbound
routing methods are discussed in 7.4, “Routing” on page 131.

As shown in Figure 89 on page 104, Marie has a new fax e-mail in her mail box.
Double click on it to open this e-mail. For your information, since we are using
manual routing in this example, this fax was routed to Marie by the “administrator”
designated to handle the routing of inbound faxes.

When using Web mail to send a fax, up to two attachments may be specified.

Note
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Figure 89. Receiving a fax

To view the fax, click once on the attached TIFF (fax) file as shown in Figure 90.

Figure 90. Viewing fax e-mail in mail box

As shown in Figure 91, click the OK button in the pop-up window to open the
TIFF file with the Imaging for Windows 95 application installed on our PC. See
6.2.4, “Printing a fax” on page 106, for more details on this application. If you are
using Windows NT, use Imaging for Windows NT.
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Figure 91. Opening the fax image file

The fax that Jane sent from her fax machine to Marie through Fax for Domino is
displayed in Figure 92.

Figure 92. Web mail: Viewing a received fax

To zoom in on the fax image, click Zoom->Fit to Width as shown in Figure 93 on
page 106. Alternatively, you can select another zoom option, such as Custom,
and enter a desired magnification.
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Figure 93. Zoom option

The fax image is resized to fit the width of the window as shown in Figure 94. The
rest of the fax can be seen by using the scroll bar on the right side of the window.

Figure 94. Reading a received fax

6.2.4 Printing a fax
As discussed in 6.2.3, “Receiving a fax”, a received fax can be viewed online by a
Web mail user through the use of an image viewing application, such as Imaging
for Windows 95. The process for printing a received fax is simple and is
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described in this section. As shown earlier in Figure 90 on page 104, click once
on the attached TIFF file in your fax e-mail. Click the OK button in the pop-up
window to open the TIFF file. A window like the one in Figure 95 appears. See
6.1.4, “Printing a fax” on page 98, for more details on the Imaging for Windows 95
or NT application.

Figure 95. Viewing a fax

Click on File->Print as shown in Figure 96. You can also click on the printer icon
in the action bar at the top of the window.

Figure 96. Printing a fax
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When a print window appears, like the example shown in Figure 97, choose the
desired printer and any other options and then click OK.

Figure 97. Print options window

Assuming that the selected printer is operational, the fax sent from Jane will be
printed out.

6.3 Using FxD from a browser e-mail client

In addition to the Web mail client discussed in the above section, a POP3 or
IMAP client can use Domino for AS/400 as a mail server. This section discusses
how a POP3 browser based client can use Fax for Domino. However, other
functions, such as using the Domino mail interface, calendar and discussion
databases, are not available to the browser POP3 or IMAP user.

As a user, your browser may have been set up for you so that it can be used as a
POP3 or IMAP client to Domino. However, if this is not the case, additional details
on how to set up a POP3 client in Netscape can be found in B.3, “Setting up
Netscape Messenger as a POP3 client” on page 211.

6.3.1 Sending a fax using a browser e-mail client
As a browser POP3 client, Martin Popp opens Netscape and then selects
Communicator->Messenger as illustrated in Figure 98.

• When using a POP3 client (or any SMTP client), there is no Fax Options
button as there is when using a Lotus Notes client. See 5.2, “User profiles”
on page 64, for how to tailor the settings for a POP3 client. If you are using
combined administration, you are limited to using the default fax
(DefaultFxDUser) profile settings.

• We are assuming that the Domino Administrator has already registered our
POP3 client user, Martin Popp, with the Domino for AS/400 server. Details
on registering a POP3 user is discussed in B.2, “Registering a POP3 client
with Domino” on page 210. We are using Netscape Communicator 4.7 in
this section.

Notes
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Figure 98. Starting Netscape Messenger (POP3 client)

In the window in Figure 99, Martin’s POP3 mail inbox is displayed.

Figure 99. Netscape Messenger POP3 inbox

Click the New Msg button at the top of the window. The contents of the fax Martin
is sending to Jane Doe is typed in the lower frame as shown in Figure 100 on
page 110.
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In our example, Jane Doe’s fax number is stroed in our Address book as her
e-mail address.

Figure 100. POP3 client: Sending a fax

Since we want to attach a file, click the Attach button, click File, and select the
desired file. As shown in Figure 101, the name of our attached file, desk.jpg,
appears next to the attachments icon (the paper clip) in the top part of the display.

In our environment, native Domino SMTP is being used. Therefore, as a POP3
user, the addressing format, name%faxnumber%faxdomain@maildomain,
must be used to send a fax. This fax mail will arrive at the SMTP server of the
domain which processes it, transforms the address, and delivers the message
through the fax domain indicated to the FxD spool mail box. If AS/400 AnyMail
(Mail Server Framework) is being used instead of the native Domino SMTP, a
POP3 user can use the addressing format
name.faxnumber.faxdomain@maildomain. See 9.7, “Broadening the reach” on
page 160.

Note
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Figure 101. POP3: Sending a fax with an attachment

Click the Send button. The fax is handled by FxD after it has been routed through
the Domino SMTP server. After FxD has processed the request, Martin Popp (our
POP3 user) receives a notification message in his Messenger inbox indicating
that his fax has been transmitted.

6.3.2 Sending a fax directly
Since the Lotus Print to Fax driver requires a Lotus Notes client, this function is
not available when using a browser based e-mail client.

6.3.3 Receiving a fax
A POP3 client can receive faxes coming into FxD for AS/400. In our example,
Jane Doe has faxed in a document for Martin Popp. Since we are using manual
inbound routing, the person designated as the “handler of inbound faxes” has
forwarded the fax to Martin. As a result, start Netscape Communicator and click
Communicator->Messenger at the top of your Netscape window, click the Get
Msg button, and then enter a password if prompted as shown in Figure 102.

Figure 102. Entering password for POP3 user

Click once on the fax mail item. It appears in the lower frame as shown in Figure
103 on page 112.
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Figure 103. POP3 client: Receiving a fax

Scroll down until the TIFF file is visible. Then, click on it as shown in Figure 104.

Figure 104. Viewing the fax

As illustrated in Figure 105, click the OK button to open the TIFF file.
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Figure 105. Security message: Viewing a TIFF file

As described in 6.1.4, “Printing a fax” on page 98, the TIFF file is opened using
the Imaging for Windows 95 application since that is what is set to handle TIFF
files on our PC. Figure 106 displays the fax sent from Jane’s fax machine to
Martin using Fax for Domino.

Figure 106. Viewing a received fax TIF file

6.3.4 Printing a fax
Printing received faxes from within our POP3 browser client is a natural extension
to viewing the fax as discussed in section 6.3.3, “Receiving a fax” on page 111. To
print our received fax, follow the steps described in 6.3.3 to open the fax in a
viewer. In our example, the viewer we are using is Imaging for Windows 95.
Additional details on this application is in 6.1.4, “Printing a fax” on page 98. As
shown in Figure 107 on page 114, click File->Print in the action bar.
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Figure 107. POP3 client: Printing a received fax

A print window, like the one in Figure 108, appears. Select the desired printer and
any other options, such as number of copies. Then, click the OK button.

Figure 108. Print window

Assuming the designated printer is operational, the received fax will be printed on
it.

The release notes for FxD 4.1 list some limitations under a section entitled
“Known Problems and limitations”. These include differences in font sizes and
rendering issues with radio buttons and twisties. These limitations are
associated with the FxD product and are not specific to the AS/400
implementation.

Note
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Chapter 7. Customization

Once you install and configure FxD, it can be used to send and receive faxes.
However, you may want to consider customizing some of the features to provide
enhanced and company-specific support in your organization.

This chapter discusses the following topics:

• How to customize cover pages
• Providing support for faxing attachments from PC applications
• Fax headers
• Routing of inbound faxes
• Telephone number translation
• Cost codes

It is also possible to automate sending faxes from within Lotus applications using
LotusScript. You can see an example of this in the FxD for Domino
Administrator’s Guide (nfxa400.nsf).

7.1 Fax cover page

When you send a fax, FxD checks whether a cover page should go out with the
fax and, if so, what the cover page settings are for the fax. To determine the name
of the cover page, FxD looks first at the fax options specified for the individual
fax. If no cover page is entered there, it checks the user information, and if no
cover page is listed there, it uses the server default user’s cover page.

As shown in Figure 109, after installing FxD server, there are three fax cover
pages in the database (nfxcover.nsf). As with any Domino application, you can
create new cover pages (new forms) in this database. You must have the Notes
Designer (R4.6) or Domino Designer (R5) client installed to change or create
cover pages.

Figure 109. Cover Pages view of Fax for Domino Cover Pages

7.1.1 Using cover pages
After your users’ environments have been changed, as described in 4.6, “Setting
up Fax for Domino users” on page 55, Notes R4 client users will see two new
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buttons (Fax Options and Fax Help) when you create a Notes Memo as shown in
Figure 110. If you are using an R5 client, there is a single Fax button with two
pull-down list choices: Fax Options and Fax Help.

Figure 110. New Memo

By clicking the Fax Options button, you can specify the cover page for an
individual fax as well as other fax options as shown in Figure 111. If the Cover
Page form field is left blank, or if the cover page entered does not exist, FxD
checks the user’s settings for a cover page, and if none is found there, the server’s
DefaultFxDUser cover page setting is used. The default cover page setting for the
DefaultFxDUser is DefaultFaxCoverPage, which has an alias of DCP. If you are using
Combined Administration, the cover page can be set in the Fax section of the Person
document in the Domino Directory (Public Address Book). If you are using Separate
Administration, the cover page can be set in the user profile document in the FxD
Administrator's database.

If FxD determines that a cover page should be sent with the fax, but a cover page
form is not specified in Fax Options, the sender’s settings, or the
DefaultFxDUser’s settings, then the fax will not be sent. In addition, the sender
will receive a Delivery Failure message in their mailbox. This is contrary to the
information provided in the FxD for AS/400 Administrator’s Guide (nfxa400.nsf),
which states that a fax with no cover page will be sent.
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Figure 111. Fax Options

7.1.2 Changing the cover page design
As an administrator, you can modify the layout and format of the default cover pages
as depicted in Figure 112. To do this, you can use any of the form design tools
available in Notes. For example, you can add text and graphics or change the design
and organization of the default cover page.

Figure 112. Fax for Domino Cover Pages

If you try to change these forms, you get a caution message as shown in Figure
113. You also receive this message if you use “copy and paste” to create new
forms. This warning advises you that your Cover Pages database (nfxcover.nsf)
is based on a template (NFXCoverPage (nfxcover.ntf)) and is still linked to that
template for refreshing the design. It is possible, although unlikely, that a future
refresh of the template could overwrite your new forms. If you unlink the
database, you may lose some important future updates.

Figure 113. Designer message
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Table 5 lists the fields contained in the Fax for Domino Cover Pages forms. The
How to set column indicates the search order for the information.

Table 5. Field list in Fax for Domino cover pages

Field name Description How to set

IS_FaxOutToName Recipient's name Fax Options->Your fax settings->
Default fax settings

IS_FaxOutRequestOriginator Sender’s name Fax Options->Your fax settings->
Default fax settings->“From” field
of Notes Memo

IS_FaxOutCompany Sender’s company Fax Options->Your fax settings->
Default fax settings

IS_FaxOutSendersAddress1 Sender’s address1 Fax Options->Your fax settings->
Default fax settings

IS_FaxOutSendersAddress2 Sender’s address2 Fax Options->Your fax settings->
Default fax settings

IS_FaxOutReturnPhoneNumber Sender’s phone
number

Person Document in the Domino
Directory(Public Address Book)

IS_FaxOutReturnFaxNumber Sender’s fax
number

Person Document in the Domino
Directory(Public Address Book)

IS_FaxOutSenderEmail Sender’s e-mail
address

Fax Options->Your fax settings->
Default fax settings

IS_FaxOutDtReceived Date of sending fax Fax Options->Your fax settings->
Default fax settings

IS_FaxOutNumberPages Number of sending
fax pages

Fax Options->Your fax settings->
Default fax settings

IS_Recipient Other recipient Fax Options->Your fax settings->
Default fax settings

IS_FaxOutMessageText Message Fax Options->Your fax settings->
Default fax settings

Subject Mail subject “Subject” field of Notes Memo

Body Mail body “Body” field of Notes Memo

The Cover Pages database also contains other forms and documents needed by
FxD. Do not edit or delete these.

Note

If you remove or change the name of a field when you design a new cover page,
FxD ignores any information that is entered in that field in either the User Profile
settings or the Fax Options.

Note
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Since fields that you add to the cover page cannot be controlled directly by the
user in a fax request, you must generate the contents of these fields by assigning
default values or by using Design Field formulas. FxD will not set a value for a
new field that you add to a cover page.

Figure 114 shows an example of a new cover page that we will create. Graphics
can be used but should ideally be in gray scale. In gray scale, dots are different
shades of gray, where dots in dithered images are black or white.

If you use R5 Domino Designer, you aren’t required to store the graphic with the
database’s resources. However, storing the graphic there allows it to be shared
with other forms.

Figure 114. Sample fax cover page

Ensure that your Lotus Notes R4 or R5 client has the Designer client installed.
Then, complete the following steps to create and use a new cover page:

1. Open the Fax for Domino Cover Pages database in design mode. If you are
using an R5 client, this can be done by right-clicking the database icon on
your workspace and then selecting Open In Designer. If you are using an R4
client, click once on the Fax for Domino Cover Pages icon on your
workspace and then click View->Design from the menu bar.
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2. Copy an existing cover page, or click New Form to create a blank form. To
ensure you include appropriate fields, we suggest that you copy an existing
cover page.

3. Modify or add fields or graphics to your custom cover page. Change the name
of the form to avoid confusion. The name may be changed while the form is
opened by selecting Design->FormProperties.

4. Click File->Save to save the form.

Although the cover page can be used when specified by name, it will not yet
appear in the list of sample cover pages (see Figure 109 on page 115) that a user
can use. This is due to the fact that this new cover page just created is a form
while the database contains documents. To include your cover page in the list of
documents that the user can see when the Fax for Domino Cover Pages
database is opened, do the following steps:

1. Open the form you just saved in step 4 above in design mode and select
Design->FormProperties. As shown in Figure 115, select the Form Property
option to Include in menu first and then ensure that the Create menu option
appears.

Figure 115. Form property

2. Click File->Save. Then, click Create->Document and select the form you just
saved to create a “dummy” document for your new cover page. In the cover
page document that appears, enter a space in one of the fields and click
FIle->Save to save the document. Press Esc. Open the FxD Cover Page
database, and your new custom cover page will be included in the list of
documents.

If you do not see the Design option when you select View, open the Fax for
Cover Pages database and then click View->Show->Design. Also, by
default, the members of the FaxAdmins group and the Notes user
registered for the FxD Windows Services System have “Manager” access to
the FxD Cover Pages database.

Note
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When you send a fax using a cover page with a “Body” field defined in it and if the
fax message has multiple text lines formatted using different point sizes and
fonts, the various points sizes are correct in the delivered fax but not the fonts.
For example, if the message has three lines, where the first line is Helv 12, the
second is Script 14, and the third is Rockwell 14, and the first line of the delivered
fax is Helv 12, as expected. However, the next two lines have the correct,
respective point sizes but not the correct font styles. To avoid this problem, use a
cover page, such as DefaultFaxCoverPage, which has the body of the message
appear on a separate page. In summary, you should not specify the Body field in
your cover page if the fonts you are sending are important to you or the fax
recipients. We experienced similar results to those described in the above
paragraph when faxing with Japanese fonts using a Domino for AS/400 4.6.6c
server.

7.1.3 Assigning a default cover page
FxD uses the cover page form that is specified in the DefaultFxDUser settings as
the default. Unless it is changed, DefaultFaxCoverPage is the default cover page
listed in the DefaultFxDUser settings. If you are using combined administration,
the default cover page information is in the Person document for DefaultFxDUser
in the Domino Directory. If you are using separate administration, this information
is in the User Profile document for DefaultFxDUser in the FxD Administration
database. As an Administrator, you can change the DefaultFxDUser’s setting to
specify a different system default cover page form.

7.1.4 Assigning a cover page to individual users
You can also specify a cover page form for individual users by changing their fax
settings. This cover page becomes the default cover page used when that user
sends a fax. If combined administration is being used, the user’s fax settings are
part of the user’s Person document in the Domino Directory (Public Address
Book) as shown in Figure 116 on page 122. If separate administration is being
used, the user’s fax settings are in the User Profile document located in the FxD
Administration database as shown in Figure 117 on page 122.

If a user requests a cover page that does not exist, the fax request fails, and FxD
sends a Delivery Failure Report message to the sender.

The above restriction is also documented in the FxD 4.1 for AS/400 Release
Notes. However, when we used FxD 4.1 on a Domino for AS/400 5.0.2c server
and sent a fax using an R4.6.6c mail template, the font styles were not lost,
even though we were using a cover page with the body field on the same page
(like the standard Cover Page with Fax Body).

Note
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Figure 116. Combined Administration: Fax settings in Person document in Domino Directory

Figure 117. Separate Administration: User Profile document in FxD Administration database

7.2 Sending a fax with attachments

A Notes memo with attachments can be sent with FxD. FxD converts these
attachments into TIFF format and sends the images along with the memo. Even if
122 Lotus Fax for Domino for AS/400: Getting the Straight Facts



your memo only contains an attachment, the received fax will have a page for the
base memo containing an icon representing the attachment, and the attachment
will start on a new page. To avoid this, use Cover Page with Fax Body, which puts
the icons on the cover page.

To enable the sending of PC application output as attachments, you may have to
install all PC applications on the FxD Windows Services System that may be
used by users to produce those files for attachment. Even if you can view those
attachments from a Lotus Notes client, it is very likely that the viewer won’t be
sufficient to enable the attachment to be faxed using FxD. The FxD Windows
Services System must have software installed that enables it to print the
particular output type.

However, if your application produces output, such as a WordPad document, GIF,
or JPEG image, for which Windows NT has built-in viewing and printing
capabilities, then additional software may not need to be installed on the FxD
Windows Services System.

When you install the FxD Windows Services System, the following two Domino
databases are created in the local notes data directory:

• Convert Server Config (nfxconv.nsf): This database provides information
required for the faxing of specific attachment types.

• Convert Server Log (nfxcnvlg.nsf): This database is used for logging the
results of document conversion.

7.2.1 How attachments are handled
If a file attachment contains one of the following image file formats, the image
attachment can be included in the fax transmitted by FxD without any additional
software installed on the FxD Windows Services System:

• TIFF
• PCX
• DCX
• GIF
• JPEG
• BMP

Attachments in any other file format (for example, word processor documents or
spreadsheets) are processed by the FxD Convert Server process. The Fax for
Domino Conversion Service requires that an application that is capable of printing
the attachment be installed on the FxD Windows Services System. For example,
in order to fax a Lotus Word Pro document, Word Pro must be installed on the
FxD Windows Services System. This system may be running on a PC with
Windows NT Workstation (or Windows NT Server) or on an AS/400 Integrated
Netfinity Server that you are using as your FxD Windows Services System. If the

Additional information on sending an attachment with a fax is discussed in
6.1.1, “Sending a fax using Lotus Notes” on page 85, 6.2.1, “Sending a fax
using a Web mail client” on page 101, and 6.3.1, “Sending a fax using a
browser e-mail client” on page 108.

Note
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mailFax Convert Server print driver encounters an error, an error message is logged
to the Fax for Domino log (nfxlog.nsf) on the AS/400 system, and an error is logged
to the Convert Server Log (nfxcnvlg.nsf) on the FxD Windows Services System.

If the application is not on the FxD Windows Services System, but the user has it
on their PC, the user can send the attachment with the Lotus Print to Fax driver
instead as discussed in 6.1.2, “Sending a fax directly from a PC application” on
page 90). You must have a Notes client installed to be able to use this utility.

FxD currently supports the file formats and associated applications shown in
Table 6 without requiring any additional customer configuration.

Table 6. Tested file formats

7.2.2 Convert Server Config documents
FxD Windows Services System processes an attachment based on its file type.
When you install a new PC application on the FxD Windows Services System, the
file type produced by that product is generally associated with that application. As
a result, if you select a file of that type from Windows Explorer, the correct
application is invoked. For many applications, this is sufficient to enable faxing
attachments of that file type.

File format Application

Word Pro Lotus SmartSuite Millennium Edition

1-2-3 Lotus SmartSuite Millennium Edition

Freelance Graphics Lotus SmartSuite Millennium Edition

Microsoft Word Microsoft Office 97

Microsoft Excel Microsoft Office 97

Microsoft PowerPoint Microsoft Office 97

ASCII text WordPad

Rich text WordPad

PDF Adobe Acrobat

If FxD cannot convert an attachment on an outgoing fax, it logs a major error in
Fax for Domino Log (nfxlog.nsf) and does not transmit the fax. FxD notifies, by
e-mail, the sender of the fax of the error.

Note

Remember, before installing any additional applications on the FxD Windows
Services System, make sure that you are a member of the NT Administrators
group for the system. You should use the same user ID that you used to install
and set up the FxD Windows Services System. If you do not use the
appropriate privileges, you may experience problems converting attachments.

Note
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In order for an attachment to be faxed, the FxD Windows Services System must
be able to “print” that attachment using the mailFax Convert Server “printer”
without any user intervention. This printer driver is automatically installed when
FxD Windows Services software is installed and configured, and it is not a
physical printer. Although many application file types are supported immediately,
some require additional setup because they require user interaction during
printing. However, it is possible to provide the necessary user interaction to the
application by using the Convert Server Config (nfxconv.nsf) database.

FxD comes with appropriately configured documents for the supported document
types that require them. This includes Microsoft Excel, Microsoft PowerPoint, and
Portable Data Format (PDF). Other document types, such as Microsoft Word 97
and Lotus Word Pro, do not require any additional configuration. If you have other
applications you want to fax attachments from, you will have to test them. We
recommend that when you install the PC application on the FxD Windows
Services System, you also open the application once and try printing to the
mailFax convert Server printer.

The FxD Windows Services System manages popup windows based on popup
window documents in the Convert Server Config database (nfxconv.nsf). This
database consists of two views: File Types and Popup Windows. When FxD is
first installed, there are four File Type documents and three Popup Window
documents defined in the Convert Server Config database. They are:

• File Type documents

– doc
– pdf
– ppt
– xls

• Popup Window documents

– ppt (Print)
– xls (Print)
– xls (Print/Microsoft Excel)

While this process works correctly with many applications, some applications
exhibit unusual behavior when asked to print a document. If an application
behaves in an unusual way, you must configure FxD to handle the application.
See Appendix C, “Handling non-standard attachments” on page 215, for
information on creating new documents in the Convert Server Config database
(nfxconv.nsf).

After you change or create documents in Convert Server Config database, you
should restart Fax for Domino Windows Services. For details about starting and
stopping FxD, see 5.7.2, “FxD Windows Services” on page 73.

If you want to fax Advanced Function Printing (AFP) files, see 9.1, “Prerequisites
for faxing spooled file attachments” on page 153, and 9.2, “Preparing the FxD
Windows Services System (AFP output only)” on page 154, for specific
information related to AFP files.
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7.2.3 Additional information
Sometimes, you may find that faxing attachments does not behave as expected.
The following sections describe considerations when faxing .txt and .html
attachments.

7.2.3.1 Faxing .txt documents
If Notepad is used to process a document or attachment, such as a .txt file, the
TIFF file created by FxD Windows Services may contain a page number at the
bottom of the page and a temporary file name (that is not part of the original
document) at the top of the page as shown in Figure 118.

Figure 118. Received text file

If this is a concern, you can remove the header and footer by using one of the
following methods:

• Use wordpad.exe instead of notepad.exe as the associated application for the
txt extension on the FxD Windows Services System.

• Edit the notepad.exe registry entry on the FxD Windows Services System.
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Note that you cannot solve this problem by changing the Notepad Page Setup on
the FxD Windows Services System because the value is reset each time the
program is run. Editing the registry entry is a permanent solution.

Using wordpad.exe instead of notepad.exe
1. Click Start->Programs->Windows NT Explorer.

2. Click View->Options and then select the File Types tab.

3. Scroll through the Registered file types and select Text Document. Click the
Edit button.

4. Click the New button.

5. Specify the following values:

• Action: printto

• Application used to perform action:
“C:\Program File\Windows NT\Accessories\WORDPAD.EXE” /pt “%1” “%2” “%3”

“%4”

6. Click OK.

7. Click Close.

8. Click Close.

9. Close the Windows NT Explorer window.

10.Open the Convert Server Config database.

11.Select Create->File Type. Complete the fields in the resulting window as
shown in Figure 119.

Figure 119. File type document for text document using printto

12.Restart FxD Windows Services and Fax for Domino for AS/400. Refer to 5.7,
“Starting and stopping services” on page 72, for more details.

Editing the registry to change the Notepad default setting
1. Click Start and then click Run.

2. In the Run window, type regedit and then press Enter or click OK.

3. In the resulting Registry Editor window, edit the registry entry for
HKEY_USERS/.DEFAULT/Software/Microsoft/Notepad by completing the
following steps:

a. Right-click HKEY_USERS and choose Expand or click the plus (+) sign to
the left of HKEY_USERS.
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b. Right-click .DEFAULT and choose Expand or click the plus (+) sign to the
left of .DEFAULT.

c. Right-click Software and choose Expand or click the plus (+) sign to the
left of Software.

d. Right-click Microsoft and choose Expand or click the plus (+) sign to the
left of Microsoft.

e. Click Notepad.

4. Determine if the value szHeader is listed for Notepad.

• If it is listed, right-click szHeader, choose Modify, and then ensure that the
Value data field is blank.

• If the szHeader value is not listed for Notepad, right-click Notepad, select
New, left click String Value, type szHeader, and press Enter.

5. Determine if the value szTrailer is listed for Notepad.

• If it is listed, right-click szTrailer, choose Modify, and then ensure that the
Value data field is blank.

• If the szTrailer value is not listed for Notepad, right-click Notepad, and
select New. Then, click String Value, type szTrailer, and press Enter.

6. Close the Registry Editor window and restart the FxD Windows Services
System and the Fax for Domino server (running on the AS/400 Domino
server).

If you are using the Print to Fax driver on a Lotus Notes client workstation to fax
an application’s output directly, you should update the Notepad Page Setup on
your client workstation. This update will only affect your workstation and will only
affect the current Print to Fax request.

Every time you plan on faxing a Notepad document, and if you do not want the
header and footer, you must perform the following steps after starting Notepad
but before using File->Print to the Print to Fax driver:

1. Click File->Page Setup.

2. Remove the entry Page &p from the footer field and remove &f from the
Header field.

3. Click OK.

You could also edit your registry as described in the previous section. This would
be a permanent solution.

7.2.3.2 Faxing .htm and .html attachments
You can fax .htm attachments without any additional configuration. We found that
we could fax .html attachments if we:

1. Installed Microsoft Internet Explorer on the FxD Windows Services System

Remember that the above registry changes will affect all users who send faxes
with .txt attachments.

Note
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2. Defined Microsoft Internet Explorer to be the default browser to handle .html
files

3. Defined Convert Server Config documents as described in C.2.3, “Faxing
.html attachments” on page 221.

However, at the time of writing, Netscape on the FxD Windows Services System
gave an unknown popup error message (“Found unknown popup ‘print’”) that we
were not able to resolve. In this scenario, you can use either Microsoft Internet
Explorer or Netscape Navigator on the originating client PC because it is the FxD
Windows Services System that is doing the conversion of the attachment.

If you want to use the Print to Fax driver to fax .html files, you can use either
Microsoft Internet Explorer or Netscape Navigator on your Notes client.

7.2.3.3 Attachment order
Attachments are stored in the document separately from the 'hot spot' images
and are held in chronological order, that is, in the order they were added to the
memo. Therefore, the attachments will appear in the fax in the order they were
added, regardless of how they appear to be ordered in the memo.

7.2.3.4 Multiple attachments must have a unique name
There may be problems if you fax a memo with multiple attachments having the
same name. Lotus recommends that each application attachment in the same
memo have a unique name.

7.3 Fax headers

If you use the AS/400 2761 PCI Analog device for FxD, you can send a header
(banner) with the fax to include your company name, the sending time, and so on.
The header is specified in the fax device settings in Fax for Domino
Administration database (if using separate administration) or Domino
Directory/Public Address Book (if using combined administration). The 7852-400
fax modem does not support fax headers.

To create and use a header on a fax page, complete the following steps:

1. If using separate administration, open the Fax for Domino Administration
database, or if using combined administration, open the Domino Directory
(Public Address Book).

2. Click Fax, then click Devices, and open the fax device settings.

3. Click the Edit Device button.

4. Click the arrow button to the right of the Fax page header field to view a list of
available headers as shown in Figure 120 on page 130.

5. In the Select Keywords window, choose an existing header from the list or
enter a desired fax header in the New Keyword field. It is a good idea to start
your header with several space characters (^) to avoid having it cut off on the
left side on the received fax.

6. Click OK.

7. Click Save and Close.

After you change the information, you must restart FxD on the AS/400 system.
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Figure 120. Fax page header selection

The header is now contained in the fax device settings and appears at the top of
each page of the fax.

Figure 121. Fax Devices document
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As shown in Figure 121, the following text has been specified as our fax header:

^^^Sending^Date:^&date^^Time:^&time^^^^^^^^^^^^From ACME Company

The text string will appear in the fax header as:

Sending Date: 03/17/2000 Time: 07:37:14 PM From ACME Company

Variables that you may use in the header are listed in Table 7. You cannot use
DBCS in the header.

Table 7. Options for Fax page header

The maximum size fax header is 132 characters, and any fax header string
exceeding the fax page width is truncated.

7.4 Routing

When incoming faxes are received, they are deposited into a mail box by FxD. If
you do not specify any other form of routing, the fax is delivered to the inbox of
the user specified in the Deliver faxes to: field in the DefaultFxDUser Person
document or user profile. This fax administrator can view the fax and forward it to
the final recipient. You cannot specify DefaultFxDUser as your default fax
recipient because DefaultFxDUser doesn’t have a mail file.

Incoming faxes may be automatically routed:

• By users' Dual Tone Multi Frequency (DTMF) numbers
• By fax senders' Called Subscriber Identification (CSID) numbers

Option Description

&date Current date

&time Current time (hour and minute)

&day Current day of week

&strmon Current month

&lyear Current year

&12hr Hour (12-hour clock)

&24hr Hour (24-hour clock)

&page Page number

&to Recipient’s CSID

&from Sender’s CSID

&user User name

^ Blank space

Remember that when planning your fax header, many header formatting
options, such as &user, are expanded during processing.

Note
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• By port number
• Manually

If you specify all routing settings, incoming faxes are delivered according to
whether delivery information can be found in the following sequence:

DTMF setting->Port setting->CSID setting->DefaultFxDUser setting (manual)

This means that if you set up someone to receive all faxes on a certain port, and
the fax comes from a known CSID fax machine, the following actions occur:

1. If DTMF is used by the person sending the fax, DTMF takes priority and
determines the recipient.

2. If the fax is sent without DTMF, the Port setting determines who receives the
fax.

3. If you remove the Port setting, and the CSID is known, the CSID recipient
receives the fax.

4. If the CSID is not known, the user set up in DefaultFxDUser receives the fax.

Note: Direct Inward Dial (DID) routing for the ISDN adapters was not available
when this redbook was written.

7.4.1 DTMF routing
You can route incoming faxes to users based on extra routing Dual Tone Multi
Frequency (DTMF) numbers supplied by the sender of the fax. The 7852-400
modem does not support DTMF. DTMF refers to the tone you hear when you
press a phone key pad. Each tone is comprised of a low and a high frequency
tone.

You can’t automatically send a fax with DTMF tones with FxD, but if you want to
test inbound faxes to FxD, this is how you manually send a fax using DTMF. You
need to:

1. Know the DTMF of your recipient.

2. Dial the fax number using the on-hook button or handset associated with the
fax machine so that you can hear the tones.

3. When the remote fax device answers and you hear a tone, press the DTMF
sequence and the # key (unless you have changed the DTMF termination
digit) to terminate the sequence. Then press the send button and replace the
handset. Your fax is routed according to the settings at the recipient site.

To set up the routing of inbound faxes using DTMF, follow these steps:

1. Enable DTMF in the fax device settings. This document is in the
Administration database for separate administration and in the Fax view of the
Domino Directory for combined administration as shown in Figure 122). You
have to restart Fax for Domino for the change to take effect (type tell fax

quit, wait for it to finish, and then type load fax at the Domino server console).
You can see that there are a number of options that you can set to customize
your DTMF. To see help text associated with each option, click on the prompt.
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Figure 122. DTMF setting in Fax Devices settings

2. Assign a code sequence to each of the users who is to receive faxes using
DTMF. A person’s telephone extension number could be a suitable number to
use.

3. Edit the user profile of the user to receive the fax and enter the DTMF
sequence associated with this user. This will be in the Person document for
combined administration and the User Profile of the Administration database
for separate administration. See Figure 123 on page 134.

4. Enter in a name in the Deliver faxes to: field.
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Figure 123. DTMF setting in Person document: Combined administration

7.4.2 CSID routing
You can route all incoming faxes coming from the same remote Called Subscriber
Identification (CSID) number to the same address or addresses. The CSID is
generally the phone number of the outside fax device and appears on the fax
header that most fax machines print on incoming faxes. It can also be an
alphanumeric character string. For example, it could be a descriptive title for the
department of a company that does business with your organization. The CSID
can be up to 20 characters long. Anything longer is truncated.

If you are having problems determining the CSID being used, look at a previously
delivered inbound fax from that company. You may be able to identify the CSID
from the banner at the top of the fax.

To use CSID routing, you must create a user profile or add information to existing
user profile settings for each CSID number that you want to have automatically
routed. If you use combined administration, create a new Person document or
update an existing Person document with fax user profile settings. If you use
separate database administration, create a User Profile document or modify an
existing User Profile document. The user name in the new document you create
can be the name of the source of the faxes (for example, "Acme Co."). Then,
specify the CSID number for the source and the address(es) to which FxD will
deliver incoming faxes.

Figure 124 shows an example of setting a CSID in an existing Person document
and routing the fax to two people.
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Figure 124. Defining inbound CSID routing using existing person

Figure 125 shows an example of setting a CSID in a new Person document
defined specifically for the company sending the fax.

Figure 125. Defining inbound CSID routing using specific record
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The CSID field that you see in the Fax Device screen (number 1 on Figure 126) is
used for outbound faxes and is the CSID that you are sending when you send a
fax.

Figure 126. CSID setting in fax device settings...Combined administration

7.4.3 Port routing
You can route all faxes coming into a particular port to the same addresses. To do
this, use the Advanced settings in the fax device settings to assign a user profile
for that port. Faxes coming in to this port will be forwarded to the user profile
specified in this field. Only one name can be specified in this field. Fax for
Domino needs to be restarted on the AS/400 system to make the change
effective (see number 2 in Figure 126).

7.4.4 Manual routing
You can route all incoming faxes that aren’t routed by one of the other methods to
a fax administrator who can then look at each fax and send it to the correct user.
To do this, specify the administrator's address in the Deliver faxes to: field in the
user profile settings of your default user profile. You should use a person who has
a mail file so that the faxes can be delivered. See Figure 127 for an example.

1

2
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Figure 127. DefaultFxDUser’s Person document...Combined administration

7.5 Telephone number translation

FxD translates telephone numbers supplied in fax requests into the local dialing
sequence. This allows users to enter complete phone numbers even though they
are unsure of the location of the FxD server relative to the target fax recipient.
Fax for Domino translates the specified sequence of digits only when they are
found at the beginning of a telephone number. Also, as shown in Figure 129 on
page 138, Fax for Domino has the ability to use the plus sign (+) for phone
number translation. It works when using the Fax to field too.

When you enter a fax/phone number in the Personal or Public Address Book
(Domino Directory), a plus sign (+) is appended to the beginning of the number if
the number starts with the number 1. For example, if you enter the phone number
as 19785551234, Notes automatically parses it to +1 (978) 555-1234. If the FxD
administrator sets up the plus sign to translate to 011, 011 is appended to the
beginning of the number. In this case, a delivery failure report is generated
because the intended phone number is a local number, not an international
number.

Say you are in Boston, and your fax server is in Rochester. You do not know that your
fax server is in Rochester. If you wanted to send a fax to someone in Rochester, you
would probably send it to 1-507-555-1234. But, since your fax server is in Rochester,
it is not a long distance call. Therefore, you would make a telephone translation that
would translate all 1-507-XXX-XXXX to just XXX-XXXX.

To set up telephone number translation, complete the following steps:
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1. If you are using combined administration, open the Domino Directory (Public
Address Book), or if you are using separate administration, then open the Fax
for Domino Administration database.

2. Click the Fax section to expand it. Then, click Telephone number
translation.

3. Click Add Fax Number Translation

4. Select the server name and then enter the appropriate data in the Telephone
number to translate: and Translate to: fields. Our example is shown in Figure
128.

Figure 128. Telephone Number Translation

5. Click Save & Close. As shown in Figure 129, the new telephone number
translation is displayed.

Figure 129. View of Telephone Number Translation

Do not define a translation rule for a prefix that is specified in the fax server
settings. For example, if users must dial 9 to reach an outside line, either specify
9 as the prefix in the fax server settings, as shown in Figure 130, or define a
translation rule to replace 1 with 91.
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Figure 130. Dialing setting in the Server document

7.6 Cost codes

FxD will record the cost code in FxD Log database entries for the user's outgoing
faxes. Cost codes can be defined in User Profile documents in the Fax for
Domino Administration database (separate administration) or Person documents
in the Domino Directory (combined administration).

The cost code can be whatever you prefer to use. For example, a department
code, such as A001, can be used. FxD comes with some predefined reports for
the log including a report on fax usage by cost code as shown in Figure 131. This
is now effectively a report by department.

Figure 131. Cost Code view in Log database

To set a cost code, follow these steps:

1. Open the Domino Directory database (Combined administration (names.nsf))
or the Fax for Domino Administration database (Separate administration
(nfxadmin.nsf)).

2. Open Person or User profile View and select a user.

3. Click Edit Person and edit the Cost code under the Fax tab (Figure 132 on
page 140). The cost code can be 32 characters long.

4. Click Save and Close.
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Figure 132. Cost code setting in the Person document...Combined administration

If you change the cost code of a user, the change does not affect existing log
entries.

You can also create your own reports to tailor this information. For example, we
defined a new view called New COST that summarizes the transmission time for
successful faxes by cost code. Because the time reported here includes various
intermediate times, it should not be seen as an indication of telephone line usage.

If you want to create new view of the Fax for Domino Log, follow these steps:

1. Open the Fax for Domino Log database (nfxlog.nsf) in the Domino Designer
client.

2. Select Views

3. Press New View.

4. Specify a View name, type, select a location for the new View, and click OK.

5. Define the View.

6. Click File->Close and save the view.
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Figure 133. Sample view using Cost Code

As you see in Figure 133, this view shows the total of the field IS_FaxTransTime
for faxes successfully delivered. The Select statement used in the View is:

SELECT ((Form = "LogFaxEntry") & (IS_RequestNumber != "0") &
(IS_RequestType="OUTFAX") & (IS_ErrorCode = 504 ) & IS_FaxOutCostCode !="")

We are not reporting on faxes from users without cost codes.

The fields used are:

Cost Code IS_FaxOutCostCode

Originator @If (IS_RequestOriginator != "" ;@Name(
[CN];IS_RequestOriginator) ; @If( IS_RequestType="INFAX" ;
IS_FaxRemoteCSID ; "Unknown" ) )

TransTime IS_FaxTransTime

Fax No. IS_FaxPhoneXlate

Date @If( @IsAvailable(Fax_EndProcTime) ; Fax_EndProcTime ;
NFX_EntryTime )
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Chapter 8. National language support

Fax for Domino for AS/400 Release 4.1 is available only in English. However, it
can be used for sending faxes from non-English Notes clients. In this chapter, we
look at how Notes clients using other languages can use Fax for Domino. We look
first at how other Roman character-based languages, such as Spanish and
German, can fax the special characters that are part of their alphabets. Then, we
examine how a double-byte character set (DBCS) language, such as Japanese,
can be supported by Fax for Domino.

8.1 Roman character-based languages

To fax Roman type characters in Notes memos and attachments, you can use
either a national language version of Windows NT 4.0 and the Notes client or an
English version of Windows NT 4.0 and the Notes client on your FxD Windows
Services System.

We are assuming in this chapter that the person wanting to send a fax is using an
NLS version of Notes. It is also possible to use an English client to send
non-English language characters.

8.1.1 Installation and setup
For installation and setup of Fax for Domino for AS/400 on a Roman character
type language AS/400 systems, follow the steps described in Chapter 4,
“Installation” on page 35. You can see in Figure 134 on page 144 that the Fax
Options and Help buttons are in English. The administrator sees that the
configuration information in the Domino Directory or Administration database are
also in English. Users find that the help database is in English as well.

You can install English or NLS versions of your applications on the FxD Windows
Services System. It is the fonts in Windows NT that provide the special
characters required.

8.1.2 Sending faxes
You can use accented or umlaut characters (for example, é, ì, ã, ö, and û) in the
Subject and Fax to fields on your Notes Memo (see Figure 134 on page 144 for a
German example). You can see that the Fax to: field is in English.
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Figure 134. German Notes memo

The Fax to: field supports type ahead addressing in the same way as a To: field
does. It works even if you use umlauts in the Fax to: field.

You can also fax attachments with umlauts in the name of the attachment. See
Figure 135 for an example.

Figure 135. German Notes memo with umlauts in the attachment name

If the address you are using in the Fax to: field contains umlauts, you will also be
able to see them in the Fax for Domino Spool database (Figure 136).
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Figure 136. Fax for Domino Spool database with umlauts in destination address

8.1.3 Receiving faxes
Fax for Domino can receive faxes containing accented and umlaut characters. All
received fax documents are stored as TIFF images and you can view them
directly from your Notes client. See Figure 137 for an example in German.

Figure 137. Inbound German fax document
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8.2 Double-byte languages

To fax DBCS Notes memos and attachments, you need to install a Japanese
version of Windows NT 4.0 and a Japanese Notes client on the FxD Windows
Services System. You then install the FxD Windows Services as you would for
other languages. You must install a DBCS version of any PC product that will be
used to produce DBCS attachments on the FxD Windows Services System. The
FxD Windows Services System can also be used for faxing Notes memos and
attachments from SBCS clients as well as DBCS attachments containing Roman
language characters. The Japanese character set, for example, contains fonts,
such as MS Gothic, that enable characters, such as those you are reading now,
to be included in a Japanese word processing document.

A Japanese client can also send in Roman characters using an English FxD
Windows Services System. In this case, Japanese characters cannot be faxed.

8.2.1 Installation and setup
After you install FxD on your AS/400 server, you need to install a Japanese
version of software for all components except for FxD Windows Services. Set up
your FxD Windows Services System the same as for an English system.

8.2.1.1 Installation on Windows NT
1. Follow the English installation instructions but use Japanese Windows NT 4.0

and a Japanese Service Pack (minimum level is SP4 or higher).

2. Install the Japanese Lotus Notes Client (we used R4.6.6b) and set it up the
same as you would for an English client.

3. Install FxD Windows Services System.

4. Install the DBCS PC applications that are required to support faxing of
attachments. This may include Japanese versions of Microsoft Word or Lotus
Word Pro.

8.2.1.2 Changing the templates on the server for DBCS client
If you are using a Japanese AS/400 system, you do not have to do this step,
because your templates will be modified on the Domino server as part of the
setup.

Remember, during FxD server setup, FxD adds two subforms
($LotusFaxMemoSubform and $LotusFaxOptionsSubform) to the mail template
(mail45.ntf, mail46.ntf, mailc46.ntf, or mail50ex.ntf) and one subform
($LotusFaxLocationSubform) to the personal name and address book template
(pernames.ntf) on the server.

If you are using a Single Byte Character Set (SBCS) AS/400 system (for
example, English) and have installed FxD, you can create DBCS templates on
the server using client templates. To do this, follow these steps:

1. Stop FxD.

2. Change the mail template’s name (mail46.ntf, for example) on the server for
later use by English clients. Do these steps:

a. On any command line, type WRKDOMSVR and press Enter.
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b. On the resulting screen, type option 12 to display the contents of the
server’s data directory and press Enter.

c. Type option 7 next to the template file you want to make a copy of and
press Enter.

d. Type in the new name, as shown in Figure 138, and press Enter.

Figure 138. Rename Object command

e. Your template may disappear from the list. Press F5 to refresh the screen.
Your template name will reappear.

3. Perform the same tasks from step 2 for pernames.ntf.

4. Send your Japanese or other DBCS Notes client’s mail template and personal
name and address book template to the server.

You can use ftp or Client Access/400 to perform the copy.

5. Change the owner of the templates to QNOTES if you use ftp:

CHGOWN OBJ('/domino/as26faxdom/mail46.ntf') NEWOWN(QNOTES)

6. Open the Fax for Domino Setup database.

7. Click Done (no need to change).

Rerunning setup updates any of the mail templates, mail45.ntf, mail46.ntf,
mailc46.ntf, mail50ex.ntf, or pernames.ntf, that are found on the system. After
setup is rerun, you have DBCS versions mail46.ntf and pernames.ntf on the
server with FxD subforms.

8. Start FxD.

If you support Notes clients using different languages on your Domino server, you
should now change the names of the new DBCS templates, for example,
mail46J.ntf and pernamesJ.ntf. Then, rename the English templates back to their
original names. You can specify the template to be used when you create a new
user and new mail file (on R5 only).

Rename Object (RNM)

Type choices, press Enter.

Object . . . . . . . . . . . . . > '/domino/as26faxdom/mail46.ntf'
New object . . . . . . . . . . . mail46bu.ntf

...

Bottom
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys
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8.2.1.3 Setting up your Notes client
Your Notes users who want to send faxes have to complete the following steps:

1. Refresh the design of the personal address book (names.nsf on local) from
the FxD server with the DBCS version of the template.

2. Change the Location document in the personal address book (names.nsf on
local) to include the name of the Fax Domain (Figure 139).

Figure 139. Location document on Japanese client

3. Replace the design of the Notes mail database from the FxD server with
DBCS version template.

If you have multiple templates, select the Japanese template by checking
the template name to be used (Figure 140).

Note
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Figure 140. Replace design

You can now see the Fax to: field and the Fax option buttons (Figure 141).

Notice that Fax Option and Fax Help are shown in English.

Figure 141. New Memo on Japanese client

8.2.1.4 Other setup considerations and limitations
You can also create a Japanese cover page (see 7.1.2, “Changing the cover page
design” on page 117). If you copy or use the sample cover pages in the Fax for
Domino Cover Pages database, you should change the field font to some font
that can support DBCS. By default, fields in this form use Arial, which can’t print
DBCS. We suggest you use MS Gothic. Use your Notes designer client to change
the font used for the fields.

You cannot use DBCS characters on the banner (see 7.3, “Fax headers” on page
129).

You can specify DBCS characters for the Windows Popup document in Convert
Server Config database if the convert server send a error message about an
unknown popup. The specific window title that generated the unknown popup is
logged in Convert Server Log database. You should specify the window title
exactly as it is in the log message (see Appendix C, “Handling non-standard
attachments” on page 215).
Chapter 8. National language support 149



8.2.2 Sending faxes
You can use Japanese characters in the Subject and Fax to fields on your Notes
Memo (Figure 142).

Figure 142. New memo on the Japanese Client

The Fax to: field supports type ahead addressing in the same way as a To: field
does.

Also, if you are using a DBCS entry for a Business Card in your local Names and
Address book, you don’t need to specify the fax number in the Fax to: field
because the information is retrieved from your local names.nsf file.

If the administrator of FxD uses an English client, the To: field doesn’t appear
correctly in the spooled database (Figure 143), but the fax is sent correctly.

If you create a new cover page containing a Body field, MS Gothic font strings
are changed into MS Mincho in the sent fax by FxD with Domino R4.6. To avoid
this, use a cover page without the Body field. You can use the
DefaultFaxCoverPage as your model.

Note
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Figure 143. Spool mailbox with Japanese fax

8.2.3 Receiving faxes
Receiving Japanese faxes is easy because the fax is received as a TIFF image
file. Even if you use an English FxD Windows Services System, you can receive a
Japanese fax in your mail file, and you can see it on Japanese client.
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Chapter 9. Faxing from the AS/400 system

We have shown you in previous chapters how to fax Notes memos and PC files
as attachments. In this chapter, we discuss how to fax spooled files from OS/400.
In this chapter, we cover faxing:

• SNA Character String (SCS) spooled files as attachments to Lotus Notes
memos

• Advanced Function Printing (AFP) spooled files as attachments to Lotus
Notes memos

• SCS and AFP spooled files using the Print to Fax Driver

• SCS and AFP spooled files from an AS/400 application

• OfficeVision/400 documents and the use of the Send Distribution (SNDDST)
command.

To read more about AS/400 spooled files and AFP output in particular, see IBM
AS/400 Printing V, SG24-2160.

9.1 Prerequisites for faxing spooled file attachments

Faxing spooled files as attachments is a two-step process, which consists of:

1. Copying the spooled file to your PC.
2. Sending a Memo with the attachment to the fax domain.

You use Operations Navigator and AFP Workbench Viewer.

It may also be possible to use third-party products that support transfer of AS/400
spooled files to the PC environment. Each product would have to be studied to
determine if it could be used to produce and/or send suitable PC files.

To fax spooled files using the techniques described here, you need to use a client
workstation with the following software installed:

• Windows 95, Windows 98, or Windows NT (we did not try Windows 2000)

Lotus has announced publicly that they will support Notes and Domino R5
running on Windows 2000 Professional/Windows 2000 Server within 90 days
of Windows 2000 general availability. This is outside the time frame in which
this redbook was written.

• Operations Navigator

If you are faxing AFP output, you also need to install an AFP viewing product on
the FxD Windows Services System. This can be one of the following options:

• IBM Client Access Express version of the AFP Workbench Viewer
• IBM AFP Workbench for Windows NT and 95

Before installing and configuring the AFP viewer, make sure that you are a
member of the Windows NT administrators group for the FxD Windows Services
System. You should use the same user ID that you used to install and set up the
FxD Windows Services System. If you do not use the appropriate privileges, you
may experience problems converting AFP attachments.
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Follow the instructions that came with IBM Client Access Express or IBM AFP
Workbench for Windows to install the AFP viewer application on the FxD
Windows Services System. Then, install the latest level of fixes for the AFP
viewer.

For Client Access Express, see the Web site at:
http://www.as400.ibm.com/clientaccess

Select Service Packs.

If you can’t find a file ftdwprt.exe on your PC, you also need the latest version of the
viewer which is located at:
ftp://ftp.software.ibm.com/as400/products/clientaccess/win32/v3r2m0/files/

The latest version is currently in the file named ftd149plus and contains the file
ftdwprt.exe. If you cannot find this file, contact IBM Support and tell them you
need the file ftdwprt.exe. This only applies to Client Access Express.

For AFP Workbench for Windows NT and 95 fixes, go to the Web site at:
http://www.printers.ibm.com

Select Support->Software Information->AFP Workbench for Windows and
OS/2.

See 9.2, “Preparing the FxD Windows Services System (AFP output only)” on
page 154, for additional setup requirements for faxing AFP output.

The procedures described here were verified using:

• IBM AFP Workbench for Windows 95 and NT (5639-F14) V1.49
• Client Access Express for Windows (5769-XE1) Service Pack SF58121

9.2 Preparing the FxD Windows Services System (AFP output only)

After you install the AFP Viewer application, you must update the Windows NT
registry on the FxD Windows Services System. Although many applications do
not require special steps to enable faxing of their output, both Client Access
Express and AFP Workbench Viewer require that you perform some additional
tasks.

Figure 144 is a listing of the file ca_afp_vwr.reg that you can use to update the
registry of the FxD Windows Services System for use with the AFP viewer of
Client Access Express.

Figure 145 is a listing of the file wkb_afp_vwr.reg that you can use to update the
registry of the FxD Windows Services System for use with AFP Workbench for
Windows. Copies of both files are included with the downloadable material
associated with this redbook. See Appendix E, “Using the additional material” on
page 239, for more information on how to obtain the files.
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Figure 144. ca_afp_vwr.reg

Figure 145. wkb_afp_vwr.reg

Complete the following steps for the version of the AFP viewer that you installed.
Do not double-click on the file expecting to edit it. You will, in fact, update your
Windows registry, which may not be what you want to do.

REGEDIT4

[HKEY_CLASSES_ROOT\.afp]
@="afpfile"

[HKEY_CLASSES_ROOT\afpfile]
@="Advanced Function Print"
"EditFlags"=hex:00,00,00,00

[HKEY_CLASSES_ROOT\afpfile\shell]
@=""

[HKEY_CLASSES_ROOT\afpfile\shell\open]
@=""
"EditFlags"=hex:01,00,00,00

[HKEY_CLASSES_ROOT\afpfile\shell\open\command]
@="\"C:\\Program Files\\IBM\\Client Access\\AFPViewr\\FTDWINVW.exe\" %1"

[HKEY_CLASSES_ROOT\afpfile\shell\Print]
"EditFlags"=hex:01,00,00,00

[HKEY_CLASSES_ROOT\afpfile\shell\Print\command]
@="\"C:\\Program Files\\IBM\\Client Access\\AFPViewr\\FTDWPRT\" /p %1"

REGEDIT4

[HKEY_CLASSES_ROOT\.afp]
@="AFP_auto_file"

[HKEY_CLASSES_ROOT\afp_auto_file]
@="Advanced Function Print"
"EditFlags"=hex:00,00,00,00

[HKEY_CLASSES_ROOT\afp_auto_file\shell]
@=""

[HKEY_CLASSES_ROOT\afp_auto_file\shell\open]
@=""
"EditFlags"=hex:01,00,00,00

[HKEY_CLASSES_ROOT\afp_auto_file\shell\open\command]
@="\"C:\\Program Files\\AFP Workbench 32\\FTDWINVW.exe\" %1"

[HKEY_CLASSES_ROOT\afp_auto_file\shell\Print]
"EditFlags"=hex:01,00,00,00

[HKEY_CLASSES_ROOT\afp_auto_file\shell\Print\command]
@="\"C:\\Program Files\\AFP Workbench 32\\FTDWPRT.exe "/p %1"
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IBM AS/400 Client Access Express for Windows
1. Download the Client Access registry file (ca_afp_vwr.reg).

2. If you installed the viewer application in any directory other than the default
directory, update the registry file to specify the correct directory. The default
directory is: C:\Program Files\IBM\Client Access\AFPViewr. To update the
registration file, follow these steps:

a. Right-click the registry file (ca_afp_vwr.reg) and select Edit.

b. Make the necessary changes and save the file. Notice that the path name
is specified in two places in the file, and the directory names are separated
by two back slashes.

3. To update the Windows NT registry, double-click the registry file
(ca_afp_vwr.reg).

IBM AFP Workbench for Windows NT and 95
1. Download the AFP Workbench registry file (wkb_afp_vwr.reg).

2. If you installed the viewer application in any directory other than the default
directory, update the registry file to specify the correct directory. The default
directory is: C:\Program Files\AFP Workbench 32. To update the registry file,
follow these steps:

a. Right-click on the registry file (wkb_afp_vwr.reg) and select Edit.

b. Make the necessary changes and save the file. Notice that the path name
is specified in two places in the file, and the directory names are separated
by two back slashes.

3. To update the Windows NT registry, double-click the registry file
(wkb_afp_vwr.reg).

9.3 SCS spooled files as attachments

You do not need to add anything to the FxD Windows Services System to fax an
SCS spooled file as an attachment to a Lotus Notes memo.

To fax an SCS spooled file, follow these steps:

1. Use Operations Navigator to connect to the AS/400 system with the spooled
file you want to fax.

2. Select Basic Operations.

3. Select Printer Output.

4. Select the SCS file you want to fax and drag it to your desktop. This creates a
file of type .txt and converts the data to ASCII. You can also copy it to any
other location on your PC.

5. This file can now be attached to any rich text field in any Domino document,
including a Notes Memo and sent.

You may notice extraneous information at the top or bottom of your fax. This is
the header and footer put in by Notepad when it converts the .txt files to TIFF. For
information on removing this information, see 7.2.3.1, “Faxing .txt documents” on
page 126.
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9.4 AFP spooled files as attachments

To fax AFP spooled files as attachments, you need to install a suitable viewer on
the FxD Windows Services System and update the Windows NT registry so that
the viewer will properly process *.afp files when you fax them. We listed the
prerequisites for faxing AFP spooled files in 9.1, “Prerequisites for faxing spooled
file attachments” on page 153.

9.4.1 Faxing an AFP spooled file
To fax an AFP spooled file, follow these steps:

1. Use Operations Navigator to connect to the system with the spooled file.

2. Select Basic Operations.

3. Select Printer Output.

4. Double-click the spooled file you want to attach. This opens the AFP
application viewer.

5. Click File->Copy pages to file and specify a file name for the file using the
extension .AFP.

6. This file can now be attached to any rich text field in any Domino document,
including a Notes Memo and sent.

7. Recipients of a faxed copy of the AFP spooled file can view the fax from within
their Notes client since it will have been converted to a TIFF format. Lotus
Notes recipients of an e-mailed copy will need to have an AFP viewer
application installed on their PC.

9.5 SCS and AFP spooled files using Print to Fax driver

In 6.1.2, “Sending a fax directly from a PC application” on page 90, we describe
how to fax Windows application documents directly from an application. You can
use this same method to fax AS/400 spooled files. To use the Print to Fax driver
to fax AS/400 spooled files (both SCS and AFP), follow these steps:

1. Install the Print to Fax driver following the instructions in B.1, “Installing the
Lotus Print to Fax driver” on page 207. Remember that you must have the
Notes client installed to use this utility.

2. Use Operations Navigator to connect to the system with the spooled file you
want to fax.

3. Select Basic Operations.

4. Select Printer Output.

5. Double-click the spooled file you want to fax. This opens the Client Access
AFP application viewer.

6. Select File->Print and select to print to the Lotus Print to Fax driver.

9.6 SCS and AFP spooled files from an AS/400 application or command

OS/400 does not contain a built-in command to enable you to fax directly from an
AS/400 command line. However, a sample command is provided that you can use
“as is”. You can also build such a command yourself using the source provided,
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and then use it either from a command line or incorporate it into your
line-of-business applications running on the AS/400 system.

The tool we are providing is called SNDDOMFAX. To run it, you need to download
some code and objects from the Web at:
http://www.as400.ibm.com/domino/related/fxd

You do not need to use the source code to be able to use the command. Refer to
the readme.html file for further details, including a disclaimer. The code is
provided as a sample only, and no support is provided for it. The code is based on
work found in Lotus Domino for AS/400: Integration with Enterprise Applications,
SG24-5345, and uses Host Print Transform. This means that you may see some
impact on your AS/400 CPU when the fax is being processed on the AS/400.
There are also some types of AS/400 documents that will not fax. For example,
overlays will not fax with SCS spooled files. You need to use AFP spooled files to
fax overlays.

Before you try to use this command, consider the following points:

• Host Print Transform, which this command uses, requires that 5769-SS1 option 8
(AFP Compatibility Fonts) be installed on your AS/400 system.

• The user of the command must be registered in the system distribution
directory. Use the Add Directory Entry (ADDDIRE) command to do this if
necessary.

• The SNDDOMFAX program runs under user profile *OWNER (QSYS) instead
of *USER. This is done because users won't have access to some of the
objects that SNDDOMFAX uses. Because of this, it is important to note that if
you rebuild the command, and you use the readme.html information, public
authority to the command will be set to *EXCLUDE. You then manually add
whomever you want to be able to run the command to the authorized list of
users.

• You need to either run the qualified command (that is, QFXDTOOLS/SNDDOMFAX) or
add the library QFXDTOOLS to your library list.

Make sure that the following requirements are met:

• The program SNDDOMFAX and the command processing program are in the
same library, QFXDTOOLS.

If you want to put them into a different library, you can use the Change
Command (CHGCMD) command to link the Command Processing Program with
the command.

• The Workstation Customization object QFXDFINE is in the library
QFXDTOOLS.

Once these conditions are satisfied, you can use the command. To see how it
works, follow these steps:

1. On the AS/400 system, run a command to produce some spooled output.

2. Use the Work Spool File (WRKSPLF) command to identify the attributes of the
spooled file.

3. On any command line, type QFXDTOOLS/SNDDOMFAX, and press F4. You see the
display as shown in Figure 146.
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Figure 146. Send Domino Fax (Part 1 of 2)

4. Enter the required information and press Page Down. You see the display as
shown in Figure 147.

Figure 147. Send Domino Fax (Part 2 of 2)

5. You can see that you just faxed the most recent spooled file of a particular
name (for example, QSYSPRT) for your current session by using * in Job
Name. Complete the fields and press Enter.

6. Enter *YES for Notify on completion. You are prompted to provide an e-mail
address.

Send Domino Fax (SNDDOMFAX)

Type choices, press Enter.

Domino Server Name . . . . . . . as26faxdom

Recipients:
Fax to . . . . . . . . . . . . Susan Green@12345@fax

+ for more values
From:
Name . . . . . . . . . . . . . Justine Middleton
Company . . . . . . . . . . . IBM
Address Line 1 . . . . . . . . *BLANK
Address Line 2 . . . . . . . . *BLANK

Subject . . . . . . . . . . . . *BLANK

More...
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys

Send Domino Fax (SNDDOMFAX)

Type choices, press Enter.

Message Text . . . . . . . . . . Here is the information you asked for

Spool File:
Spool File Name . . . . . . . qsysprt Character value
Job Name . . . . . . . . . . . * Character value, *
User Name . . . . . . . . . . Character value
Job Number . . . . . . . . . . 000000-999999
Spooled File Number . . . . . *LAST 1-999999, *ONLY, *LAST

+ for more values
Scheduled Date . . . . . . . . . *CURRENT Date, *CURRENT
Scheduled Time . . . . . . . . . *CURRENT Time, *CURRENT
Notify on completion . . . . . . *NO *NO, *YES

Bottom
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys
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7. This command supports both AFP and SCS spooled files. We could not fax an
OfficeVision/400 document because the FFT format of the spooled file was not
recognized.

You can use this tool as a basis for an enhanced command or incorporate it into a
line-of-business application. The code is provided on an as-is basis for your use
and information. The field in the From name parameter is what is used for looking
up a fax user profile unless you specify an e-mail address together with Notify on
completion. In this case, the e-mail address is used. See 5.2, “User profiles” on
page 64, for more information on this.

9.7 Broadening the reach

This section was tested using Domino for AS/400 R5. We did not test the options
with R4.6. If you set up your AS/400 system to use AnyMail/400 Integration and
can exchange mail with users on your Domino server, you can use this support
for sending faxes.

OfficeVision/400 users can send faxes by sending mail with an address format of
user.faxno.faxdomain@maildomain. Although you can send SMTP mail such as
this by predefining system distribution directory entries, you can also set up your
AS/400 system to enable simpler ad-hoc Internet addressing. We describe how to
do this in 9.7.1, “Enabling Internet addressing” on page 161.

In fact, even if you don’t use OfficeVision/400, you can use the Send Distribution
(SNDDST) command to send faxes. Non-OfficeVision/400 users on the AS/400 can
use the SNDDST command to fax PC files (*DOC) for applications that have been
installed on the FxD Windows Services System. Note that the SNDDST command
does not support faxing of messages (*MSG) to Internet addresses.

Taking this one step further, if you can send e-mail to your FxD server from
somewhere in your SMTP network, you can use the fax services from that client.
There are some font conversion limitations that we document in Table 8 on page
165.

You may now want to consider security because anyone who can send SMTP
mail to your AS/400 system can route faxes through it. However, in the Fax server
configuration, you can specify whether certain users can send faxes as shown in
Figure 148.
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Figure 148. Restricting the use of Fax

You can use groups or individuals in your allow/exclude field. A denied user will
receive a message back saying that they are not allowed to use this fax server. A
minor event will be logged in the FxD log saying, for example:

Fax request from JMIDDLE?AS25@as25.itsoroch.ibm.com was denied due to setting
of Fax Server access list.

9.7.1 Enabling Internet addressing
To enable Internet addressing from an AS/400, follow these steps:

1. On any AS/400 command line, type:

ADDDIRE USERID(INTERNET SMTPRTE) USERD(‘Internet addressing’)
SYSNAME(INTERNET) MSFSRVLVL(*USRIDX) PREFADR(NETUSERID *IBM ATCONTXT)

Press Enter.

2. On any AS/400 command line, type:

CHGDSTA SMTPRTE(INTERNET SMTPRTE)

Press Enter.

3. For any OfficeVision/400 user who needs to use Internet addressing, use
OfficeVision/400 administration to change their Environment information to
Allow Internet Addressing.

For more information, see AS/400 Electronic-Mail Capabilities, SG24-4703.
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There is one more configuration item that you may want to know the value of in
your installation. It is the SMTP attribute Percent routing character. It specifies
whether the SMTP Server should interpret the “%” character as an SMTP routing
character or allow the character to just pass through. *YES is the default that
treats it as an SMTP routing character. Use the Change SMTP Attributes
(CHGSMTPA) command to check the value.

9.7.2 Global Domain documents
This section specifically refers to Domino R5. We did not test Domino R4.6.6.

When you configure Domino for AS/400 server for AnyMail Integration, a Global
Domain document (MTAGlobal) is created. The Conversions tab looks like the
example shown in Figure 149. Your Local primary Internet domain entry will be
different.

Figure 149. Global Domain document for AnyMail/400

If you change your configuration to Domino R5 SMTP, this document may still be
in your configuration. You may or may not still require it.

When you configure a new Domino server for Domino SMTP, you do not get a
Global Domain document by default. You may choose to create one to allow
multiple inbound SMTP domains to be accepted by the Domino server. If you
create one, the Conversions tab will look similar to the example shown in Figure
150. Your Local primary Internet domain will be different or empty if you have not
defined this value.
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Figure 150. Global Domain document for Domino SMTP

We found that the naming alternatives for sending faxes from other AS/400
systems and Domino servers using our Fax for Domino server depend on the
existence and configuration of the Global Domain document.

9.7.3 Testing environment
This is our testing environment. AS26 is our base machine with Fax for Domino
running. We only tested with Domino Release 5.0.2c.

• AS/26 Fax for Domino on this AS/400: Two scenarios
– AS/26a OfficeVision/400 and SNDDST AnyMail Integration
– AS/26b Domino SMTP

• AS/23 Domino server not in the same Domino Domain as AS26 and not
cross-certified

• AS/25 OfficeVision/400 and SNDDST AnyMail Integration

If trying to replicate these results, make sure your DNS/Host tables allow the
AS/400s to locate the various SMTP domains so that the requests can be sent
and the results of the faxing returned.

Note that the Default user profile will be used to provide outbound characteristics
for the fax, as FxD is unable to get the User Profile document for the sending
user. In some cases, you may be able to remove this limitation by creating a user
profile that matches the name you see in the error log. This only works if you are
using separate administration. See 5.2, “User profiles” on page 64 for more
information.

9.7.4 Addressing the mail
How you can address the item to be faxed depends on your Domino settings.
This information is included in the results in 9.7.5, “Test results” on page 165.

If you have no Global Domain document for inbound SMTP domains, you can use
a percent (%) symbol or a period (.) to address your fax mail.
Chapter 9. Faxing from the AS/400 system 163



For an example in faxing an OfficeVision/400 Note, see Figure 151.

Figure 151. Sending an Office Note

To fax a document stored in a folder using the SNDDST command, address it as
shown in Figure 152.

Figure 152. Send Distribution

Remember that, in both cases, the ability to use “.” or “%” depends on your
environment.

Send Note

Type mailing information, press F6 to type note.
Subject . . . . . . . . . . TEST FAX

Reference . . . . . . . . .

Type distribution list and/or addressees, press F10 to send.
Distribution list . . . . . F4 for list

----------------------------------Addressees----------------------------------
Type nickname, user ID address, or internet address. One per line.
Joanne%12345%fax@gerridom.com

More...
F3=Exit F6=Type note F9=Attach memo slip F10=Send F11=Change details
F12=Cancel F13=Change send instructions F14=Specify list F24=More keys

Send Distribution (SNDDST)

Type choices, press Enter.

Information to be sent . . . . . > *DOC *MSG, *DOC, *FILE, *IDP...
Recipient:
User ID . . . . . . . . . . . Character value
Address . . . . . . . . . . . Character value
Recipient type . . . . . . . . *PRI *PRI, *CC, *BCC

+ for more values
Internet Recipient:
Internet address . . . . . . . susanjones.2345.fax@as26faxdom

Recipient type . . . . . . . . *PRI *PRI, *CC, *BCC
+ for more values

Description . . . . . . . . . . A fax from me

More...
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys
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9.7.5 Test results
The following points summarize 9.7, “Broadening the reach” on page 160:

• If you are using AnyMail integration, use a “.” as the delimiter.

• If you are not using a Global Domain document, you can use “.” or “%” as the
delimiter.

• If you are using Domino SMTP and a Global Domain document, use “.” as the
delimiter with an exception in the next bullet.

• If you are using Domino SMTP and a Global Domain document that looks like
what is shown in Figure 150 on page 163, and your SMTP attributes on the
AS/400 system allow the use of a % (that is, CHGSMTPA
PCTRTGCHR(*NO)), and use “%” as the delimiter.

Table 8 shows a summary of the results we achieved. We did not test every
possible combination. Use the guidelines in the above list and test in your
environment to see if you can use a “%” rather than a “.”.

Table 8. Sending faxes in SMTP environment

Sent from Addressing Results

AS26 Domino
(Base Environment)

name@12345@fax Fonts are converted.
Attachments converted correctly.
Fax has no heading (To and From, etc.).

AS26 OV/400 memo name.12345.fax@smt
pdomain

Fonts not converted.
Full heading of memo present.
Requires AnyMail Integration

AS26 SNDDST
Word document

name.12345.fax@smt
pdomain

Fonts converted.
Have to enter description when using
SNDDST command but not used.
Requires AnyMail Integration.

AS25 OV/400 memo name.12345.fax@smt
pdomain

Fonts not converted.
Full heading of memo present.

AS25 SNDDST
Word document

name.12345.fax@smt
pdomain

Fonts converted.

AS23 Domino not
cross-certified with
AS26 and in
different Domino
domain

name.12345.fax@smt
pdomain

Fonts lost.
Attachments convert OK.
Fax has no heading (To and From, etc.).

POP3 client using
AS26 for SMTP

name.12345.fax@smt
pdomain

Fonts are converted.
Attachments convert OK.
Requires AnyMail/400 integration.

POP3 client using
Domino for SMTP

name%12345%fax@
smtpdomain

Fonts are converted.
Attachments convert OK.

second Domino
server in same
Domain

name@12345@fax Same as Base Environment.
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Note the following observations:

• When using Internet addressing from OfficeVision/400, you can’t put a space
in the name. For example, you must use jmiddle.12345.fax@gerridom.com,
not justine middleton.12345.fax@gerridom.com.

• When using the SNDDST command, a space in the user name is acceptable
but disappears when displayed on the cover page. Justine Middleton becomes
JustineMiddleton.

• In one test, the SNDDST command was used to fax a document from AS25. In
one case, a Word document was sent, and in the other, a Lotus 123 document. In
the former case, the subject that was included on the faxed cover page was
~wrd0000.tmp, and in the other, it was mine.123 (the real name). We do not know
the reason for this.

The new bind-to-specific IP address PTFs (also known as dual stack) allow you
to use AnyMail Integration and Domino SMTP on the same AS/400 at the same
time. In our scenarios, this means that we can now fax from OfficeVision/400
on AS26 using our FxD server on AS26.

You will require the following PTFs and any co-requisite or pre-requisite PTFs:

AS/400 release Server PTF Client PTF

V4R2M0 SF55697 SF55704

V4R3M0 SF58661 SF59663

V4R4M0 SF60787 SF60764

Note

Assuming that the network is set up so that OfficeVision/400 users can
exchange mail with Domino users, inbound faxes that are for OfficeVision/400
users can be forwarded by the Fax administrator. The OfficeVision/400 user
receives two mail items. The first item is the notification of the fax, and the
second item is the fax TIFF file itself with an internally generated name. The
OfficeVision/400 user can file the TIFF document to a folder and rename it at
the same time, and then use a mapped network drive and the imaging sofware
on the PC to view it.

Inbound faxes
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Chapter 10. Problem determination

This chapter discusses problem determination when using Fax for Domino for
AS/400. The method for troubleshooting a problem with Fax for Domino for
AS/400 depends on when the problem occurs.

You can use this chapter as a first step in problem determination, but you should
then use the FxD for AS/400 Admin Guide (nfxa400.nsf). There may also be more
detailed information available from the Domino for AS/400 FxD Web site:
http://www.as400.ibm.com/domino/related/fxd

10.1 Problems during installation and setup

In this section, we describe how you can solve problems during installation and
setup.

10.1.1 Add Domino Application (ADDDOMAPP)
This section describes a common problem encountered during an Add Domino
Application (ADDDOMAPP) command as well as its cause and solution.

Problem
If your user profile does not have the right authority, as described in 4.1,
“Installing the Fax for Domino software on the AS/400 system” on page 35, you
see the screen (Figure 153) after entering the Add Domino Application
(ADDDOMAPP) command and pressing F4.

Figure 153. Wrong authority for ADDDOMAPP

Cause
The message ID of this error is CPD6808. The cause is that without the *ALLOBJ
and *SECADM special authorities, you cannot use the QNNINPDC program in
the QNOTES library to retrieve the choices text for the LICPGM parameter. In our
case, the QNNINPDC program, in the QNOTES library, does not have enough
authority to retrieve information about 5733FXD, the licensed program for Fax for

Add Domino Application (ADDDOMAPP)

Type choices, press Enter.

Server path:
Server name . . . . . . . . . ____________________________________________

________________________________________________________________________________
________________________________________________________________________________
____________________________________________________

Data subdirectory . . . . . . *NONE_______________________________________
______

+ for more values _
Product . . . . . . . . . . . . _______
Optional part to be added . . . *BASE *BASE, 0, 1, 2, 3, 4, 5, 6...

Bottom
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys
Error occurred while retrieving choices text.
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Domino for AS/400. An example of how the screen should look is in Figure 25 on
page 37.

Solution
Sign on using a user profile that has *ALLOBJ and *SECADM special authorities.

10.1.2 Setting up Fax for Domino using Fax for Domino Setup database
This section describes some problems you may encounter while setting up Fax
for Domino using the Fax for Domino Setup database. Causes and solutions are
also addressed.

Problem
You filled out the form of the Fax for Domino Setup database as described in
4.4.2, “Running the Fax for Domino setup” on page 47. After you click the Done
button, you see a notice similar to the example in Figure 154.

Figure 154. Database Is Not Correct

Cause
This error occurs because you created a local replica of the database and opened
the local version of the database instead of the server version of the database.

Solution
Do not create a local replica of the Fax for Domino Setup database. Use only the
server copy of the database.

Problem
You enter a fax domain name greater than 32 characters. After clicking on the
Done button, you see a notice similar to Figure 155.

Figure 155. Fax domain greater than 32 characters

Cause
Only a fax domain name up to 32 characters is allowed.

Solution
Use a fax domain name that contains not more than 32 characters.

Problem
After clicking the Done button, you receive the display shown in Figure 156.
168 Lotus Fax for Domino for AS/400: Getting the Straight Facts



Figure 156. Setup failed

Cause
Your server has no authority to run unrestricted LotusScript/Java agents.

Solution
See 4.4.1, “Modifying the agent restrictions on your server” on page 46. This is
the main cause of this error. However, there are others. If modifying agent
restrictions doesn’t solve the problem, look at the FxDInstallLog file in the
server’s data directory for further information.

10.2 Problems after starting Fax for Domino for AS/400

If a problem occurs once you have completed installation and setup and have
started Fax for Domino for AS/400, you should check the Fax for Domino Log
database (nfxlog.nsf) for more information.

10.2.1 The standard Fax for Domino Log entry codes
Every Fax for Domino subsystem (see 2.1, “Fax for Domino for AS/400
architecture overview” on page 11)-related entry in the log has an associated
four-digit number. The first two digits identify the subsystem from which the
message was generated. If the second digit is even, it is an error message. If it is
odd, it is an event.

The ranges of entry codes for the various subsystems are described in Table 9.

Table 9. Code ranges for Fax for Domino subsystems

Range Subsystem

0000 - 0199 Global errors

0200 - 0399 Configurator

0400 - 0599 Scheduler
Chapter 10. Problem determination 169



An example of an error is:

479: Fax configuration could not be updated due to error.

An example of an event is:

502: Fax server configuration record read successfully.

10.2.2 The AS/400-specific Fax for Domino Log entry codes
There are also AS/400-specific entry codes. These entry codes have a five-digit
number. For problem resolution, refer to the FxD for AS/400 Admin Guide
(nfxa400.nsf). There may also be more detailed information available from the
Domino for AS/400 FxD Web site: http://www.as400.ibm.com/domino/related/fxd

10.2.3 Field NFX_xxx cannot be found in administration forms
When you find this error in your Domino console or in the Fax for Domino Log
database, make sure that you have specified a name for the fax administrator of
your Fax for Domino server in the Fax Server document when you configured
FxD. Refer to 4.5, “Configuring Fax for Domino for AS/400” on page 50 for more
information.

10.2.4 Dealing with FxD Windows Services System problems
The FxD Windows Services System must remain active whenever Fax for
Domino for AS/400 is active. If you suspect a problem with the FxD Windows
Services System, you may want to stop the services so that you can restart them
again. These are the ways you can deal with FxD Windows Services System
problems.

• Determine if the Windows Fax for Domino Conversion Service is active.
• Start the Windows Fax for Domino Conversion Service.
• Stop the Windows Fax for Domino Conversion Service.
• Manage the Windows Fax for Domino Service Monitor.

0600 - 0799 Administration

0800 - 0999 Spool

1200 - 1399 Router

1400 - 1599 Format converter

1600 - 1799 Logging

1800 - 1999 Job thread

2000 - 2199 E-mail

Range Subsystem

If the error code is below 1000, you do not see the leading 0 in the log entry.

Note
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10.2.5 Determining whether Windows Fax for Domino Conversion Service is active
On your FxD Windows Services System, perform the following steps:

1. Click Start->Settings->Control Panel and select the Services icon. The
display that is shown in Figure 157 appears.

Figure 157. Fax for Domino Conversion Service

2. Look at the Status column for the Fax for Domino Conversion Service to
determine its state:

• Blank: The Fax for Domino Conversion Service is not currently active.
Follow the Starting the FxD Windows Services System instructions to start
it. See the following section for more information.

• Started: The Fax for Domino Conversion Service has been previously
started. Follow the Stopping the FxD Windows Services System
instructions if you want to stop it for some reason. See 10.2.7, “Stopping
the Windows Fax for Domino Conversion Service” on page 172, for more
information.

• Starting: The Fax for Domino Conversion Service is in the process of
starting. Continue to monitor its status to make sure its status changes to
Started.

10.2.6 Starting the Windows Fax for Domino Conversion Service
Perform the following process from your FxD Windows Services System:

1. Click Start->Settings->Control Panel. Select the Services icon.

2. Select the Fax for Domino Conversion Service.

3. Click the Start button on the Services dialog.

If you want to use the DEBUG option, enter the following command in the
Startup Parameters box:

-debug

Monitor the C:\QFXDrouter.log file for debug information.

The debug log is never deleted. Additional debugging information is simply
appended to it. If it becomes too large, you can stop the FxD Windows
Services System and then delete it.

Note
Chapter 10. Problem determination 171



10.2.7 Stopping the Windows Fax for Domino Conversion Service
On your FxD Windows Services System, perform the following steps:

1. Click Start->Settings->Control Panel. Select the Services icon.
2. Select the Fax for Domino Conversion Service.
3. Click the Stop button.

10.2.8 Managing the Windows Fax for Domino Service Monitor
The Windows Fax for Domino Service Monitor is automatically stopped or started
when the Fax for Domino Conversion Service is stopped or started. Do not
attempt to stop this service directly. If you stop it, the service monitor
automatically restarts. To stop it, you must stop the Windows Fax for Domino
Conversion Service.

10.3 Problems using the Windows Fax Format Converter port 19700

It is possible that the Windows Fax for Domino Conversion Service cannot start
because a different application on the FxD Windows Services System is already
using port 19700 for TCP/IP communication.

Contact Lotus Support if you need to change the Windows Fax for Domino
Conversion Service port from 19700 to a different port number.

10.4 Problems during the fax conversion of an attachment

In 4.3.5, “Installing the required applications” on page 45, we explained that you
have to install the applications that your users most commonly use for document
attachments so that the attachments can be converted. During the process of
conversion, these attachments invoke the application and use the print function
and the mailFax Convert Server driver to convert them to TIFF files.

Not all applications use the same mechanism to print, and sometimes
unanticipated pop-up windows can occur during the conversion. With Fax for

Starting the Windows Fax for Domino Conversion Service also starts the
Windows Fax for Domino Service Monitor. Also, when you restart the Fax for
Domino Windows Services, you must stop and restart Fax for Domino on each
Domino for AS/400 server that uses the system for fax conversions.

Note

Stopping the Windows Fax for Domino Conversion Service also stops the
Windows FxD Service Monitor.

If fax conversions are in progress for very large files, it may take a long time for
the services to end. If one or more conversion threads hang, the services never
end, and you must reboot the FxD Windows Services System to recover.

Note
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Domino for AS/400, a tool to help identify the source of conversion problems is
installed on the FxD Windows Services System.

10.4.1 The utility program mfDesk.exe
The mfDesk.exe utility program allows a suitably privileged user to display the
Window NT Desktops currently active on a Windows NT system and to switch
between them. It is installed on your FxD Windows Services System when you
install FxD.

Sometimes an attachment produces an unknown dialog message on the FxD
Windows Services System. Normally, you can't see the dialog, but running
mfdesk.exe allows you to switch to the hidden desktop where the application is
run. This should let you see popup dialog windows. This program is found in the
Notes program subdirectory on the FxD Windows Services System.

After you execute mfDesk.exe, you see a display like the example in Figure 158.

Figure 158. mfDesk.exe

To switch to the convert desktop, select convert and click the Switch button. You
are switched to the desktop of the Windows Fax for Domino Convert Server (see
Figure 159 on page 174).

This program is provided to you “as is”. There is no support available. Lotus,
therefore, does not warrant or guarantee its reliability, serviceability, or
function.

Note
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Figure 159. Fax for Domino Convert Server desktop

On this desktop, you can now see which applications are invoked during the
conversion process, and if the conversion fails, you can see the pop-up window
that is causing the problem. You can interact with these pop-up windows to
correct the error.

An example of a pop-up window that needs an answer is, for example, to accept
the Software License Agreement for Acrobat reader. The first time you want to fax
a PDF file as an attachment, the window, which is shown in Figure 160, may
appear.

Figure 160. Acrobat Reader: Software License Agreement

After you select to Accept the Software License Agreement, the conversion
process goes on. You will not see this window again.

Information on how to tailor FxD for non-standard applications can be found in
Appendix C, “Handling non-standard attachments” on page 215.
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10.5 Problems ending Fax for Domino

When you shut down your Fax for Domino server, you may see a message that
the fax is not ending gracefully. This is not an error, it is more of an information
notice that Fax for Domino has reached a time-out in trying to shut down your fax
devices.

10.5.1 Fax did not gracefully exit
The following sections describe an example of a non-graceful exit:

Problem
Using the TELL FAX QUIT command on the Domino console or the End Domino
Server (ENDDOMSVR) command, as described in 4.8, “Stopping Fax for Domino for
AS/400” on page 60, you may see an error message like the example in Figure
161.

Figure 161. Fax did not gracefully exit

Cause
It is possible that during the shut down process some of your fax devices are still
receiving or sending a fax. Fax for Domino will not terminate these sending or
receiving devices immediately. Fax for Domino will tell these devices to quit after
finishing their job. You need to wait for these jobs to finish before you restart Fax
for Domino.

You must not touch the Fax for Domino Convert Server window, for example, to
click the Exit button. Any interaction with the Fax for Domino Convert Server
window, shown in Figure 159, may require you to reboot your entire FxD
Windows Services System.

Note

Work with Domino Console
Server: AS26FAXDOM

Previous subcommands and messages:

03/20/2000 10:43:09 AM Internal error. Fax did not gracefully exit.
03/20/2000 10:43:24 AM Searching Administration Requests database.
03/20/2000 11:22:40 AM Periodic full text indexer starting, performing
hourly full text indexing
03/20/2000 11:22:41 AM Periodic full text indexer terminating
03/20/2000 11:43:24 AM Searching Administration Requests database.
03/20/2000 11:46:18 AM Opened session for Domino Admin/ABC (Release 5)
03/20/2000 11:46:18 AM Opened session for Domino Admin/ABC (Release 5)
03/20/2000 11:46:18 AM Closed session for Domino Admin/ABC
Databases accessed: 0 Documents read: 0 Documents written: 0
03/20/2000 11:58:12 AM Closed session for Domino Admin/ABC
Databases accessed: 2 Documents read: 3 Documents written: 0

Enter a Domino subcommand.
===>

F3=Exit F5=Refresh F6=Print F9=Retrieve
F17=Top F18=Bottom F21=Command line
Chapter 10. Problem determination 175



Solution
Use the Work with Active Jobs (WRKACTJOB) command to display the subsystem of
your Fax for Domino for AS/400 server. Refresh your screen by pressing F5 until
the FAX and all QFAXDD jobs are gone. Check that your fax devices have a
status of CONNECT PENDING or VARIED OFF, like the example shown in Figure
162, using the Work with Configuration Status (WRKCFGSTS) command. Once
all these jobs are gone, FxD is in a stopped state.

Figure 162. Work with Configuration Status/Connect pending

Work with Configuration Status AS26
03/20/00 12:36:23

Position to . . . . . Starting characters

Type options, press Enter.
1=Vary on 2=Vary off 5=Work with job 8=Work with description
9=Display mode status 13=Work with APPN status...

Opt Description Status -------------Job--------------
FXPORT01 CONNECT PENDING
FXPORT02 CONNECT PENDING
FXPORT03 CONNECT PENDING
FXPORT04 CONNECT PENDING
FXPORT05 CONNECT PENDING
FXPORT06 CONNECT PENDING
FXPORT07 CONNECT PENDING
FXPORT08 CONNECT PENDING

More...
Parameters or command
===>
F3=Exit F4=Prompt F12=Cancel F23=More options F24=More keys
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Chapter 11. FxD in action

We want to document an example of a customer implementing Fax for Domino
using an AS/400 Integrated Netfinity Server and a IBM PCI Analog 2761 modem
card. The Domino administrator and the fax administrator are different people.

In this chapter, we discuss a number of topics including:

• Load balancing
• Port routing
• Fax enablement of Domino applications

The customer in this scenario is a computer company. The ACME company sells
computers and software. They also want to maintain a good relationship with
their business partners who are their distributors. They have developed an
application running on a Domino Web server. The ACME company has about 500
employees who have been using Lotus Domino for AS/400 E-mail, calendaring,
and workflow applications for some time. ACME uses clustering between their
two Domino mail servers to ensure availability. They always intended to
implement Lotus for Domino, so they named their servers MAILFAX1 and
MAILFAX2. They also have a separate Domino server called Ebusiness, on which
they are piloting some Web applications. In the future, they will use Internet
Cluster Manager (ICM) to provide failover support in the Internet environment.

ACME now wants to install two Fax for Domino servers using load balancing so
that all users can send and receive faxes with direct customers, suppliers, and
business partners. They also want to fax enable the business partner registration
part of their Web application. This allows them to create a fax and send it to the
business partner as part of the registration process.

11.1 Scenario characteristics

In this scenario, we use the following environment:

• OS/400 Version 4 Release 4

• Domino for AS/400 R5.0.3

• Notes Client for Windows R5.0.3

• AS/400 Integrated Netfinity Server (as the Windows NT FxD Conversion
Service System)

• IBM PCI Analog 8-port modem card (Feature code 2761)

• 500 Mail users in a clustered mail environment (in other words, two clustered
Domino mail servers that use mail cluster failover). For more information on
setting up Domino clustering, see Administering Domino Clusters, CT73SNA,
which is also part of the Domino R5 Administration Help database.

You cannot cluster all Fax for Domino databases because it doesn’t make
sense to have two active Spool Mailboxes. Therefore, you cannot have an
automatic failover fax system. In this chapter, we only cluster the Fax for
Domino Cover Page database for load balancing and data management.

Note
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• Domino Web server serving an e-business application with fax enablement.
We are using a part of the eBoats application described in Developing an
e-business Application: Using Lotus Domino for AS/400, SG24-6052.

Figure 163. Advanced scenario

11.2 Scenario objectives

Our objective here is to set up Fax for Domino for AS/400 using the existing
Domino for AS/400 environment so that all Domino users can send and receive
faxes, but also so the e-business application clients can send a pre-created fax
using a Web interface.

11.3 Planning

As with any software, planning is essential to a smooth implementation. Prior to
installing the actual software, there are a number of pre-installation tasks that
should be completed.

We are using the planning table described in Table 1 on page 34 to gather all
information necessary prior to installing Fax for Domino for AS/400. Our values
are summarized in Table 10.

Table 10. Fax for Domino for AS/400 planning table

Item Sample value

CSID (refer 3.4.1, “CSID for your fax lines”
on page 27)

5-6110, 5-6111, 5-6112, 5-6113, 5-6114,
5-6115, 5-6116, 5-12345

TCP/IP host name of your AS/400 system
(refer 3.4.2, “TCP/IP host name of your
AS/400 system” on page 28)

ACME1

e-business Application
Server/ Web Server

Mail Cluster and Fax for
Domino 4.1 Server

Integrated

Netfin
ity

Server

IBM PCI

Analog 2761
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We decided to use combined administration to centralize the management.

11.4 Installation

The following steps are needed for installation:

1. Install FxD on the AS/400 system
2. Add FxD server to Domino
3. Set up FxD Windows Conversion Services server
4. Set up FxD for Domino for AS/400 server
5. Configure FxD for AS/400
6. Set up Fax for Domino users
7. Start Fax for Domino

11.4.1 Installing the FxD product on the AS/400 system
To install FxD on the AS/400 system, refer to 4.1, “Installing the Fax for Domino
software on the AS/400 system” on page 35.

11.4.2 Adding the FxD server to the Domino server
Before we can add a Fax for Domino server to the existing Domino server, we
must end the Domino for AS/400 server where we want to add it. In our case, we
want to add Fax for Domino to server MAILFAX1 and MAILFAX2. In our clustered
mail environment, we first shutdown MAILFAX1, add Fax for Domino, restart
MAILFAX1, and do the same for MAILFAX2.

We use the Work Domino Server (WRKDOMSVR) command to show our servers and
type option 6 to end MAILFAX1 as shown in Figure 164 on page 180.

TCP/IP host name of your external FxD
Windows Services System (refer 3.4.3,
“TCP/IP host name of your external FxD
Windows Services System” on page 28)

We use an Integrated Netfinity Server located
on the same AS/400 system. Therefore, we do
not need a TCP/IP host name.

Network server description name (refer
3.4.4, “Network server description name”
on page 29)

NTSVR1

Fax hardware installed on your AS/400
system (refer 3.4.5, “Determining which
fax hardware is installed on the AS/400
system” on page 29)

X_ IBM PCI Analog 2761 (8-port)
__ IBM Analog (7852 model 400)

Fax hardware resource name or names
(refer 3.4.5, “Determining which fax
hardware is installed on the AS/400
system” on page 29)

CMN10
CMN11
CMN12
CMN13
CMN14
CMN15
CMN16
CMN17

Notes user and password on FxD
Windows Services System (refer 3.5,
“Registering a Notes user for the FxD
Windows Services System” on page 31)

FXDNTPC FAX
lotusnotes

Item Sample value
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Figure 164. Ending MAILFAX1 and MAILFAX2

After the MAILFAX1 server displays the Domino Status *ENDED (press F5 to
refresh the screen), and we use the Add Domino Application (ADDDOMAPP)
command as described in 4.2.2, “Adding the Fax for Domino software to the
Domino server” on page 37, to add the Fax for Domino databases and templates
to MAILFAX1. Then, we restart the server and follow the same procedure for
MAILFAX2. Remember that this command can normally be used to add the
application to both servers at the same time. However, in our case, we have
clustered servers for availability, so we choose to keep one server up.

After that, we register the Notes user we want to use on the FxD Windows
Services System as described in 3.5, “Registering a Notes user for the FxD
Windows Services System” on page 31.

11.4.3 Setting up FxD Windows Services System
To install Windows NT 4.0 and the latest service pack for Windows NT, we follow
the steps described in AS/400 - Implementing Windows NT on the Integrated
Netfinity Server, SG24-2164.

Refer to 4.3, “Setting up the FxD Windows Services System” on page 40, for
other steps required here.

11.4.4 Setting up FxD for AS/400 server
Before setting up Fax for Domino using the Fax for Domino Setup database, we
have to remove the additional FaxAdmins group that was created during the
second time we used the Add Domino Server (ADDDOMSVR) command. To do so, we
open the Domino Directory on one of our Domino servers and select the Groups
view on the left pane. Then, we select one of the FaxAdmins groups and delete it
as shown in Figure 165.

Work with Domino Servers
System: AS24

Type options, press Enter.
1=Start server 2=Change server 5=Display console 6=End server
7=Submit command 8=Work console 9=Work server jobs
11=Change current directory 12=Work object links 13=Edit NOTES.INI

Domino Domino
Opt Server Subsystem Status
__ *HTTPSETUP QDOMINOHT *ENDED
6_ MAILFAX1 MAILFAX1 *STARTED
__ MAILFAX2 MAILFAX2 *STARTED
__ EBUSINESS EBUSINESS *STARTED

Bottom
Parameters or command
===> _________________________________________________________________________
F3=Exit F4=Prompt F5=Refresh F9=Retrieve F11=Display path
F12=Cancel F17=Top F18=Bottom F22=Display entire field F24=More keys
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Figure 165. Delete additional FaxAdmins group

Then, we open the remaining FaxAdmins group and add all users we want to be
able to administer faxes.

Now we can run the setup for Fax for Domino as described in 4.4, “Setting up the
Fax for Domino for AS/400 server” on page 46.

On the Fax for Domino Setup database configuration display (Figure 166), we
enter for MAILFAX1:

• Fax Foreign Domain: Fax1
• Administration: Select Combined
• Notes User for FxD Windows Services: fxdntpc fax/ACME

• FxD Windows Services System: Select Local Integrated Netfinity Server
• Network Server Description: NTSVR1

Figure 166. Fax for Domino Setup MAILFAX1
Chapter 11. FxD in action 181



On the Fax for Domino Setup database configuration display, we enter for
MAILFAX2:

• Fax Foreign Domain: Fax2
• Administration: Select Combined
• Notes User for FxD Windows Services: fxdntpc fax/ACME

• FxD Windows Services System: Select Local Integrated Netfinity Server
• Network Server Description: NTSVR1

After both setup procedures are completed successfully, we have to configure the
Fax Server documents.

11.4.5 Configuring Fax for Domino for AS/400
To configure the Fax for Domino server using combined administration, we follow
the steps described in 4.5, “Configuring Fax for Domino for AS/400” on page 50.
We select the Fax->Servers view in the left hand pane of the Domino Directory
and open the MAILFAX1 Server document. Expand the Fax section of the
document.

1. In the Server administrator field, we specify the FaxAdmins group. All our fax
administrators are included in this group.

2. Load balancing allows the fax transmission load within an organization to be
shared by multiple fax servers in order to increase the transmission rate.
Within a group of load balancing fax servers, one parent server monitors all
child fax servers. We want to use load balancing. Therefore, we set the Is this
server the parent controller? field to Yes and specify MAILFAX2 in the Child
Server field as shown in Figure 167.

Load balancing is more important in a PC server environment than in a Fax for
Domino for AS/400 implementation. In most cases, the AS/400 chassis should be
able to provide space for the required number of fax lines. Although, in this
example, we show the use of load balancing in a single footprint with two Domino
servers, it does not really provide a true benefit here. The benefit comes when
you have to use multiple AS/400 systems to supply the required number of fax
lines.

Load balancing across servers is performed by using the ratio of the current load
on a given server (the number of bytes waiting to be faxed by a server) and the
load-balancing weight of that server in its fax server settings.

All servers included in a load balancing arrangement must:

• Be fax servers

• Have the FxD software installed

• Have a fax device installed

• Include information in the Fax section of the Server document (combined
administration) or have a Fax Server document in the FxD Administration
database (separate database administration)

• Be in the same Notes domain

• Have a replica of the Cover Pages database

Note
182 Lotus Fax for Domino for AS/400: Getting the Straight Facts



The administrator assigns server weights based on the number of outgoing fax
lines, the performance rating of the system, and what other applications run on
the server. For example, in the case of two identical systems that have similar
non-fax workloads, the server with one outgoing fax line would get a weight of “1”,
while the server with four outgoing fax lines would get a weight of “4”.

Figure 167. MAILFAX1 Server document

After we save and close the MAILFAX1 Server document, we open the
MAILFAX2 Server document and expand the Fax section of the document.

1. In the Server administrator field, we specify the FaxAdmins group.

2. MAILFAX2 is the child server. Therefore, we set the Is this server the parent
controller? field to No as shown in Figure 168 on page 184.
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Figure 168. MAILFAX2 Server document

3. We save and close the MAILFAX2 Server document.

Now we are ready to define the fax devices for the Fax for Domino. Perform the
following steps:

1. We select the Fax->Devices view in the right hand pane of the Domino
Directory. Then, we click the Create menu and select IBM PCI Analog.

2. For the Fax server name field, we use MAILFAX1/ACME.

3. Using the planning table shown in Table 10 on page 178, we configure our first
device using CMN10 in the Fax hardware resource name field.

4. In the Unique name for fax device field, we enter FAX101.

5. We enter the CSID, 5-6110, we defined in the planning table in the CSID field.

6. For the Fax page header, we select Header 1.

The completed display appears like the example in Figure 169.

We decide to use four ports of the IBM PCI Analog 2761 modem card for the
MAILFAX1 Fax for Domino server and four ports for MAILFAX2. We also
decide that we want to use the port routing method as described in 7.4.3,
“Port routing” on page 136, to deliver inbound fax to different departments.

Note
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Figure 169. IBM PCI Analog fax device settings

7. We enter the Notes person name in the Default user profile for routing of
incoming faxes field. This person will distribute inbound fax documents in the
department to which we assign this port.

8. After we save and close the first fax device settings, we create device settings
for all eight ports of the IBM PCI Analog 2761 modem card.

When all devices are created, the devices view looks like the display in Figure
170.

Figure 170. Fax devices view
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11.4.6 Setting up FxD users
Before we inform our users that Fax for Domino is now available for use, we
define the standards for our fax users. We design a corporate default cover page
and specific cover pages for some users by following the steps described in 7.1,
“Fax cover page” on page 115. The finished cover page is shown in Figure 171.

Figure 171. Corporate default cover page

We call it “ACME Fax Cover Page”.

To use this as a default for most of our fax users, we change the DefaultFxDUser
Person document and set ACME Fax Cover Page as the value of the Cover Page
field as shown in Figure 172.
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Figure 172. DefaultFxDUser

To maintain only one Fax for Domino Cover Pages database, we decide to delete
the Fax for Domino Cover Pages database on MAILFAX2 and to create a replica
of the Fax for Domino Cover Pages database of MAILFAX1 on MAILFAX2.
Because these two Domino servers are clustered, all changes are mirrored
immediately to the replica of the database on the other server.

To update the personal address books on the Notes client of our users, we now
create a Memo that we send to all of our users.

This Notes memo includes, as an attachment, a copy of the updated
pernames.ntf templates from MAILFAX1 and a step-by-step description on how to
detach the template to the client and how to refresh the database design of their
local address book against the template. The memo also includes the button
described in 4.6.1, “Updating user Personal Address Books with fax domain
information” on page 55 as a second step.

11.4.7 Starting Fax for Domino for AS/400
To start the two Fax for Domino servers, we follow the steps in 4.7, “Starting Fax
for Domino for AS/400” on page 58.

Now all our Notes users can send and receive fax documents.

We provide our users with copies of Chapter 6, “Using Fax for Domino: A user’s
perspective” on page 81, to assist them with learning how to use Fax for Domino
for AS/400.

We advise them that to send faxes, they always address the fax to Fax domain
Fax1, for example, jdoe@12345@Fax1. FxD will route faxes to the spool
database represented by Fax2 as necessary. In the Fax for Domino Spool
Mailbox database on the parent Fax for Domino server MAILFAX1, we can see
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that some jobs are redirected to MAILFAX2. This is shown in Figure 173 by
looking at the Original Server and Processing Server field in the Spool
Information section of the fax entry information.

Figure 173. Fax for Domino Spool Mailbox on MAILFAX1

We now open the Fax for Domino Spool Mailbox database on the child Fax for
Domino server MAILFAX2 and then open the same entry. We can see in the
Temporary Files Information section that the temporary fax TIFF files are
processed by MAILFAX2 as shown in Figure 174.

Load balancing across servers is performed by using the ratio of the current
load on a given server to the load balancing weight of that server. The current
load is the number of bytes waiting to be faxed by the server. The load
balancing weight is assigned to the server in its fax server settings.

Note
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Figure 174. Fax for Domino Spool Mailbox on MAILFAX2

11.5 Enabling the Web application to send fax documents

The application in this section is based on an example in Developing an
e-business Application: Using Lotus Domino for AS/400, SG24-6052.

The ACME company is using a Web application to register business partners.
Until now, the new business partner has to fill out a form on the Web. This form is
stored in a Domino database, and mail is sent to the business partner telling them
that their application to be a new business partner has been received. You can
see the form in Figure 175 on page 190.
Chapter 11. FxD in action 189



Figure 175. Basic business partner application form

The approver of the application currently telephones the prospective business
partner to request their credit card information.

Now, with Fax for Domino, we want to allow the new business partner to request
a pre-created fax using the fax number they enter on the form. To do this, we add
an additional button to our form. The Fax button is defined to invoke the following
commands as you can see in Figure 176 on page 191:

@Command([FileSave]); ‘Save the Document
@Command([ToolsRunMacro]; "Credit Card Request"); ‘Run the agent that sends the
fax
db := @Subset(@DbName; -1);
url := "/" + db + "/AboutUs?OpenPage";
@URLOpen(url) ‘Go to next web page
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Figure 176. Fax button commands

In the next step, we change the text property of the first line of text (the line
beginning with “Please enter the...”) to be hidden on a Notes client display and
the second line of text (“This is the information...”) to be hidden on the Web
interface as shown in Figure 177 on page 192.
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Figure 177. Hide paragraph

After we save the form, we now create the agent that sends the fax to the new
business partner.

We name this agent Credit Card Request, define this to be a Shared Agent, and
select the Action in the bottom part of the display to run a simple action as shown
in Figure 178.

Figure 178. Simple action agent

We click the Add Action button and select Send Mail Message as shown in
Figure 179.
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Figure 179. Send Mail Message Action

To create To: and Subject: fields using variables, we click the More button.

On the More Options display, we create a formula, using the fields from the
business partner form to create the fax address in the required format, in the To:
field and a variable Subject: field as shown in Figure 180.

Figure 180. More options

After we click the OK button, we can now enter the body of the message.

The text we type in here is what you see in the top part of Figure 183 on page
195.

We want the new business partner to check the data they submitted to us.
Therefore, we include a copy of the document in the fax as shown in Figure 181
on page 194.
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Figure 181. Include copy of document

Now, we can click the OK button and save the agent.

We now have a fax enabled Web application. When a new business partner
wants to register and accesses our application through the Web, they see a
display like the example in Figure 182.

Figure 182. New Business Partner registration

The completed and returned fax is shown in Figure 183.
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Figure 183. Inbound business partner fax

Now the fax enablement of the Web application is completed, and this concludes
the scenario.
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Appendix A. Additional installation topics

This appendix includes additional information pertaining to the installation of Fax
for Domino for AS/400. The first section describes using a Lotus Notes 5.0.2b
client, instead of a 4.6.6b client, to register a user for the FxD Windows Services
System.

The second section provides information on how to cross certify the Notes user
ID that you are using for the FxD Windows Services System with the cert.id file of
this additional Notes organization. You only need to do this if you want to use one
FxD Windows Services System to serve more than one Notes organization. Most
installations do not require this.

A.1 Configuring the Notes client on the FxD Windows Services System

You have registered the user ID for the FxD Windows Services System in 3.5,
“Registering a Notes user for the FxD Windows Services System” on page 31.
This section describes how to configure an R5 Notes client using this user ID.
Complete the following steps:

1. Start the Lotus Notes client application. When the window, as shown in Figure
184, appears, click Next.

Figure 184. Lotus Notes Client Configuration

2. Select I want to connect to a Domino server as shown in Figure 185 on
page 198.
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Figure 185. Configuration: Connect to Domino server?

3. Select the desired LAN connection, as shown in Figure 186, and click Next.

Figure 186. Configuration: Type of connection

4. Enter our Domino server name as depicted in Figure 187. Click Next.

Figure 187. Configuration: Domino Server Name

5. The window, as shown in Figure 188, prompts for the user name. Enter the
user, Grnfxdpc Fax, which was previously registered. Click Next.
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Figure 188. Configuration: Who Are You?

6. Click Next in the next window as shown in Figure 189.

Figure 189. Configuration: Connection over LAN is set up

7. In the window, as shown in Figure 190, select I don’t want to create an
Internet mail account and click Next.

Figure 190. Configuration: Create Internet mail account

8. Select I don’t want to connect to a news server as shown in Figure 191 on
page 200. Click Next.
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Figure 191. Configuration: Connect to a News Server

9. Choose I don’t want to connect to another directory server and click on
Next as illustrated in Figure 192.

Figure 192. Configuration: Directory server

10.Select I do not connect to the Internet through a proxy server, as shown in
Figure 193, then click the Next button.

Figure 193. Configuration: Connect through a Proxy Server
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11.Select Connect over my existing local area network, as shown in Figure
194. Then, click Next.

Figure 194. Configuration: Internet Connection Type

12.On the Congratulations window, as shown in Figure 195, click on Finish.

Figure 195. Configuration: Lotus Notes setup complete

13.Enter the password for user Grnfxdpc Fax as shown in Figure 196. The Lotus
Notes client retrieves the user ID file for Grnfxdpc Fax from the GREENDOM
server and stores it in the Notes data directory on our PC. Click OK.

Figure 196. Enter Password

14.Click OK on the Notes Setup complete window as seen in Figure 197 on page
202.
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Figure 197. Lotus Notes setup complete

The Lotus Notes R5 desktop appears as shown in Figure 198.

Figure 198. Lotus Notes desktop

15. Since the Lotus Notes setup is complete, close the Notes client.

You may now want to return to 4.3.4, “Installing FxD Windows Services System
software” on page 43, to continue the installation process.

A.2 Cross certifying the user ID file

As described in 3.6.2, “One FxD Windows Services System serving different
organizations” on page 32, you may want to use one FxD Windows Services
System to serve more than one Domino organization. In this case, you have to
cross certify the Notes user ID that you are using for the FxD Windows Services
System with the cert.id file of this additional Domino organization.

To cross certify the user ID file of the FxD Windows Services System, follow
these steps:

1. Use the FxD Windows Services System user ID file to send a safe copy of this
ID file to the administrator of the second organization by following these steps:
202 Lotus Fax for Domino for AS/400: Getting the Straight Facts



a. On the Notes client, click File->Tools->User ID. Then, you see a window
similar to the example in Figure 199.

Figure 199. User ID

b. Select the Certificates icon as shown in Figure 200.

Figure 200. Certificates

c. Click the Request Cross Certificate button and select the ID file you want
to have cross certified (Figure 201 on page 204).

A safe copy means that you are not sending your original user ID file. You
are sending only a stripped down copy to use for cross certification.

Note
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Figure 201. Choose ID to be Cross-Certified

d. Type the other Domino administrator address where you want to send the
safe copy of the ID file and click Send as shown in Figure 202.

Figure 202. Mail Cross Certificate Request

2. The Domino administrator of the other organization now has to cross certify
the safe copy of the ID received through mail by following these steps:

a. Open the mail document containing the cross certificate request and click
the Actions->Cross Certify Attached ID file as shown in Figure 203.

Figure 203. Cross Certify Attached ID File
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b. Choose the certifier ID file you want to use to certify the attached ID file
and click OK (Figure 204).

Figure 204. Choose Certifier ID

c. Click the Server button, as shown in Figure 205, to change the registration
server. Once all is selected, you may click the Cross Certify button to
perform certification (Figure 205).

Figure 205. Cross Certify ID

Once certification is completed, the other organization can use the FxD Windows
Services System to convert their fax documents.
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Appendix B. A user’s perspective: Installation topics

This appendix to Chapter 6, “Using Fax for Domino: A user’s perspective” on
page 81, includes additional details on installing the Lotus Print to Fax driver and
setting up a POP3 client using Netscape 4.7.

B.1 Installing the Lotus Print to Fax driver

The Lotus Print to Fax driver enables you to fax output from any Windows-based
application using FxD without directly using the Notes client. However, the Lotus
Notes client must be installed before you can use the Print to Fax driver. This is
an alternative to sending the output of Windows-based applications as
attachments to Lotus Notes memos. You may see Lotus documentation refer to
this driver as PTF. To avoid confusion with the AS/400 term Program Temporary
Fix, we do not use this abbreviation.

First, download the Print to Fax driver for your Windows PC from the Web site at:
http://www.lotus.com/home.nsf/welcome/faxfordomino

After the download completes, the file lotusptf.exe is on your system as shown in
Figure 206. Double-click the lotusptf.exe icon. The installation occurs
automatically. There is no need to run the Microsoft Windows - Add Printer
function.

Figure 206. Lotus Print to Fax driver file

After a few seconds, a window appears, which is shown in Figure 207 on page
208. After closing any other active applications, as is suggested, click the Next
button.
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Figure 207. Print to Fax driver install: Welcome

The Software License Agreement window is displayed, as shown in Figure 208.
Click Yes to continue after reading the agreement.

Figure 208. Installation window: Software Agreement

Figure 209 shows the next window, which includes information on the Print to Fax
driver. This information is also in the readme.doc file that is in the directory
selected in Figure 210. Click Next to continue the installation.
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Figure 209. Print to Fax: Information

As shown in Figure 210, a default destination folder is already selected but can
be changed if desired. Click the Next button to continue.

Figure 210. Destination folder for Print to Fax driver

After the installation is complete, the window shown in Figure 211 on page 210
appears. At this point, select whether to restart your computer immediately or
later. A restart is required before using the Lotus Print to Fax driver.
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Figure 211. Setup Complete for Print to Fax driver

B.2 Registering a POP3 client with Domino

The following steps must be completed by the Domino Administrator to register a
POP3 user with a Domino R5 server.

1. Start Domino Administrator by clicking on its bookmark icon on your R5
desktop. Alternatively, click File->Tools->Server Administration to start
Domino Administrator. Click Esc at the Administrator welcome display.

2. Select your domain and the server (if necessary) and then select the People
and Groups tab.

3. Click the People twistie and then click Register. When prompted, enter the
password for the cert.id of the your server.

4. Click No if you see a pop-up window regarding the certifier ID and recovery.

5. In the Register Person - New Entry window, select the Advanced box and
enter:

• First name
• Last name
• Password
• Internet address, such as name@popdomain.com

6. Select the Set Internet Password box.

7. Click the Mail icon in the Register Person window. Verify that the mail server is
correct. Also, you must ensure that the Mail system is changed to POP.

8. After verifying that the person’s information has been entered as indicated
above, click the Add Person button. The new user appears at the bottom of
the window in the Registration queue area.

Although the process would be similar to register a POP3 user with a Domino
4.6 server, the actual selections used in each step may vary. For example, the
Domino Administrator client is new with R5.

Note
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9. Click the Register button (or Register All if you are registering more than one
person).

10.Close the Register Person - New Entry window and refresh the Domino
Administrator window.

The new POP3 user appears in the People & Groups view.

B.3 Setting up Netscape Messenger as a POP3 client

The following steps outline what must be done to set up Netscape Messenger as
a POP3 client. The information required to configure Microsoft Outlook Express is
similar. We are assuming that the Domino Administrator has already registered
you as a POP3 user as shown in B.2, “Registering a POP3 client with Domino” on
page 210.

Before you (as a POP3 user) can send and receive e-mail, your browser settings
must be changed to reflect your mail server and whether you will use an IMAP or
POP3 server. You may have one POP3 server or multiple IMAP servers, but not
both.

To specify or change the servers you use for mail, perform the following steps:

1. From Netscape, click Edit->Preferences.

2. Click Identity and enter appropriate information as shown in Figure 212.

Figure 212. Entering the identity of the POP3 user

3. Click Mail Servers from the Mail & Newsgroup category. In the Incoming Mail
Server field, click Add to add a server. As shown in Figure 213 on page 212,
enter the appropriate information for your POP3 server. In our example, our
as26faxdom server is functioning as both an FxD server and a POP3 mail
server.

The browser used in this section is Netscape Communicator 4.7.

Note
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a. At Server Type, click the drop-down list and select POP3.

b. Enter your user name.

c. Select Remember password if you’d rather not be prompted for your
password each time you start Messenger (you are prompted for a
password initially). In our example, do not select this option.

d. If desired, select Check for mail every __ minutes and set a time period.
In our example, we are not selecting this option and, therefore, must click
the Get Msg icon on the component bar to retrieve messages.

e. Click the OK button.

Figure 213. Mail Server Properties

4. Click the POP tab, and a window, as shown in Figure 214, appears.

Since we do not want to leave messages on both the mail server and our
personal computer, do not check Leave messages on server.

Figure 214. POP settings

The other option, “When deleting a message locally, remove it from the
server”, only applies if we select Leave messages on server.

Note
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5. At the Mail Servers window, as shown in Figure 215, enter your SMTP server
in the Outgoing mail (SMTP) server field. In our case, our SMTP server is
as26faxdom.abc.com.

Also, enter your user name as provided by your system administrator or
Internet service provider. Do not enter your entire e-mail address.

We are leaving the defaults for the other Mail Server options.

Figure 215. Outgoing mail settings

Optionally, other Netscape preferences, such as the Messenger window layout
and disk space settings, can be changed by selecting other Mail & Newsgroups
categories.

Note
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Appendix C. Handling non-standard attachments

FxD converts non-image attachments to fax image format by starting the
application associated with the document type and having that application print
the document using the Fax for Domino Conversion Service print driver (mailFax
Convert Server driver; this printer driver is installed by FxD automatically). This
print driver captures the image created by the application and passes it back to
FxD to transmit with the fax.

While this process works correctly with many applications, some applications
exhibit unusual behavior when asked to print a document. Where an application
behaves in an unusual way, you must configure FxD to handle the application by
creating documents in Convert Server Config database (nfxconv.nsf).

Any necessary documents for the applications announced as supported for
attachments are already provided.

C.1 Fax for Domino Conversion Service

After installation FxD Windows Services System, two services are started
automatically: Fax for Domino Conversion Service and Fax for Domino Service
Monitor (Figure 216).

Figure 216. Services on Windows NT that FxD Windows Services System running on

The Fax for Domino Conversion Service is what actually converts Lotus Notes
attachments to fax images (TIFF). This service continually monitors for
conversion requests from any FxD for AS/400 that is configured to use this
service for conversion purposes. Once the Fax for Domino Conversion Service
has received a conversion request, it starts the Windows application that is
needed to successfully convert the attachment. The Fax for Domino Conversion
Service monitors this application’s progress during the conversion process.
Normally, the Fax for Domino Conversion Service is alerted that the application
has finished converting the attachment into a print file when the application ends.
However, if the application displays one or more dialog boxes during the
conversion process, the Fax for Domino Conversion Service may not successfully
complete the conversion process and may, in fact, timeout unless the necessary
steps have previously been taken to handle these dialog boxes.

To handle these dialog boxes, the Fax for Domino Conversion Service uses the
Convert Server Config database (nfxconv.nsf) found locally on the FxD Windows
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Services System. Therefore, when the Fax for Domino Conversion Service
encounters conversions of attachments that result in dialog boxes being
displayed, it uses the nfxconv.nsf documents to automatically handle the dialog
boxes without requiring any administrator intervention.

For example, suppose there is an application installed on the FxD Windows
Services System named XYZ, which always displays a dialog box before starting
a print request. This dialog box is titled “Print”, it has some user input fields, and it
has Yes and No buttons. Furthermore, assume the FxD administrator has added
the necessary documents to the local Convert Server Config database
(nfxconv.nsf) so that the Yes button is pressed whenever a “Print” dialog box is
displayed during an XYZ attachment conversion. With this in mind, now suppose
the Fax for Domino Conversion Service receives a request to convert an XYZ
attachment. To convert the XYZ attachment, it starts the XYZ application to
generate a print file. Next, the Fax for Domino Conversion Service is alerted that
a “Print” dialog box has been displayed by the XYZ application. Therefore, using
the nfxconv.nsf documents that were created to handle the XYZ application, the
Fax for Domino Conversion Service automatically presses the Yes button on the
“Print” dialog box. This allows the XYZ application to continue generating the
print file. The Fax for Domino Conversion Service is notified again when the XYZ
application ends, and it then creates a fax image from the XYZ generated print
file.

Some applications start a second process to generate print files and then
terminate themselves before the print file has been created. In these cases, the
Fax for Domino Conversion Service must be configured to wait for the second
process to finish generating the print file instead of assuming that the print file
exists when the original application terminated. Once again, documents can be
created in the local Convert Server Config database (nfxconv.nsf) to alert the Fax
for Domino Conversion Service of this occurrence so that it monitors the correct
process.

Please refer to the following section to better understand how to use the Convert
Server Config database (nfxconv.nsf) to handle applications similar to the ones
described above.

Whenever you change these documents, you need to perform the following tasks
for the changes to take effect:

1. Stop FxD for AS/400 on each Domino fax server that uses this Fax for Domino
Conversion Service.

2. Stop the Fax for Domino Conversion Service.

3. Start the Fax for Domino Conversion Service.

4. Start FxD for AS/400 for each Domino fax server that you previously stopped.

C.2 Configuring a file format

The configuration options for file formats are set in the Convert Server Config
database (nfxconv.nsf), which has two views:

• File Types view: The File Types view of the Convert Server Configuration
database contains a list of the file types the Fax for Domino Conversion
Service must process in a non-standard manner.
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• Popup Windows view: If the application displays one or more dialog boxes
while printing a document, and these dialog boxes require either a button or
keyboard keystrokes to be pressed, you must define the popup windows and
the actions the Fax for Domino Conversion Service should perform.

C.2.1 File Types view

To view or edit the configuration information for a file type, select it from the list in
the File Types view. To define the processing options for a new file type, select
Create->File Type.

If a file type is not listed in this view, the Fax for Domino Conversion Service uses
the default conversion options in an attempt to print the document.

Table 11 shows options of the File Types form.

Table 11. Options of the File Types form

Option Description

File type The file type (or file extension) these processing options are
associated with, for example, “lwp” for a Word Pro document.

Wait for print exit Specifies whether the printing of the document should have
completed by the time the application terminates. Most
applications will finish printing a document before they terminate.
However, some applications start a second process to print a
document and then terminate the main process. In this case, this
option should be set to No.

If this option is set to Yes, but the conversion has not completed
when the application terminated, the Fax for Domino Conversion
Service will assume that the conversion has failed.

Use ‘printto’ Specifies whether the Fax for Domino Conversion Service should
use the Print To or the Print command to convert files of this
type. Some applications define a Print To command in the
Windows registry, which specifies how a file should be printed on
any printer. Other applications define only a Print command,
which specifies how a file should be printed on the Windows
default printer.

If you set this option to Yes, the Fax for Domino Conversion
Service uses the Print To command to print files to the Fax for
Domino Conversion Service printer. Setting this option to Yes
may prevent the application from displaying a pop-up window
prompting for the printer name, and therefore, avoiding the need
to define a popup window.

If you set this option to No, the Fax for Domino Conversion
Service uses the Print command to print files to the default
printer. The Fax for Domino Conversion Service sets the mailFax
Convert Server printer to be the default. With this setting, some
applications display a popup window that prompts you to choose
which printer to use.
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C.2.2 Popup Windows view

Documents in this view ensure that no manual interaction is required. You must
create and configure one document in this view for each window the application
can display.

The Popup Windows view of the Convert Server Config database contains a list
of the pop-up windows that the Convert Server will monitor for each file type. You
can configure any number of popup windows for each file type. However, the
popup windows for a file type must be specified in the order that they are
displayed.

To view or edit the configuration information for a Popup Window, select it from
the list in the Popup Windows view. To define a new Popup Window, select
Create->Popup.

The Popup Window form contains the options shown in Table 12.

Table 12. Options of the Popup Window form

Print via spool If this option is set to Yes, the Fax for Domino Conversion Service
will print files via the spooling system. If this option is set to No,
the Fax for Domino Conversion Service will print files directly to
the fax printer. This option should be set to No for most
applications. However, some applications do not correctly print
directly to the printer.

Wait for print process
exit

If this option is set to Yes, the Fax for Domino Conversion Service
waits for the application to terminate after the print conversion has
completed before returning the converted document to FxD. This
option should be selected for most applications.

Print exit timeout The length of time (in seconds) the Fax for Domino Conversion
Service will wait for the application to terminate after the
document printing has completed. Leave this field blank or
specify 0 to accept the Fax for Domino Conversion Service
default wait time.

Option Description

File type The file type (or file extension) with which these processing
options are associated, for example, “lwp” for a Word Pro
document.

Window number An integer number indicating the order in which this window is
displayed when printing a document with this file type. The first
window should have a window number of 1, the second - 2, etc.

Option Description

If you create a File Types document, one or more associated Popup Windows
documents are only needed if the application displays dialog boxes.

If you create a Popup Windows document, an associated File Types document
must also exist.
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In the Keys to send text box, specify one or more keys in the order they should be
pressed. This can include a list of keystrokes representing both printing and
non-printing keys.

Window title Specifies the title of the popup window so that the Fax for Domino
Conversion Service can identify it. You can specify either the full
window name or a portion of it. Normally, you would use only a
portion of the window title if it contains some variable text, for
example, the document name. Refer to the Must match full
window title option.

Specify the window title that appears in the log message when the
Fax for Domino Conversion Service logs “unknown popup
window”.

Must match full window
title

Specifies whether the Window title option contains the full or
partial window title. Select Yes if it contains a full window title or
No if it contains a portion of the window title.

Popup window is
optional

Specifies whether the popup window always displays when
printing a document with this application or whether it displays
only under certain conditions. Select Yes if the popup window
does not always display. If this option is set to No, the Fax for
Domino Conversion Service waits for the popup window to
display. If for some reason the window does not display, the
process eventually times out and fails the conversion.

Clear dialog action Specifies the action the application should take when it detects
this popup window. The options are:

• Press button: Specifies that a button on the popup
window should be pressed when the window is displayed.
If this option is selected, you must also complete the
Button ID to press field.

• Send key strokes: Specifies that keyboard keystrokes
should be sent to the popup window when it is displayed. If
this option is selected, you must also complete the Keys to
send text box.

Button ID to press Specifies which button to press. This is done by specifying a
Button ID. Each button in a dialog box is assigned an ID number.
Normally, the OK button is ID number 1. You can determine the ID
number associated with a button either by using trial and error, or
by using a tool such as Spy++ (a tool that comes with Microsoft
Visual C++), which allows you to analyze the windows currently
being displayed.

Keys to send Specifies the keystrokes to send to the popup window. See below
for an explanation of how to configure keystrokes.

Fail conversion
message

If this popup window indicates that the file cannot be printed (for
example, if the document is password protected, and this window
is prompting for the password), specify the text of the error
message that should be returned to the fax originator, for
example, “Document is password protected”. This field should be
left blank if this popup window does not indicate a failure of the
conversion.

Option Description
Appendix C. Handling non-standard attachments 219



To send an ordinary keyboard key or sequence of keys, such as A, 8, or DIR,
simply enter the actual characters in the Keys to send text box.

To send non-printing keyboard keys, such as Tab, Backspace, or keys that
perform actions in the active window, such as Page Up, use the key code shown
in Table 13 (including the braces).

Table 13. Key code

To include a character from the following table in this option, enclose it in braces
as shown in Table 14.

Table 14. Character code

Key Code

Backspace {BS} or {BKSP} or {BACKSPACE}

Break {BREAK}

Caps Lock {CAPSLOCK}

Clear {CLEAR}

Del {DEL} or {DELETE}

Down arrow {DOWN}

End {END}

Enter ~ or {ENTER}

Esc {ESC} or {ESCAPE}

Help {HELP}

Home {HOME}

Ins {INSERT}

Left arrow {LEFT}

Num Lock {NUMLOCK}

Pg Dn {PGDN}

Pg Up {PGUP}

Right arrow {RIGHT}

Scroll Lock {SCROLLLOCK}

Tab {TAB}

Up arrow {UP}

Function keys {F1} to {F16}

Character Code

Brace {{} or {}}

Bracket {[} or {]}

Caret {^}

Parenthesis {(} or {)}
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Table 15 shows how to designate keys pressed in combination with Alt, Ctrl, or
Shift.

Table 15. Combination key code

To apply a combination key to a sequence of keys, enclose the sequence in
parentheses. For example, +(xy) holds down the Shift key for both x and y. It is
equivalent to +x+y.

C.2.3 Faxing .html attachments

As mentioned in 7.2.3.2, “Faxing .htm and .html attachments” on page 128, there
was no special setup required to fax .htm documents. However, we had to
configure specific documents for Microsoft Internet Explorer to allow .html
documents to be faxed. These documents are described here. We were unable to
determine how to configure Netscape to enable faxing .html documents using
Netscape.

First, we installed Microsoft Internet Explorer on the FxD Windows Services
System. Then, to fax html attachments, we needed to create documents in the
Convert Server Config database.

You need a File type document as shown in Figure 217 and a Popup Window
document as shown in Figure 218 on page 222.

Figure 217. File type document for .html attachment

Percent sign {%}

Plus sign {+}

Tilde {~}

Combination key Code

Alt %

Ctrl ^

Shift +

Character Code
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Figure 218. Popup window for html attachment

Once you update the database, you need to perform the following steps for the
changes to take effect:

1. Stop FxD for AS/400 on each Domino fax server that uses this Fax for Domino
Conversion Service.

2. Stop the Fax for Domino Conversion Service.

3. Start the Fax for Domino Conversion Service.

4. Start FxD for AS/400 for each Domino fax server that you previously stopped.

If you are faxing html files using the Print to Fax driver, the conversion takes
place on your client PC, and you do not have to make these changes.

To determine what should go into the documents, we used a combination of
information from this appendix and looked at previous File type and Popup
Window documents and extrapolated from there.

Use Microsoft Spy++ to determine which Button ID to press. Microsoft Spy++ is
a tool in Microsoft Visual C++.

Note
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Appendix D. ISDN

The adapters 2750 and 2751 are PCI cards that support Integrated Services
Digital Network (ISDN). Model 2750 is for the U.S. and has a 2-wire interface.
Model 2751 is for Europe and has a 4-wire interface. Both have four ports and
support eight simultaneous ISDN connections.

More information regarding ISDN is available on the AS/400 Information Center
at http://www.as400.ibm.com/infocenter

Look under Networking for the topic on ISDN. Once the support is available,
additional information will be posted on the Fax for Domino for AS/400 home
page at: http://www.as400.ibm.com/domino/related/fxd/

D.1 Additional features with ISDN

As well as the inbound routing features described in 7.4, “Routing” on page 131,
ISDN supports Direct Inward Dialing (DID) routing. DID fax routing assigns a
unique fax number for every user who should receive faxes. Senders
simply dial the fax number, and Fax for Domino delivers the incoming fax to the
user’s inbox. You can set up the DID numbers in the Person document (combined
administration) or in the user profiles (separate administration).

D.2 Configuration for ISDN

When FxD is configured for the 2761 and 7852-400, the necessary line
descriptions are automatically created as part of the FxD configuration process.
When you are using ISDN, you need to do this manually.

You need to have *IOSYSCFG special authority on your user profile to run the
Create Network Interface ISDN (CRTNWIISDN) command.

There may be different ways to configure ISDN for Fax for Domino. The following
example is one option with sample values being used.

In the example that follows, the resource being used is CMN06. We are using the
following conventions for the object names.

NWI name FAXNWI06
Connection list FAXCL06
Outbound conn. list entry FAXCLE06O
Inbound conn. list entry FAXCLE06I
Outbound PPP line description FAXLIN06O
Inbound PPP line description FAXLIN06I

Before you start, use the Change Network Attributes (CHGNETA) command to set
the value for the Modem country ID. This parameter is on the last page of the
command. Press F4 (Prompt) to see the available values.

D.2.1 Creating a network interface for ISDN

To create a network interface for ISDN, use the Create Network Interface ISDN
(CRTNWIISDN) command.
© Copyright IBM Corp. 2000 223



Follow these steps:

1. From any command line, type CRTNWIISDN and press F4.

2. Enter the Network interface description and Resource name as shown in
Figure 219 and press Enter.

Figure 219. CRTNWIISDN command (Part 1 of 3)

3. You see the display as shown in Figure 220. Complete the fields as shown and
press Enter.

Figure 220. CRTNWIISDN command (Part 2 of 3)

Create Network Interface ISDN (CRTNWIISDN)

Type choices, press Enter.

Network interface description . FAXNWI06 Name
Resource name . . . . . . . . . CMN06 Name
Online at IPL . . . . . . . . . *YES *YES, *NO
Vary on wait . . . . . . . . . . *NOWAIT *NOWAIT, 15-180 seconds
Network type . . . . . . . . . . *NISDN *NETATR, *ATT, *DBP1TR6...

Bottom
F3=Exit F4=Prompt F5=Refresh F10=Additional parameters F12=Cancel
F13=How to use this display F24=More keys

Create Network Interface ISDN (CRTNWIISDN)

Type choices, press Enter.

Network interface description . > FAXNWI06 Name
Resource name . . . . . . . . . > CMN06 Name
Online at IPL . . . . . . . . . *YES *YES, *NO
Vary on wait . . . . . . . . . . *NOWAIT *NOWAIT, 15-180 seconds
Network type . . . . . . . . . . > *NISDN *NETATR, *ATT, *DBP1TR6...
Rate . . . . . . . . . . . . . . *BASIC *BASIC, *PRIMARY
Channel entries: _
Channel number . . . . . . . . > 1 1-30, *SWTALL, *D
Channel connection . . . . . . > *SWT *SWT, *NONSWT
Line description . . . . . . . __________ Name

_
Channel number . . . . . . . . > 2 1-30, *D
Channel connection . . . . . . > *SWT *SWT, *NONSWT
Line description . . . . . . . __________ Name

+ for more values _

More...
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys
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4. You see the display as shown in Figure 221. Complete the fields as shown and
press Enter. The values in this display are examples only. Your service
provider will advise you of appropriate Service profile identifiers (SPIDs) if you
require them.

Figure 221. CRTNWIISDN command (Part 3 of 3)

The network interface is created.

To delete the network interface, use the Delete Network Interface Description
(DLTNWID) command.

D.2.2 Creating a connection list

To create a connection list, use the Create Connection List (CRTCNNL) command.
This list is used for inbound and outbound entries.

Follow these steps:

1. From any command line, type CRTCNNL and press F4.

2. Enter the Connection list name and Network type as shown in Figure 222 on
page 226 and press Enter.

Create Network Interface ISDN (CRTNWIISDN)

Type choices, press Enter.

Protocol entries: _
Protocol . . . . . . . . . . . > *PPPMAX *PPPMAX, *IDLCMAX, *X25MAX...
Preload Licensed Internal Code > *LOAD *NOLOAD, *LOAD
Maximum switched channels . . > 2 1-30, *MAX, *NONE

+ for more values _
Auto SPID detection . . . . . . *NO *NO, *YES
Service profile identifiers: _
SPID number . . . . . . . . . > 1 1-2
SPID value . . . . . . . . . . > 015555000

_
SPID number . . . . . . . . . > 2 1-2
SPID value . . . . . . . . . . > 015555001

Local number . . . . . . . . . . 5000________________________________________
______

5001________________________________________
______

More...
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys
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Figure 222. CRTCNNL command (Part 1 of 2)

3. You see the display as shown in Figure 223. Complete the Text description as
shown and press Enter.

Figure 223. CRTCNNL command (Part 2 of 2)

The connection list is created.

To delete the connection list, use the Delete Connection List (DLTCNNL) command.

Create Connection List (CRTCNNL)

Type choices, press Enter.

Connection list . . . . . . . . FAXCL06 Name
Network type . . . . . . . . . . *NISDN *NETATR, *ATT, *DBP1TR6...

Bottom
F3=Exit F4=Prompt F5=Refresh F10=Additional parameters F12=Cancel
F13=How to use this display F24=More keys

Create Connection List (CRTCNNL)

Type choices, press Enter.

Connection list . . . . . . . . > FAXCL06 Name
Network type . . . . . . . . . . > *NISDN *NETATR, *ATT, *DBP1TR6...
Text 'description' . . . . . . . CONNECTION LIST

Bottom
F3=Exit F4=Prompt F5=Refresh F10=Additional parameters F12=Cancel
F13=How to use this display F24=More keys
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D.2.3 Adding a connection list entry for outbound

To add a connection list entry for outbound, use the Add Connection List Entry
(ADDCNNLE) command.

Follow these steps:

1. From any command line, type ADDCNNLE and press F4.

2. Enter the Connection list name, as shown in Figure 224, and press Enter.

Figure 224. ADDCNNLE command (Part 1 of 5)

3. You see the display as shown in Figure 225 on page 228. Complete the fields
as shown and press Enter.

Add Connection List Entry (ADDCNNLE)

Type choices, press Enter.

Connection list . . . . . . . . FAXCL06 Name

Bottom
F3=Exit F4=Prompt F5=Refresh F10=Additional parameters F12=Cancel
F13=How to use this display F24=More keys
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Figure 225. ADDCNNLE command (Part 2 of 5)

4. You see the display as shown in Figure 226. Complete the fields as shown and
press F10 to see additional parameters.

Figure 226. ADDCNNLE command (Part 3 of 5)

5. You see the display as shown in Figure 227. Complete the fields as shown and
press Page Down.

Add Connection List Entry (ADDCNNLE)

Type choices, press Enter.

Connection list . . . . . . . . > FAXCL06 Name
Entry . . . . . . . . . . . . . FAXCLE06O Name
Remote number . . . . . . . . . *ANY

Information transfer type . . . *FAXMODEM

Bottom
F3=Exit F4=Prompt F5=Refresh F10=Additional parameters F12=Cancel
F13=How to use this display F24=More keys
Current values could not be retrieved.

Add Connection List Entry (ADDCNNLE)

Type choices, press Enter.

Connection list . . . . . . . . > FAXCL06 Name
Entry . . . . . . . . . . . . . > FAXCLE06O Name
Remote number . . . . . . . . . > *ANY

Information transfer type . . . > *FAXMODEM
Modem init command string . . . *LIND

Text 'description' . . . . . . . OUTBOUND CONNECTION LIST ENTRY

Bottom
F3=Exit F4=Prompt F5=Refresh F10=Additional parameters F12=Cancel
F13=How to use this display F24=More keys
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Figure 227. ADDCNNLE command (Part 4 of 5)

6. You see the display as shown in Figure 228. Complete the fields as shown and
press Enter.

Figure 228. ADDCNNLE command (Part 5 of 5)

The connection list entry is added.

To remove the connection list entry, use the Remove Connection List Entry
(RMVCNNLE) command.

Add Connection List Entry (ADDCNNLE)

Type choices, press Enter.

Connection list . . . . . . . . > FAXCL06 Name
Entry . . . . . . . . . . . . . > FAXCLE06O Name
Remote number . . . . . . . . . > *ANY

Information transfer type . . . > *FAXMODEM
Modem init command string . . . > *LIND

Text 'description' . . . . . . . > 'OUTBOUND CONNECTION LIST ENTRY'

Additional Parameters

Remote number type . . . . . . . *UNKNOWN
Remote numbering plan . . . . . *UNKNOWN *NETTYPE, *UNKNOWN, *ISDN...
Remote subaddress . . . . . . . *ANY

More...
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys

Add Connection List Entry (ADDCNNLE)

Type choices, press Enter.

Remote subaddress type . . . . . *USER *NETTYPE, *NSAP, *USER
Local number . . . . . . . . . . *ANY

Local number type . . . . . . . *UNKNOWN
Local numbering plan . . . . . . *UNKNOWN *NETTYPE, *UNKNOWN, *ISDN...
Local number presentation . . . *NONE *NONE, *ALLOW, *RESTRICT
Local subaddress . . . . . . . . *ANY

Local subaddress type . . . . . *ANY *NETTYPE, *NSAP, *USER

Bottom
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys
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D.2.4 Adding a connection list entry for inbound

To add a connection list entry for inbound, use the Add Connection List Entry
(ADDCNNLE) command.

Follow these steps:

1. From any command line, type ADDCNNLE and press F4.

2. Enter the Connection list name, as shown in Figure 229, and press Enter.

Figure 229. ADDCNNLE command (Part 1 of 5)

3. You see the display as shown in Figure 230. Complete the fields as shown and
press Enter.

Add Connection List Entry (ADDCNNLE)

Type choices, press Enter.

Connection list . . . . . . . . FAXCL06 Name

Bottom
F3=Exit F4=Prompt F5=Refresh F10=Additional parameters F12=Cancel
F13=How to use this display F24=More keys
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Figure 230. ADDCNNLE command (Part 2 of 5)

4. You see the display as shown in Figure 231. Complete the fields as shown and
press F10 to see additional parameters.

Figure 231. ADDCNNLE command (Part 3 of 5)

5. You see the display in Figure 232 on page 232. Complete the fields as shown
and press Page Down.

Add Connection List Entry (ADDCNNLE)

Type choices, press Enter.

Connection list . . . . . . . . > FAXCL06 Name
Entry . . . . . . . . . . . . . FAXCLE06I Name
Remote number . . . . . . . . . *ANY

Information transfer type . . . *FAXMODEM

Bottom
F3=Exit F4=Prompt F5=Refresh F10=Additional parameters F12=Cancel
F13=How to use this display F24=More keys
Current values could not be retrieved.

Add Connection List Entry (ADDCNNLE)

Type choices, press Enter.

Connection list . . . . . . . . > FAXCL06 Name
Entry . . . . . . . . . . . . . > FAXCLE06I Name
Remote number . . . . . . . . . > *ANY

Information transfer type . . . > *FAXMODEM
Modem init command string . . . *LIND

Text 'description' . . . . . . . INBOUND CONNECTION LIST ENTRY

Bottom
F3=Exit F4=Prompt F5=Refresh F10=Additional parameters F12=Cancel
F13=How to use this display F24=More keys
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Figure 232. ADDCNNLE command (Part 4 of 5)

6. You see the display as shown in Figure 233. Complete the fields as shown and
press Enter.

Figure 233. ADDCNNLE command (Part 5 of 5)

The connection list entry is added.

To remove the connection list entry, use the Remove Connection List Entry
(RMVCNNLE) command.

Add Connection List Entry (ADDCNNLE)

Type choices, press Enter.

Connection list . . . . . . . . > FAXCL06 Name
Entry . . . . . . . . . . . . . > FAXCLE06I Name
Remote number . . . . . . . . . > *ANY

Information transfer type . . . > *FAXMODEM
Modem init command string . . . > *LIND

Text 'description' . . . . . . . > 'INBOUND CONNECTION LIST ENTRY'

Additional Parameters

Remote number type . . . . . . . *UNKNOWN
Remote numbering plan . . . . . *UNKNOWN *NETTYPE, *UNKNOWN, *ISDN...
Remote subaddress . . . . . . . *ANY

More...
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys

Add Connection List Entry (ADDCNNLE)

Type choices, press Enter.

Remote subaddress type . . . . . *USER *NETTYPE, *NSAP, *USER
Local number . . . . . . . . . . *ANY

Local number type . . . . . . . *UNKNOWN
Local numbering plan . . . . . . *UNKNOWN *NETTYPE, *UNKNOWN, *ISDN...
Local number presentation . . . *NONE *NONE, *ALLOW, *RESTRICT
Local subaddress . . . . . . . . *ANY

Local subaddress type . . . . . *ANY *NETTYPE, *NSAP, *USER

Bottom
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys
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D.2.5 Creating a PPP line description for outbound

To create a Point-to-Point Protocol (PPP) line description for outbound, use the
Create Line Description PPP (CRTLINPPP) command.

Follow these steps:

1. From any command line, type CRTLINPPP and press F4.

2. Enter the Line description and Resource name, as shown in Figure 234, and
press Enter.

Figure 234. CRTLINPPP command (Part 1 of 4)

3. You see the display in Figure 235 on page 234. Complete the fields as shown
and press Enter. When FxD starts, it varies on the Line Description. We leave
the parameter Online at IPL set to *NO.

Create Line Desc (PPP) (CRTLINPPP)

Type choices, press Enter.

Line description . . . . . . . . FAXLIN06O Name
Resource name . . . . . . . . . *NWID Name, *NWID
Connection type . . . . . . . . *SWTPP *SWTPP, *NONSWTPP...

Bottom
F3=Exit F4=Prompt F5=Refresh F10=Additional parameters F12=Cancel
F13=How to use this display F24=More keys
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Figure 235. CRTLINPPP command (Part 2 of 4)

4. You see the display as shown in Figure 236. Complete the fields as shown and
press Enter. Note that the Switched connection type should be set to *DIAL, not
*BOTH.

Figure 236. CRTLINPPP command (Part 2 of 4)

5. You see the display as shown in Figure 237. Complete the fields as shown and
press Page Down.

Create Line Desc (PPP) (CRTLINPPP)

Type choices, press Enter.

Line description . . . . . . . . > FAXLIN06O Name
Resource name . . . . . . . . . > *NWID Name, *NWID
Connection type . . . . . . . . *SWTPP *SWTPP, *NONSWTPP...
Switched NWI list:
NWI description . . . . . . . FAXNWI06 Name, *NONE
NWI channel type . . . . . . . *B *B
NWI channel number . . . . . . *CALC *CALC, 1-30

+ for more values
Online at IPL . . . . . . . . . *NO *NO, *YES

Bottom
F3=Exit F4=Prompt F5=Refresh F10=Additional parameters F12=Cancel
F13=How to use this display F24=More keys

Create Line Desc (PPP) (CRTLINPPP)

Type choices, press Enter.

Line description . . . . . . . . > FAXLIN06O Name
Resource name . . . . . . . . . > *NWID Name, *NWID
Connection type . . . . . . . . *SWTPP *SWTPP, *NONSWTPP...
Switched NWI list: _
NWI description . . . . . . . > FAXNWI06 Name, *NONE
NWI channel type . . . . . . . > *B *B
NWI channel number . . . . . . > *CALC *CALC, 1-30

+ for more values _
Online at IPL . . . . . . . . . *NO *NO, *YES
Vary on wait . . . . . . . . . . *NOWAIT *NOWAIT, 15-180 seconds
Line speed . . . . . . . . . . . 115200 9600-2048000
Maximum frame size . . . . . . . 4096 1500-4096
Switched connection type . . . . *DIAL *BOTH, *ANS, *DIAL
Switched NWI selection . . . . . *FIRST *FIRST, *CALC

Bottom
F3=Exit F4=Prompt F5=Refresh F10=Additional parameters F12=Cancel
F13=How to use this display F24=More keys
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Figure 237. CRTLINPPP command (Part 4 of 4)

The line description is created.

To delete the line description, use the Delete Line Description (DLTLIND)
command.

D.2.6 Creating a PPP line description for inbound

To create a Point-to-Point Protocol line description for inbound, use the Create
Line Description PPP (CRTLINPPP) command.

Follow these steps:

1. From any command line, type CRTLINPPP and press F4.

2. Enter the Line description and Resource name, as shown in Figure 238 on
page 236, and press Enter.

Create Line Desc (PPP) (CRTLINPPP)

Type choices, press Enter.

Line description . . . . . . . . > FAXLIN06O Name
Resource name . . . . . . . . . > *NWID Name, *NWID
Connection type . . . . . . . . *SWTPP *SWTPP, *NONSWTPP...
Switched NWI list: _
NWI description . . . . . . . > FAXNWI06 Name, *NONE
NWI channel type . . . . . . . > *B *B
NWI channel number . . . . . . > *CALC *CALC, 1-30

+ for more values _
Online at IPL . . . . . . . . . *NO *NO, *YES
Vary on wait . . . . . . . . . . *NOWAIT *NOWAIT, 15-180 seconds
Line speed . . . . . . . . . . . 115200 9600-2048000
Maximum frame size . . . . . . . > 4096 1500-4096
Switched connection type . . . . > *DIAL *BOTH, *ANS, *DIAL
Switched NWI selection . . . . . *FIRST *FIRST, *CALC
Outgoing connection list . . . . FAXCL06 Name
Connection list entry . . . . . FAXCLE06O Name

More...
F3=Exit F4=Prompt F5=Refresh F10=Additional parameters F12=Cancel
F13=How to use this display F24=More keys
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Figure 238. CRTLINPPP command (Part 1 of 4)

3. You see the display as shown in Figure 239. Complete the fields as shown and
press Enter. When Fed starts, it varies on the Line Description;. We leave the
parameter Online at IPL set to *NO.

Figure 239. CRTLINPPP command (Part 2 of 4)

4. You see the display as shown in Figure 240. Complete the fields as shown and
press Enter. Note that the Switched connection type should be *ANS, not
*BOTH.

Create Line Desc (PPP) (CRTLINPPP)

Type choices, press Enter.

Line description . . . . . . . . FAXLIN06I Name
Resource name . . . . . . . . . *NWID Name, *NWID
Connection type . . . . . . . . *SWTPP *SWTPP, *NONSWTPP...

Bottom
F3=Exit F4=Prompt F5=Refresh F10=Additional parameters F12=Cancel
F13=How to use this display F24=More keys

Create Line Desc (PPP) (CRTLINPPP)

Type choices, press Enter.

Line description . . . . . . . . > FAXLIN06I Name
Resource name . . . . . . . . . > *NWID Name, *NWID
Connection type . . . . . . . . *SWTPP *SWTPP, *NONSWTPP...
Switched NWI list: -
NWI description . . . . . . . FAXNWI06 Name, *NONE
NWI channel type . . . . . . . *B *B
NWI channel number . . . . . . *CALC *CALC, 1-30

+ for more values _
Online at IPL . . . . . . . . . *NO *NO, *YES

Bottom
F3=Exit F4=Prompt F5=Refresh F10=Additional parameters F12=Cancel
F13=How to use this display F24=More keys
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Figure 240. CRTLINPPP command (Part 2 of 4)

5. You see the display as shown in Figure 241. Complete the fields as shown and
press Enter.

Figure 241. CRTLINPPP command (Part 4 of 4)

The line description is created.

To delete the line description, use the Delete Line Description (DLTLIND)
command.

Create Line Desc (PPP) (CRTLINPPP)

Type choices, press Enter.

Line description . . . . . . . . > FAXLIN06I Name
Resource name . . . . . . . . . > *NWID Name, *NWID
Connection type . . . . . . . . *SWTPP *SWTPP, *NONSWTPP...
Switched NWI list:
NWI description . . . . . . . > FAXNWI06 Name, *NONE
NWI channel type . . . . . . . > *B *B
NWI channel number . . . . . . > *CALC *CALC, 1-30

+ for more values
Online at IPL . . . . . . . . . *NO *NO, *YES
Vary on wait . . . . . . . . . . *NOWAIT *NOWAIT, 15-180 seconds
Line speed . . . . . . . . . . . 115200 9600-2048000
Maximum frame size . . . . . . . 4096 1500-4096
Switched connection type . . . . *ANS *BOTH, *ANS, *DIAL
Switched NWI selection . . . . . *FIRST *FIRST, *CALC

Bottom
F3=Exit F4=Prompt F5=Refresh F10=Additional parameters F12=Cancel
F13=How to use this display F24=More keys

Create Line Desc (PPP) (CRTLINPPP)

Type choices, press Enter.

Line description . . . . . . . . > FAXLIN06I Name
Resource name . . . . . . . . . > *NWID Name, *NWID
Connection type . . . . . . . . *SWTPP *SWTPP, *NONSWTPP...
Switched NWI list: _
NWI description . . . . . . . > FAXNWI06 Name, *NONE
NWI channel type . . . . . . . > *B *B
NWI channel number . . . . . . > *CALC *CALC, 1-30

+ for more values _
Online at IPL . . . . . . . . . *NO *NO, *YES
Vary on wait . . . . . . . . . . *NOWAIT *NOWAIT, 15-180 seconds
Line speed . . . . . . . . . . . 115200 9600-2048000
Maximum frame size . . . . . . . > 4096 1500-4096
Switched connection type . . . . > *ANS *BOTH, *ANS, *DIAL
Switched NWI selection . . . . . *FIRST *FIRST, *CALC
Incoming connection list . . . . > FAXCL06 Name, *NETATR
Network controller . . . . . . . __________ Name

More...
F3=Exit F4=Prompt F5=Refresh F10=Additional parameters F12=Cancel
F13=How to use this display F24=More keys
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D.3 Verifying Configuration

Once you configure the ISDN objects, you can vary on the NWI and the lines that
you created. If they go to CONNECT_PENDING, everything is configured
correctly. If they go to VARY_ON_PENDING, there is a problem with your
configuration. Check the values you have used.

D.4 Configuring FxD

There is now an additional FxD Device form for configuring ISDN. You must
create a fax device document of type IBM PCI ISDN for each channel or modem
port you are using for Fax for Domino:

• For each PPP line description you create for outbound, create an IBM PCI
ISDN fax device document in FxD that is set to Enable Transmit only.

• For each PPP line description you create for inbound, create an IBM PCI ISDN
fax device document in FxD that is set to Enable Receive only.

You must restart FxD in order for the configuration changes to take effect. The
controller and device descriptions are created automatically when you start FxD.
238 Lotus Fax for Domino for AS/400: Getting the Straight Facts



Appendix E. Using the additional material

This redbook also contains additional Web material. See the information below
for instructions on using or downloading the material.

E.1 Locating the additional material on the Internet

The material associated with this redbook is available in softcopy on the Internet
from the IBM Redbooks Web server. Point your Web browser to:

ftp://www.redbooks.ibm.com/redbooks/SG245941

Alternatively, you can go to the IBM Redbooks Web site at:

http://www.redbooks.ibm.com/

Select the Additional materials and open the directory that corresponds with the
redbook form number.

E.2 Using the Web material

The additional Web material that accompanies this redbook includes the
following:

File name Description
5941code.zip Sample Registry files and Fax Domain

button

E.2.1 Using the Web material

Create a subdirectory (folder) on your workstation and copy the contents of the
Web material into this folder.
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Appendix F. Special notices

This publication is intended to help AS/400 Systems Administrators install and
configure Lotus Fax for Domino for AS/400. The information in this publication is
not intended as the specification of any programming interfaces that are provided
by Lotus Fax for Domino for AS/400.

References in this publication to IBM products, programs or services do not imply
that IBM intends to make these available in all countries in which IBM operates.
Any reference to an IBM product, program, or service is not intended to state or
imply that only IBM's product, program, or service may be used. Any functionally
equivalent program that does not infringe any of IBM's intellectual property rights
may be used instead of the IBM product, program or service.

Information in this book was developed in conjunction with use of the equipment
specified, and is limited in application to those specific hardware and software
products and levels.

IBM may have patents or pending patent applications covering subject matter in
this document. The furnishing of this document does not give you any license to
these patents. You can send license inquiries, in writing, to the IBM Director of
Licensing, IBM Corporation, North Castle Drive, Armonk, NY 10504-1785.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact IBM Corporation, Dept.
600A, Mail Drop 1329, Somers, NY 10589 USA.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The information contained in this document has not been submitted to any formal
IBM test and is distributed AS IS. The use of this information or the
implementation of any of these techniques is a customer responsibility and
depends on the customer's ability to evaluate and integrate them into the
customer's operational environment. While each item may have been reviewed
by IBM for accuracy in a specific situation, there is no guarantee that the same or
similar results will be obtained elsewhere. Customers attempting to adapt these
techniques to their own environments do so at their own risk.

Any pointers in this publication to external Web sites are provided for
convenience only and do not in any manner serve as an endorsement of these
Web sites.

The following terms are trademarks of the International Business Machines
Corporation in the United States and/or other countries:

Advanced Function Printing AFP
APPN AS/400
AT CT
Current DB2
IBM Manage. Anything. Anywhere.
Netfinity Network Station
OfficeVision OfficeVision/400
Operating System/400 OS/2
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The following terms are trademarks of other companies:

Tivoli, Manage. Anything. Anywhere.,The Power To Manage., Anything.
Anywhere.,TME, NetView, Cross-Site, Tivoli Ready, Tivoli Certified, Planet Tivoli,
and Tivoli Enterprise are trademarks or registered trademarks of Tivoli Systems
Inc., an IBM company, in the United States, other countries, or both. In Denmark,
Tivoli is a trademark licensed from Kjøbenhavns Sommer - Tivoli A/S.

C-bus is a trademark of Corollary, Inc. in the United States and/or other countries.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States and/or other countries.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States and/or other countries.

PC Direct is a trademark of Ziff Communications Company in the United States
and/or other countries and is used by IBM Corporation under license.
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Appendix G. Related publications

The publications listed in this section are considered particularly suitable for a
more detailed discussion of the topics covered in this redbook.

G.1 IBM Redbooks

For information on ordering these publications see “How to get IBM Redbooks”
on page 245.

• IBM AS/400 Printing V, SG24-2160

• AS/400 - Implementing Windows NT on the Integrated Netfinity Server,
SG24-2164

• AS/400 Electronic-Mail Capabilities, SG24-4703

• Lotus Domino for AS/400 - Installation, Customization, Administration,
SG24-5181

• Lotus Domino for AS/400: Integration with Enterprise Applications,
SG24-5345

• Lotus Domino for AS/400 R5: Implementation, SG24-5592

• Developing an e-business Application: Using Lotus Domino for AS/400,
SG24-6052

G.2 IBM Redbooks collections

Redbooks are also available on the following CD-ROMs. Click the CD-ROMs
button at http://www.redbooks.ibm.com/ for information about all the CD-ROMs
offered, updates and formats.

G.3 Other resources

These publications are also relevant as further information sources:

• OS/400 Backup and Recovery, SC41-5304

• Fax for Domino for AS/400 Installation Guide:
http://www.as400.ibm.com./domino/related/fxd/FXDINSTL.PDF

• Administering Domino Clusters, CT73SNA, which is also part of the Domino
R5 Administration help database (help/help5_admin.nsf)

CD-ROM Title Collection Kit
Number

System/390 Redbooks Collection SK2T-2177
Networking and Systems Management Redbooks Collection SK2T-6022
Transaction Processing and Data Management Redbooks Collection SK2T-8038
Lotus Redbooks Collection SK2T-8039
Tivoli Redbooks Collection SK2T-8044
AS/400 Redbooks Collection SK2T-2849
Netfinity Hardware and Software Redbooks Collection SK2T-8046
RS/6000 Redbooks Collection (BkMgr Format) SK2T-8040
RS/6000 Redbooks Collection (PDF Format) SK2T-8043
Application Development Redbooks Collection SK2T-8037
IBM Enterprise Storage and Systems Management Solutions SK3T-3694
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G.4 Referenced Web sites

These Web sites are also relevant as further information sources:

• Fax for Domino page: http://www.as400.ibm.com/domino/related/fxd/

• Lotus Domino for AS/400 home page: http://www.as400.ibm.com/domino/

• Facsimile Support/400 information:
http://www.as400.ibm.com/fax400/fax400.htm

• BRMS enhancements for Domino:
http://www.as400.ibm.com/service/brms/domino.htm

• The Fax for Domino for AS/400 Installation Guide is shipped with the FxD
product and is also available online at:
http://www.as400.ibm.com./domino/related/fxd/FXDINSTL.PDF

• You can download and install the latest Domino for AS/400 Quarterly
Maintenance Update from the Web at:
http://www.as400.ibm.com/domino/QMUList.htm

• Informational APARs can be found online at: http://as400service.ibm.com

• You can install the latest AS/400 cumulative fix package and check the latest
Domino for AS/400 related PTFs appropriate for your OS/400 release from:
http://www.as400.ibm.com/domino/DomSupport.htm

• If FxD Windows Services fixes are available, information will be posted at the
FxD for AS/400 Web site at:
http://www.as400.ibm.com/domino/related/fxd/index.htm

• The Imaging for Windows 95 accessory, which can be used to create,
annotate, view, and print TIFF and other images, can be downloaded from the
Web site at: http://www.microsoft.com/downloads/search.asp

• For Client Access Express, the latest level of fixes for the AFP viewer can be
found at: http://www.as400.ibm.com/clientaccess

• For AFP Workbench for Windows NT and 95 fixes, go to the Web site at:
http://www.printers.ibm.com

• You can download the Print to Fax driver for your Windows PC from the Web
site at: http://www.lotus.com/home.nsf/welcome/faxfordomino
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How to get IBM Redbooks

This section explains how both customers and IBM employees can find out about IBM Redbooks, redpieces, and
CD-ROMs. A form for ordering books and CD-ROMs by fax or e-mail is also provided.

• Redbooks Web Site http://www.redbooks.ibm.com/

Search for, view, download, or order hardcopy/CD-ROM Redbooks from the Redbooks Web site. Also read
redpieces and download additional materials (code samples or diskette/CD-ROM images) from this Redbooks
site.

Redpieces are Redbooks in progress; not all Redbooks become redpieces and sometimes just a few chapters will
be published this way. The intent is to get the information out much quicker than the formal publishing process
allows.

• E-mail Orders

Send orders by e-mail including information from the IBM Redbooks fax order form to:

• Telephone Orders

• Fax Orders

This information was current at the time of publication, but is continually subject to change. The latest information
may be found at the Redbooks Web site.

In United States
Outside North America

e-mail address
usib6fpl@ibmmail.com
Contact information is in the “How to Order” section at this site:
http://www.elink.ibmlink.ibm.com/pbl/pbl

United States (toll free)
Canada (toll free)
Outside North America

1-800-879-2755
1-800-IBM-4YOU
Country coordinator phone number is in the “How to Order” section at
this site:
http://www.elink.ibmlink.ibm.com/pbl/pbl

United States (toll free)
Canada
Outside North America

1-800-445-9269
1-403-267-4455
Fax phone number is in the “How to Order” section at this site:
http://www.elink.ibmlink.ibm.com/pbl/pbl

IBM employees may register for information on workshops, residencies, and Redbooks by accessing the IBM
Intranet Web site at http://w3.itso.ibm.com/ and clicking the ITSO Mailing List button. Look in the Materials
repository for workshops, presentations, papers, and Web pages developed and written by the ITSO technical
professionals; click the Additional Materials button. Employees may access MyNews at http://w3.ibm.com/ for
redbook, residency, and workshop announcements.

IBM Intranet for Employees
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IBM Redbooks fax order form
Please send me the following:

We accept American Express, Diners, Eurocard, Master Card, and Visa. Payment by credit card not
available in all countries. Signature mandatory for credit card payment.

Title Order Number Quantity

First name Last name

Company

Address

City Postal code

Telephone number Telefax number VAT number

Invoice to customer number

Country

Credit card number

Credit card expiration date SignatureCard issued to
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